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About This Guide
Welcome to the ServiceCenter System Administrator’s Guide, Volume 1. The 
ServiceCenter System Administrator’s Guide is a two-volume set that provides 
an introduction to ServiceCenter from a system administrator’s perspective.

The guide provides instructions for starting, setting up, and managing 
ServiceCenter. It includes instructions for using database tools, supporting 
files, and some advanced administrative utilities. It also includes information 
on the basic ServiceCenter window, use of the applications, logging on and 
off of ServiceCenter, and using the menus and buttons. All menus and forms 
presented are those that a system administrator with all available modules 
would see.

Volume 1 is divided into the following sections:

Getting Started

Support Files

User Access and Security Control

Print Routines and Printer Setup

Clocks and the Inactivity Timer

Time Zone Function and Date Formats

Monitor System Events

Mandanten Database Protection

Command Line Prompt Calls, Appendix A
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Volume 2 is divided into the following sections:

Unload Script Utility

Purging and archiving records

Data Mapping

Loading and unloading records

Export Utility

Import Utility

Telephony

LDAP Server Interface

Load Manager

Report Writer

Benchmark Utility

Keyboard Shortcuts, Appendix A

You’ll find specific installation and reference information in other 
ServiceCenter documentation. For instructions on getting started in the 
applications, see the ServiceCenter User’s Guide. For instructions on 
administering the Java client, see the ServiceCenter Java Client Installation 
and Setup Guide.

Knowledge Requirements

A system administrator needs a thorough knowledge of the operating 
environment in which ServiceCenter is installed and accessed and a basic 
understanding of the ServiceCenter applications. Before you begin using this 
guide, thoroughly read and become familiar with the material in the 
ServiceCenter User’s Guide.

ServiceCenter installation requirements are specific to the machine where 
ServiceCenter is being installed. These requirements are listed in the 
respective installation guides.
10  About This Guide 



System Administrator’s Guide, Volume 1
Organization of This Guide

This guide is organized around the main system administration tasks 
associated with setting up and maintaining the ServiceCenter, applications, 
modules, and user base. The following chart shows you which parts of the 
manual you need to reference to find the information you need.

To Find This Look Here

ServiceCenter Interface Enhancement, 
ServiceCenter Client/Server, starting and 
stopping ServiceCenter, Initialization (sc.ini) 
file, The System Administrator Client window 

Getting Started on page 15.

Menu setup Creating a Startup Menu on 
page 174.

Central Administration Utilities Central Administration Utilities on 
page 142.

Printing setup Printing—Setup on page 238.

Starting and stopping clocks Clocks on page 251.

Attaching and deleting documents -- OLE 
(Object Linking and Embedding) containers

File Attachments and OLE 
Containers on page 69.

Limiting attachment, record, and array sizes Limiting Attachment File Sizes on 
page 73.

Searching extended text fields Finding Data in Extended Text 
Fields on page 75.

Support files Support Files on page 81.

Accessing, creating, updating, and deleting a 
record

File Management on page 82.

Adding users and accessing operator records, 
capability words used to allow functionality to 
a user, changing user passwords, modifying a 
company record, central user maintenance 
control

User Access and Security Control on 
page 131.

Display system status from a command line 
and from a system button, system status 
features

ServiceCenter System Status on 
page 47.

Error logs Monitor ServiceCenter System 
Events on page 283.
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ServiceCenter’s Best Practices in Processes and 
Workflow

ServiceCenter uses the Information Technology Infrastructure Library 
(ITIL) processes and workflow. This is a set of standards and procedures 
developed by the Central Computer & Telecommunications Agency 
(CCTA), a United Kingdom government agency, for its best practices in 
processes and workflow. You will find that Peregrine Systems has given you 
the tools you will need to perform certain tasks in ServiceCenter. For more 
information on ServiceCenter’s Best Practices, see ServiceCenter Introduction 
and Best Practices.

Sample Data in the System

The standard ServiceCenter system contains test data (users, devices, 
contacts, and so on) with which to work and learn the system. You can use 
these records as a model for your actual data. This guide uses the sample data 
to illustrate the utilities and processes described. You can modify or delete 
these records as you learn the system. You can also create new records.

Sample data includes:

Users—a set of fictitious users with associated profiles, incident tickets 
and other records.

Menus—various startup menus with different system rights. You may 
copy these for your use or modify them to fit the users on your system.

Starting, stopping, and restarting the inactivity 
timer, deleting the inactivity schedule record

Inactivity Timer on page 267.

Protecting records Mandanten Database Protection on 
page 297.

Deciding which print routines to use Print Routines and Printer Setup on 
page 229.

Restrict logins to prepare for system 
maintenance

Restricting Logins on page 192.

To Find This Look Here
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Inventory—a simulated network inventory (modems, PCs, workstations, 
mainframe hosts, and so on).

Contacts—a number of contact records. Each individual in the contacts 
file is associated with a certain device or primary asset. 

Other Supporting Files—additional sample data in such files as location, 
company, model, and vendor. Information in these files is used throughout 
ServiceCenter.

Sample Screens and Examples 

The sample screens and examples included in this guide are for illustration 
only and may differ from those at your site. 

Documentation Web Site

For a complete listing of the current ServiceCenter documentation, see the 
Documentation pages on the Peregrine CenterPoint Web site at 
http://support.peregrine.com/. 

You will need your current login and password to access this Web page.

For copies of the manuals, you can download .PDF files of the 
documentation using the Adobe Acrobat Reader (also available on the Web 
site). Additionally, you can order printed copies of the documentation 
through your Peregrine Systems sales representative.

Contacting Peregrine Systems

For further information and assistance with ServiceCenter in general, contact 
Peregrine’s Customer Support.

Peregrine’s CenterPoint Web Site
Current details of local support offices are available through Peregrine’s 
CenterPoint Web site at http://support.peregrine.com/.
Sample Screens and Examples  13
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To find Peregrine Worldwide Contact Information:

1 Log on with your login User Name and Password.

2 Click Go for CenterPoint.

3 Select Whom Do I Call? in the navigation bar on the left side of the page.

Peregrine worldwide information is displayed for all products.

Contacting Education Services

Training services are available for the full spectrum of Peregrine Products 
including ServiceCenter. 

Current details of our training services are available through the following 
main contacts or at: 

http://www.peregrine.com/education 

Address: Peregrine Systems, Inc.
Attn: Education Services
3611 Valley Centre Drive
San Diego, CA 92130

Telephone: +1 (858) 794-5009

Fax: +1 (858) 480-3928
14  About This Guide 
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CHAPTER

1
 Getting Started
Overview

This chapter will help you get started using the ServiceCenter application. 
Learn more as you read about:

Switching interface enhancement modes.

Installing a new server.

Starting and stopping a ServiceCenter server.

The System Administrator Client window.

Setting up clocks to track time in specific areas of ServiceCenter, such as 
incident tickets.

Using OLE (Object Linking and Embedding) containers.

Setting file attachments size limits.

Using the Find feature to search fields for data.

Creating a Hot News entry for the Knowledge Base.
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ServiceCenter
ServiceCenter Interface Enhancement for Windows 
NT/2000/XP

ServiceCenter offers a choice of two interfaces for Windows NT/2000/XP:

Multiple Display Interface (MDI), which ships with an active MDI that 
provides a separate ServiceCenter desktop and menu bar (Figure 1-1 on 
page 17). Windows appear as separate threads that are confined within the 
desktop. Menu options change appropriately for the active thread. 

Single Display Interface (SDI)

The advantages to the MDI feature are:

Facilitates organization of multiple windows on the working desktop. You 
may resize the desktop to fit any sized window. Threaded windows will not 
go beyond the borders of the MDI desktop and cannot get lost behind 
other objects on your screen.

Allows users to minimize multiple threads to a single desktop process in 
the task bar. The Single Display Interface (SDI) requires users to minimize 
each window separately to reduce screen clutter. This can rapidly fill the 
task bar with unmarked ServiceCenter buttons. The MDI mode 
minimizes the entire desktop into a single task bar button that contains all 
open windows.
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Figure 1-1: ServiceCenter in MDI mode
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Switching Modes
Although the default interface mode for ServiceCenter 3.0 or later is MDI, 
you may configure your system to use the SDI mode. If you are upgrading 
your system from an earlier release of ServiceCenter, you may want your 
users to see the same interface with which they have been working. You may 
use either of the following processes to configure your system to use the SDI 
mode:

If your ServiceCenter server is on Windows NT/2000/XP add a parameter 
to the ServiceCenter initialization file. This method reconfigures the 
server to the SDI mode. All the users logging on to the system see the 
Single Display Interface.

Add a parameter to the client shortcut. This method configures an 
individual client to see the SDI mode. All other users logging on to the 
system see the MDI mode. This procedure can be performed by the user 
with the guidance of the system administrator.

Initialization (sc.ini) File
To edit the initialization file:

1 Stop the ServiceCenter server.

2 Go to the ServiceCenter RUN directory.

3 Open the sc.ini file using Notepad.

4 Add the following line to the parameter field:

sdi
5 Save the file, and exit Notepad.

6 Restart the ServiceCenter server.

Client Shortcut
To edit the client shortcut:

1 Place the cursor on the client shortcut.

2 Click the right mouse button (right-click), and choose Properties from the 
menu.

3 Select the Shortcut tab in the Properties window (Figure 1-2 on page 19).
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4 Add the following to the shortcut path:

-sdi
For example: "C:\Program Files\ServiceCenter\Run\scguiw32.exe" 
-system:joe.user.12670

Figure 1-2: Shortcut properties

5 Click OK.

ServiceCenter Client/Server

As previously mentioned, ServiceCenter runs in a client/server environment. 
Most users are not aware of the server, although they are accessing the data 
from the server. The ServiceCenter server contains the system’s database, 
applications and utilities.

Users access ServiceCenter applications through a client. The client can 
either run the applications locally or from the server. The processing for the 
ServiceCenter client is done on the server, and the results are displayed on the 
user’s screen.
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ServiceCenter clients operate on many platforms, including:

Windows 98/NT/2000/XP

Java

Unix (text mode only)

OS/390 (text mode only)

ServiceCenter servers operate on:

Windows NT/2000/XP

Unix

OS/390

Clients and servers can run in different environments. For example, 
end-users can be running Windows-based clients, while the ServiceCenter 
server is running on a Unix machine.

Server Installation Overview
Installation instructions for ServiceCenter are specific to the platform on 
which you are installing the system (that is, OS/390, Unix, Windows, 
Macintosh, OS/2) and what you are installing, the client or the server 
software. Each installation is documented in a separate guide.

ServiceCenter can also be accessed from a user’s PC by connecting directly to 
a ServiceCenter Server, using the ServiceCenter Java client. The Java client, 
which is a completely and fully functioning interface to the ServiceCenter 
applications, supports the same functionality as the traditional ServiceCenter 
Windows clients without any need for application or format customizing. To 
learn more about the Java client, see the ServiceCenter Java Client Installation 
and Configuration Guide.

Starting and Stopping a ServiceCenter Server

Before starting or running any client sessions, the ServiceCenter server must 
be started.
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Starting the ServiceCenter Server in Windows NT/2000/XP
The ServiceCenter server runs as a service on Windows NT/2000/XP. The 
service can be started from the following locations:

ServiceCenter Console

Windows NT/2000/XP Services Control Panel

DOS Command Prompt

ServiceCenter Console
To start the ServiceCenter service from the Console:

1 Display the ServiceCenter Console.

a Open the ServiceCenter program group from the Start menu, and select 
ServiceCenter Console.

– or –

b Double-click the ServiceCenter Console button on your desktop.
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2 Click Start to start the ServiceCenter service.

After several seconds, messages are displayed in the Console window stating 
that the service is running and indicating the number of processes that are 
running. 

The Stop button becomes active.

You can exit the Console by closing the window or clicking Done. The 
ServiceCenter service remains running until you click Stop.

The Console can be accessed again by double-clicking the ServiceCenter 
Console button.

Control Panel
To start the ServiceCenter Windows NT/2000/XP server from the Control 
Panel:

1 In Windows NT, open the Control Panel and double-click Services.

Note: In Windows 2000/XP, go to: 
Control Panel>Administrative Tools>Services.

The Window NT/2000/XP Services dialog box is displayed.
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2 In the services list, select ServiceCenter.

Figure 1-3: Windows NT/2000 Services—starting service

3 Click Start in Windows NT or select Action > Start in Windows 2000/XP.

A message box is displayed in Window NT, stating: Attempting to start the 
ServiceCenter service on <host name>. In Windows 2000 the following 
message is displayed: Windows is attempting to start the following service on 
Local Computer.

After several seconds, the service starts. The Services dialog box displays 
Started in the Status field. If the ServiceCenter service does not start, call 
Peregrine Customer Support with any relevant data (error messages, and so 
on).
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DOS Command Prompt
To start the ServiceCenter Windows NT/2000/XP service from a DOS 
Command Prompt:

1 From the Start menu, open a Command Prompt.

2 Enter the following command to start the ServiceCenter server:

net start servicecenter
3 Press Enter.

A message is displayed informing you that the ServiceCenter service is 
starting.

Using the NetDOS Command Prompt to Display Other Commands

If you want to display other Net DOS command prompts, type net to display 
other options.

For example, type net statistics server to receive statistics.

Automatically Starting ServiceCenter
You can configure ServiceCenter to start automatically whenever the system 
is restarted. Out-of-box, this is the default.

To automatically start ServiceCenter when the system is restarted:

For this example, we will use a Windows NT platform.

1 In the Start menu, click Settings > Control Panel > Services.

The Services dialog box is displayed.

2 Scroll down to ServiceCenter. Select ServiceCenter by putting your cursor on 
ServiceCenter and highlighting your selection.

3 Click Startup... in the Services dialog box.

4 Select Automatic in the Startup Type field, and then click OK to save your 
change and exit back to the Services dialog box.

ServiceCenter is now flagged to automatically start up when your system is 
restarted. Notice that the Startup column for ServiceCenter in the Services 
dialog box now says Automatic. 

If you want to change this back to manual or disable the ServiceCenter 
startup, go back into the Services dialog box, as described in these steps, and 
make your change.
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Stopping the ServiceCenter Server in Windows NT/2000/XP
To stop a ServiceCenter server in Windows NT/2000/XP, begin with exiting 
all clients. This will ensure that no information is lost during the shutdown 
process.

Note: If you do not exit all clients, they will be terminated automatically. 

You may stop the ServiceCenter server from the following locations:

ServiceCenter Console

Windows NT/2000/XP Services Control Panel

DOS Command Prompt

ServiceCenter Console
To stop the ServiceCenter server:

1 Double-click the ServiceCenter Console button on your desktop.

The ServiceCenter Console is displayed.

2 Click Stop.

A prompt is displayed asking: Do you want to stop ServiceCenter?

3 Click OK.

The Stop button fades to gray and the Start button is highlighted. A message 
is displayed in the console window stating: ServiceCenter is not running.

4 Click Done (or close the window) to exit the ServiceCenter Console.
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Control Panel
To stop the ServiceCenter Service from the Windows NT/2000/XP Control 
Panel:

1 Open the Control Panel and double-click Services.

Note: For Win/2000/XP, go to: Control Panel>Administrative 
Tools>Services.

The Windows NT/2000/XP Services dialog box is displayed.

Figure 1-4: Windows NT/2000 Services—stopping service

2 From the Services list, select ServiceCenter.

3 Click Stop to stop the ServiceCenter service.

A prompt is displayed asking: Do you want to stop ServiceCenter?

4 Click OK.
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DOS Command Prompt
To stop the ServiceCenter Windows NT/2000/XP server from a DOS 
Command Prompt:

1 From the Start menu, open a Command Prompt.

2 Enter the following command to stop the ServiceCenter server:

net stop servicecenter
3 Press Enter. 

A message is displayed informing you that the ServiceCenter service is 
stopping.

Starting the ServiceCenter Server in Unix
The ServiceCenter server process is started by a script in the Unix 
environment. The script is supplied with ServiceCenter. You can also enable 
client login.

To start the script:

1 Change to the directory where the scstart script is located, for example:

/Run

2 Enter the command scstart and press Enter.

To start a listener from a command prompt:

1 Change to the Run directory.

2 Issue the following command:

scenter -express:<expressport> &

3 Press Enter.
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Stopping the ServiceCenter Server in Unix
To shut down a ServiceCenter server on Unix:

Issue the following command:

scstop u

Note: The u parameter indicates all ServiceCenter processes should be 
stopped. The shutdown process can take up to five minutes.

Issue the following command to stop ServiceCenter immediately:

scstop u -i

Issue the following command to force the close of other processes that were 
not properly shut down:

scstop u -f

Starting the ServiceCenter Server in OS/390
To start ServiceCenter:

1 Edit the member SC in the HILEV.VERSION.SAMPLIB partitioned data set 
created during installation.

This member contains sample JCL that starts ServiceCenter as a batch job 
and also contains notes indicating the necessary changes.

2 For started tasks only:

a Copy the SC member to your started task PROCLIB.

b Delete the JOBCARD, and delete the PEND and EXEC SC statements (the 
last two statements in the member). If possible, use the preset parameters 
for REGION and TIME.

Note: For more information about these DD statements, refer to Appendix 
A of the Client/Server Installation Guide for OS/390.

3 Submit the batch job (or initiate the started task). Within one minute, 
ServiceCenter issues the following console message:

SC001 SERVICECENTER LOGONS ENABLED -- APPLID

If ServiceCenter does not issue this console message, refer to Appendix B of 
the Client/Server Installation Guide for OS/390.

Note: If you are unable to resolve startup errors, contact Peregrine Customer 
Support for assistance. Be prepared to provide information about any 
abend messages you received and any steps taken towards resolution.
28 Chapter 1—Getting Started 



System Administrator’s Guide, Volume 1
Stopping the ServiceCenter Server in OS/390
The ServiceCenter server can be shut down either internally or externally in 
OS/390.

Internal OS/390 shutdown

For OS/390 only, internal shutdown is the recommended method of shutting 
down ServiceCenter (as opposed to the external method).

To shut down ServiceCenter internally:

Enter shutdown on the ServiceCenter command line,

- or -

In the system administrator’s home menu, select the Utilities tab, click 
Maintenance, select the System tab, and then click Shutdown,

- or -

Select the shutdown option from the System Admin Menu II (text user).

Note: Selecting the shutdown option from the System Admin Menu II can 
be done only by an operator with SysAdmin capability.

For more information on internal shutdown and available options, see 
Shutting Down a ServiceCenter Server from a Windows client on page 30.

External OS/390 Shutdown

Although an internal shutdown is the recommended method of shutting 
down ServiceCenter, two external methods are available:

OS/390 Modify command: /f jobname, SHUTDOWN

OS/390 P (stop) command.

Note: Both external shutdown methods permit the system to complete 
active I/O transactions, preserving the integrity of the file system.

Warning: Do not use the OS/390 C (cancel) command to stop ServiceCenter. 
Canceling ServiceCenter prevents it from completing active I/O 
transactions, potentially causing file system corruption.
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Shutting Down a ServiceCenter Server from a Windows client
Shutting down a server is a different process than stopping a server. A server 
can be shut down from within ServiceCenter while clients are logged on to 
the system, which allows them to finish their work and exit the system. 
Peregrine Systems recommends stopping a server only after all clients have 
logged off. How you shut down a ServiceCenter server depends upon the 
platform on which it is running.

You can shut down your ServiceCenter server from a ServiceCenter client 
window if you are logged on as an administrator. There are three shutdown 
types:

Immediate

Delayed

Scheduled

Users are notified when the server stops. You can also check the system 
status. These options are available through the ServiceCenter Maintenance 
Menu.

Note: If you are running the ServiceCenter server on Windows NT/2000/XP, 
you must stop the ServiceCenter Server service after the shutdown 
process.

Immediate Shutdown
To shut down a ServiceCenter server immediately:

1 In the system administrator’s home menu, click the Utilities tab.

2 Click Maintenance.
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The ServiceCenter Maintenance menu is displayed.

Figure 1-5: ServiceCenter Maintenance menu

3 In the System tab, click Shutdown.

A system shutdown form is displayed listing the system status.

4 Click Shutdown NOW to shut down the system without advising your users.

5 After the warning prompt is displayed, click Confirm to shutdown 
ServiceCenter service without notifying your users.

6 Click Status to display the System Status window.

Delayed Shutdown
To delay the shutdown of ServiceCenter:

1 In the system administrator’s home menu, click the Utilities tab.

2 Click Maintenance.

The ServiceCenter Maintenance menu (Figure 1-5 on page 31) is displayed.

3 In the System tab, click Shutdown.
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A system shutdown form is displayed listing the system status.

Figure 1-6: System shutdown form

4 Click Advise & shutdown.

A dialog box is displayed asking for the number of seconds to delay before 
starting the shutdown.
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Figure 1-7: Shutdown time setting

5 Enter the number of seconds, and then click Advise & shutdown.

Your system will lock up until the client shuts down.

Scheduled Shutdown
You can also schedule a shutdown for a different time. This automatic 
shutdown can be a one time event, or a regularly scheduled shutdown. For 
example, you may want the ServiceCenter server to shut down each Friday 
night.

To schedule a shutdown of a ServiceCenter Server:

1 In the system administrator’s home menu, click the Utilities tab.

2 Click Maintenance.

The ServiceCenter Maintenance menu is displayed (Figure 1-5 on page 31).

3 In the System tab, click Schedule Shutdown.
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An automatic shutdown form is displayed.

Figure 1-8: Automatic shutdown form

4 Complete the following fields to configure the shutdown:

Field Description

Shutdown Date Date you want the shutdown to occur. The format is: 
mm/dd/yy HH:MM. You can use the Fill button to place the 
current date and time in the field, which you can modify to 
the date and time of the shutdown.

If a shutdown record already exists, click Search.

Auto-Shutdown Activates the automatic shutdown for the set date, time and 
interval, if set.

Reschedule Interval Number of days between automatic, scheduled shutdowns. 
You can use the down arrow to select an interval.

Shutdown Warning Number of minutes before the shutdown in which 
ServiceCenter should issue a warning to the users of the 
impending shutdown. You can use the down arrow to select 
an interval.
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5 Click Add or press F2.

A message in the status bar states: Record added to schedule file.

6 From the Options menu, select update schd.

This action adds the automatic shutdown to the ServiceCenter schedule file.

7 Click Return to return to the Maintenance menu.

Set Server Control Parameters

There are a number of parameters that clients normally establish for 
themselves. ServiceCenter includes a central control utility that allows you to 
set server controls such as Print Options in printing, SC Timer, Help, and the 
View menu. For example, you can set the Tool bar option as active (1) or 
inactive (0) to display or not display the Tool bar on your client screens. You 
can revise these options in the server’s Initialization file (sc.ini file) to suit 
your client needs. See the following table for the control parameters you can 
use to make changes. When the 0 (zero) setting is used, the option will not be 
selected, disabling the option and leaving it greyed out (unavailable as a 
menu option to the client). When the 1 (number one) setting is used, the 
option is active, which means it will be selected and used by the client. Setting 
these parameters in the server sc.ini file disables any individual user control 
of these parameters. 

See the following table for details of the server control parameters.

Server Control 
Parameters

Descriptions

viewtoolbar:0/1 0 = Set Tool bar option as inactive

1 = Set Toolbar option as active

viewstatusbar:0/1 0 = Set Status bar option as inactive

1 = Set Status bar option as active

viewkeynumbers:0/1 0 = Set Key numbers option as inactive

1 = Set Key numbers option as active

viewtraycaptions:0/1 0 = Set Tray captions option as inactive

1 = Set Tray captions option as active

viewtalltray:0/1 0 = Set Tall tray option as inactive

1 = Set Tall tray option as active
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Changes made to these client parameters are set in the server initialization file 
(sc.ini file). Therefore, options set in the server sc.ini file will override the 
parameters and options set in the client side ini files.

viewdocktrayontop:0/1 0 = Set Dock tray on top option as inactive

1 = Set Dock tray on top option as active

viewactivenotes:0/1 0 = Set Active notes option as inactive

1 = Set Active notes option as active

viewpromptforsave:0/1 0 = Set Prompt for save option as inactive

1 = Set Prompt for save option as active

viewrecordlist:0/1 0 = Set Record list option as inactive

1 = Set Record list option as active

viewattachments:0/1 0 = Set Attachments option as inactive

1 = Set Attachments option as active

clientprinting:0/nnn 0 = Set so that clients logged on to the server use server 
printing. Print Options cannot be changed

nnn = Set so that clients logged on to the server are 
limited to printing a specified number of pages per 
report. For example, to limit each report to no more than 
30 pages, set the parameter to 30. Print Options cannot be 
changed

nohelponfield:0/1 0 = Set Help on field option as active

1 = Set Help on field option as inactive

sctimeramount:n n = Set timer so that clients logged on to the server are 
using the heartbeat timer for a specified number of 
seconds. For example, to have the server check each client 
every 20 seconds, set the parameter to 20 in the sc.ini file:

sctimeramount:20

Server Control 
Parameters

Descriptions
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Changing Server Control Parameters in the Initialization (sc.ini) 
File

The sc.ini file on the ServiceCenter Server must be revised to include the 
server control parameters that you want to change. 

To revise the Toolbar view option so that it won’t display on your client 
screens:

1 Go to the ServiceCenter Programs file directory.

2 Edit the sc.ini file with any text editor.

For example, on Windows NT/2000, you can go to 
Start>Programs>ServiceCenter>Init file to open the sc.ini file with 
Notepad. The sc.ini file is opened in Notepad (Figure 1-9 on page 38).

3 Add a new line to the parameter field.

Example: Add the following line to the parameter field:

viewtoolbar:0

4 From the File menu, choose Save.

5 Exit Notepad.
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6 Stop and restart ServiceCenter, so that the system changes will be recognized.

Figure 1-9: sc.ini file

Note: Your changes will not take effect until the next time you sign back on 
to ServiceCenter.

If you want to make additional revisions, repeat these steps.
38 Chapter 1—Getting Started 



System Administrator’s Guide, Volume 1
The System Administrator Client Window

All ServiceCenter client windows have a similar look and feel. This provides 
consistency and simplifies learning the system. Your startup menu may vary, 
depending on how your ServiceCenter system is customized. As the system 
administrator, you can use ServiceCenter’s Forms Designer to create 
customized menus for different types of users. For details, see the Forms 
Designer chapter of ServiceCenter System Tailoring, Volume 1.

Figure 1-10: System Administrator’s home menu

Exit

System StatusRemote Management ServiceCenter Mail

Exit

Command LineStart Command Arrow
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Command Line
The command line is accessible from every screen in ServiceCenter and 
enables you to enter commands for: 

Accessing files

Running applications, queries, scripts, and command shortcuts

Searching command shortcuts

Changing the currently-active menu in Menu Manager

The command line keeps a record of previously-entered commands. You can 
choose whether to see the command line by selecting or deselecting 
Command Line from the View menu.

For example, to access the Contacts file in Database Manager:

1 On the system administrator’s home menu, make sure that the command 
line is visible by selecting Command Line from the View menu.

2 Type *fcontacts on the command line.

3 Click the Start Command arrow or press Enter.

The Contacts file appears.

You set the command line to be available for use at startup by selecting 
Activate Command Line on Startup on the Startup tab of the Operator 
record. For details, see Startup Tab (Includes an Operator’s System 
Capabilities) on page 158.

To set the cursor focus to the command line prompt, press Shift—Ctrl+L.

For a list of command line prompt calls you can enter on the command line 
as well as their functions, see Command Line Prompt Calls on page 313.
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System Buttons

Services Tab
Use the Services tab (Figure 1-10 on page 39) to access the main 
ServiceCenter applications. Buttons are active for installed applications only.

Support Tab
The Support tab provides access to important support files used throughout 
ServiceCenter. For details on these files, refer to Chapter 3, Support Files.

Figure 1-11: Support tab—ServiceCenter support files

Field Description

Remote 
Management

Access Peregrine’s InfraTools Remote Management 
product.

Exit Logs you out of the current ServiceCenter client session.

ServiceCenter Mail Accesses the ServiceCenter internal mail utility.

System Status Accesses the system status list to display status information 
about users and processes.
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Utilities Tab
Use the Utilities tab to access ServiceCenter administrative utilities. You can 
access other key ServiceCenter features, such as operator records, the link file, 
and Format Control, through this tab. You’ll find the administrative 
functional instructions for starting, setting up, and managing ServiceCenter 
in this guide.

Figure 1-12: Utilities tab—utilities used to administer ServiceCenter

You’ll also find instructions for using database tools, support files, and some 
advanced administrative utilities. The following information is also available 
for edit by the system administrator. To get to this information, go to the 
Information/Security/Insight tab of the Administration button.

Information
The information that can be edited by a system administrator in the 
administrative utilities and obtained by users from within ServiceCenter 
include:

System Bulletin

Run Report

Print Queue

Distribution
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System Bulletin
System Bulletin is used by the system administrator to edit the system 
bulletin that is displayed for users. 

To access the system bulletin as a help desk analyst:

1 Log on as BOB.HELPDESK. 

2 Click the View System Bulletin button at the top of the menu to view the 
active ‘hot’ incidents (Figure 1-13).

Figure 1-13: Viewing the System Bulletin

Run Report
Run Report is used to run a ServiceCenter system report that was previously 
created in Report Writer. For more information on creating, using, and 
running reports from Report Writer, see the Report Writer chapter in System 
Administrator’s Guide, Volume 2.

Print Queue
Prior to client side printing, all printing was done (and can still be done) 
through a printer via the server. This generally meant a Unix or OS/390 
server. The pages to be printed were stored in the “Print Queue” file until the 
print spooler background processor ran and actually printed the pages. The 
Print Queue button allows you to see if there is anything in the print queue 
waiting to print or if there is anything not being processed. When you press 
Enter on the Spool Header page, any unprinted pages are displayed.
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Distribution

Distribution is an access point into the distgroup file, which allows you to 
define users as recipients and type of print or message delivery. Once a group 
is defined with a list of recipients and type of delivery, users can send reports 
from ReportWriter and annotated messages to other ServiceCenter users via 
print, email, fax, or page. This distribution capability is also built into 
Change Management and Incident Management. 

The following fields are used to create a distribution group within the 
distgroup file.

Field Description

Group Name This group identifies a distribution group to whom a 
ReportWriter report is printed or a mail message is sent.

Type Method of print or mail delivery.

Change (Change Management)
Email
FAX
Page
Problem (Incident Management)

Operators/Contacts This field contains a list of users to whom the reports or 
message is to be sent. The names in the list must be 
ServiceCenter operator names or contact names.
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Toolkit Tab
Use the Toolkit tab to access the database, modify ServiceCenter forms, and 
view applications with the RAD editor. These are the applications used to 
customize ServiceCenter.

Figure 1-14: Toolkit tab—applications used to customize ServiceCenter

Logout Button
The Logout button logs you out of the current ServiceCenter client session. 
This button is the same as the Exit button.

Launching Network Discovery Applications from ServiceCenter
You can also access certain Network Discovery (formerly called InfraTools 
Network Discovery (IND)) functions from Incident Management, 
Inventory/Configuration Management, and Change Management.

The Network Discovery function is launched from the Options menu of a 
record in these applications. When the option is selected, the Web browser is 
launched and an HTTP request is sent to the Network Discovery network 
appliance. The Network Discovery login procedure then begins. 
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See Figure 1-15 for a breakdown of how ServiceCenter and Network 
Discovery integrate.

See the Network Discovery User’s Guide for information about using Network 
Discovery.

.

Figure 1-15: Launching Network Discovery from ServiceCenter
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Setting Up ServiceCenter to Launch Network Discovery 
Functions
To configure the Company Record to launch Network Discovery functions:

Important: You will need to shut down and restart your ServiceCenter 
server to activate this function.

1 Log on as an administrator.

2 Select the Utilities tab in the main menu.

3 Click Administration.

4 Click System Wide Company Record in the Information/Security/Insight 
tab.

5 Enter the path to the Network Discovery appliance in the Network Discovery 
System field.

Note: The http:// and the trailing slashes are not needed. You need only to 
enter the machine and any path extensions.

6 Click Save.

7 Click OK to exit the Company Record.

8 Log out of ServiceCenter.

9 Stop and restart your ServiceCenter server.

ServiceCenter System Status

When you access the System Status window, the system.status.list form 
appears showing a current list of started background processes and all logged 
on users. Some of the tasks you can perform from the System Status window 
include, but are not limited to:

Check the status of a user or background task

Halt a user’s session or task

Check on system locks

Send out broadcast messages

As system administrator, you can check the status of your ServiceCenter 
system, including who is currently logged on and what processes are running, 
by accessing the System Status window (Figure 1-17 on page 49).
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For more information on background processes, see Background Processes on 
page 50.

Access the System Status window, using one of two methods:

Command line

System button

Figure 1-16: System Status button in the home menu

Displaying system status from the command line
To display a system status from the command line:

1 On the system administrator’s home menu, make sure that the command 
line is visible by selecting Command Line from the View menu.

2 Type status on the command line.

3 Click the Start Command arrow or press Enter.

The System Status window appears (Figure 1-17 on page 49).

System Status
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Displaying system status from the system button
To display the System Status window (Figure 1-17 on page 49), click System 
Status in the system administrator’s home menu (Figure 1-16 on page 48). 

From this form, you can check on the status of a user or background task, kill 
the user’s session or the task, check on locks, send out a broadcast message, 
and so on. The following shows connections made from an OS/390, 
NT/2000/XP server, or Unix.

Figure 1-17: System Status window
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Background Processes
Background processes are also known as background agents, schedulers, 
processors, and background tasks. The background agent’s startup entry 
defines both its sleep interval and the schedule class that it controls. 

For example, the linker processor (or agent) sleep time is 60 seconds and the 
default schedule class is linker. The background agent sleeps for the time 
defined on its startup entry, and then wakes up and processes any schedule 
record with the right class and with an expiration time prior to the current 
date/time. The schedule record defines the RAD application that gets run 
whenever the background agent processes the schedule record. In linker 
processing, the application used is apm.start.linked.close, which searches for 
calls related to the incident ticket, posts the resolution to the call, and then 
updates the status of the call. The schedule record also defines the parameter 
values that the application needs. The apm.start.linked.close application 
parameters include the incident number of the closed ticket.

The Background Processes on page 51 describe the background processes and 
how they are used.
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Background Processes

Process Description of Process

startup A collection of background processes that get started 
automatically when the system loads.

SLA A process that creates SLA-based alerts.

agent A process that creates charts, using stored queries.

Note: If the queries used are unkeyed, the agent process 
may use a large amount of CPU time.

alert.startup (Problem) A process that is used to manage messages and problem 
alerts.

availability.startup
(Availability)

A process that is used to determine asset availability.

Note: This process pre-dates SLA. It is not typically used 
anymore.

change.startup 
(Change)

A process that is used to manage Change events.

contract A process that manages contract events, such as handle 
time.

event.startup(Event) A process that is used to manage asynchronous incoming 
events (Eventin Queue).

gie.startup(gie) A process that is used to manage incoming Prim Events.

Note: This has not been used since Connect.It! was 
released.

inactive.startup
(inactive)

A process that automatically logs users off ServiceCenter 
when they have been inactive for a period of time.

linker.startup
(Linker-Incident)

A process that is used to manage related calls to an 
incident that was closed.

lister.startup(Lister) A process that is used to build global variables, based on 
definitions in the globallist file.

Note: If the queries in the globallist file are unkeyed, 
this process may use a large amount of CPU time.

marquee A process that manages static marquee messages.

netview A process that reads NAPA vsam from Netview.

ocm.startup(OCM) A process that is used to manage request events.

printer.startup(Spool) A process that manages server-side print requests.
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Column Headings
The System Status table contains the following columns:

report.startup(Report) A process that manages Report Writer reports. It is also 
used for background import/exports.

scauto.startup
(SCAUTO Server)

A bi-directional interface to external applications, such 
as Tivoli and MAPI Compliant Email.

scemail.startup
(SCEMAIL)

An outgoing interface only. Not used in connection with 
SC Automate.

vsamin A process that reads to a dataset.

vsamout A process that writes from a dataset.

Process Description of Process

Column Heading Description

Command Field where the s or k  is entered.

User Name Lists the user or background task as identified in the 
ServiceCenter database.

PID Process Identification number, which is assigned when a 
new thread is opened. These numbers are simply used by 
ServiceCenter to identify the separate processes. See 
Feature Buttons on page 53 for more information on the 
numbers that display in this field. This information 
identifies who is running what kind of client or 
background process.

Device ID Identifies where the process or session is being run and 
the type of session.

Login Time Date and time the process or session was started.

Idle time Length of time since an action took place in the process 
or session.
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Feature Buttons
The System Status window contains a series of buttons. Some buttons 
execute a function, while others access forms to provide more information or 
functionality.

The following features are discussed in this section:

Refresh Display on page 53

Start Scheduler on page 53

Broadcast on page 55

Show Locks on page 56

Display Options on page 56

System Monitor on page 58

System Monitor Access Buttons on page 59

Command List on page 66

Summary on page 67

Execute Commands on page 68

Refresh Display
Clicking Refresh Display (Figure 1-17 on page 49) updates the table with 
current system information.

Start Scheduler
Clicking Start Scheduler (Figure 1-17 on page 49) allows you to start 
ServiceCenter server background processes from a list of available processes 
(Figure 1-18 on page 54). 

Note: The scheduler can be started only from a ServiceCenter client (which 
includes Java) or in text-mode.
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To start the scheduler from a ServiceCenter client:

1 Click Start Scheduler.

A list of available background processes is displayed.

Figure 1-18: Start Scheduler QBE

2 Double-click the process you want to start, or select the process and press 
Enter.

You are returned to the status form with the newly started task displayed at 
the bottom of the list. A message in the status bar states: System background 
scheduler: event started at: mm/dd/yyyy 00:00:00.
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Broadcast
Clicking Broadcast (Figure 1-17 on page 49) allows you to send a message 
(Figure 1-20 on page 56) to all currently logged-on ServiceCenter users in 
your system.

To send a message using the Broadcast feature:

1 Click Broadcast.

A form is displayed in which you may create and send a message.

Figure 1-19: Broadcast message

2 Enter the message in the Message box.

3 Click Send msg.

You are returned to the System Status console. Your message is displayed in 
the status bar of the form.

4 To cancel the message before sending it, click Menu exit and return to your 
original entry point (home menu). 
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Show Locks
Clicking Show Locks (Figure 1-17 on page 49) displays a list of objects 
(Figure 1-20 on page 56) that have been locked.

Figure 1-20: Locked Resources form

Display Options
Clicking Display Options (Figure 1-17 on page 49) displays a setup menu 
(Figure 1-18 on page 54) to configure the System Status display. Options are 
available in the framed central area of the screen and in the system tray.
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Figure 1-21: Display options

Option Buttons

Button Action

All Tasks Displays the status of all the tasks currently running in 
ServiceCenter.

Active Displays status of the active processes currently running in 
ServiceCenter.

Inactive Displays the status of the inactive processes that still exist in 
ServiceCenter.

User Displays the status of idle and active users in ServiceCenter.

System Displays the status of current background processes in 
ServiceCenter.
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System Monitor
Clicking System Monitor (Figure 1-17 on page 49) displays statistics on the 
impact of ServiceCenter processes. The Main User Info form (Figure 1-22 on 
page 58) is one in a series of forms containing this data.

Figure 1-22: System Monitor—Main User Info form
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System Monitor Columns

System Monitor Access Buttons

Note: The button that activates a window is not displayed with the other 
buttons, but only is displayed when the view is changed.

Field Description

Name Name of the process or user.

PID Process ID number.

Device Name Computer on which the user is operating or the process is 
running.

Idle Time Length of time since the process or user last accessed the 
server.

Application ServiceCenter application in which the process or user is 
operating.

Network Address IP address.

Mem% Percentage of RAM this user or process is using under 
ServiceCenter.

CPU% Percentage of the system’s CPU the process or user is 
using with ServiceCenter.

Statements Evaluated Number of statements evaluated for the process or user.
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Grand Totals —displays the system totals for usage (Figure 1-23 on page 60). 
The buttons next to these fields display other system statistics.

Figure 1-23: System Monitor—Grand Totals
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CPU Info —displays a table showing the impact of the processes and users 
on the system on which they are operating. 

Figure 1-24: System Monitor—CPU Info
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IOInfo —displays statistics on the number of operations by each 
ServiceCenter user or process.

Figure 1-25: System Monitor—IO Info
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Shared Memory Info—displays the memory allocation specifics for your 
ServiceCenter system.

Figure 1-26: System Monitor—Shared Memory Info
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Capture —allows you to set up regularly scheduled snapshots (Figure 1-27 
on page 64) of the system monitor information. You can set a Begin Time 
and Repeat Interval. Click Schedule to set the capture.

Figure 1-27: System Monitor—Capture Schedule Monitor
64 Chapter 1—Getting Started 



System Administrator’s Guide, Volume 1
View Capture—allows you to view the information retrieved from the 
scheduled capture.

Figure 1-28: System Monitor—viewing capture information
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Command List
Clicking Command List (Figure 1-17 on page 49) displays a read-only form 
describing the s and k commands used in the System Status Utility.

Figure 1-29: Command descriptions

Command List Descriptions

Command Description

S Type S to select a record for more information. Displays 
additional information about the record selected and allows 
access to specific operations within the record, such as, send 
message.

Note: Only one record can be selected at a time.

K Type K to kill (end) a task. You can enter K on multiple tasks lines 
to end multiple tasks.

Note: Some system tasks cannot be killed.

Note: This option should only be used as a last resort.
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Summary
Clicking Summary (Figure 1-17 on page 49) displays the System Status 
Recap form (Figure 1-30 on page 67). The System Status includes:

Figure 1-30: System Status Recap

Field Description

Total Processes Provides the number of users and background processes 
currently running. 

Active Users Provides the number of active users and lists the names of 
those users. 

Idle Users Provides the number of users who are logged on but inactive. 
The names of those users are also listed. 

Schedulers Provides the number of schedulers currently active and lists 
those schedulers. 

Other Users Provides the number of other ServiceCenter users. 

Other Provides the names of other ServiceCenter processes that are 
running.
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Execute Commands
The Execute Commands button (Figure 1-17 on page 49) instructs the 
System Monitor to execute the s or k command that has been placed next to 
a user or process in the System Monitor list (Figure 1-31 on page 68).

Figure 1-31: Command for killing a process

To execute an operation on a user session or background task:

1 Place the cursor in the Command column next to the listed task or user.

2 Enter the command you want to execute:

Type s next to a user session or task to view application and schedule 
record details.

Type s next to a user session to view details of the application that the 
session is running.

Type s next to a background process to see a list of all schedule records 
currently executing or awaiting execution on this process.

Type k next to a user or task to kill that user’s session or the task.
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3 Click Execute Commands.

If s is executed, a form is displayed providing the status of the item.

If k is executed, a confirmation message is displayed in the status bar.

File Attachments and OLE Containers

An OLE (Object Linking and Embedding) container is a Forms Designer 
widget that permits users to embed pertinent files from other applications 
directly into a ServiceCenter record. When a file is attached to a record in this 
manner, it may be opened in the application that created it directly from the 
record by double-clicking on the button displayed in the OLE container field.

OLE containers are used in the Attachments tabs of the following records in 
ServiceCenter: 

change requests

incident tickets

device records

service contracts

contact records

SLA records

You may use an OLE container to attach a wide range of file types, such as 
spreadsheets, text files, image files, and flow diagrams. These files can be 
opened by any ServiceCenter user who can access the record.

Note: With ServiceCenter 4.0 or later, attachments are handled as file 
attachments instead of OLE objects. File attachments are supported in 
OS/390 (Windows mode only) and Windows, OS/2, and Macintosh 
Windows and Java clients. Windows and Java clients can also access 
and launch existing OLE objects from earlier releases of ServiceCenter. 
OS/2 and Macintosh Java clients can access OLE objects from earlier 
releases of ServiceCenter, but cannot launch them.
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Attaching Files
To attach files, the Attachment option in the sc.ini file must be turned on. 
This is the default. For details, see the viewattachments parameter described in 
the Technical Reference.

There are two methods for attaching files to an OLE container:

Inserting using a menu command

Drag-dropping

Insert Command
You may either insert an existing files or create a new file to insert.

To create a new file to insert:

1 Right-click the Attachment tab, and choose Insert Object from the shortcut 
menu.

A dialog box is displayed, showing a list of possible objects to attach.

Figure 1-32: Insert Object dialog box

2 Click Create New to create a new file (this is the default).

3 Select a format from the Object Type field, and then click OK.

A new file (object) is opened in the appropriate application.

4 Create the attachment within the application selected.

5 From the File menu, choose Close & Return to SC.

The attachment you have created is displayed as a button in the Attachment 
tab.

It is not necessary to save the record to save your changes. The file is 
imbedded into the record when the button is displayed in the tab.
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Note: Attachments created with this method have a general label only (for 
example, Document, Visio).

To insert an existing file:

1 Right-click the Attachment tab, and choose Insert File from the shortcut 
menu.

A browse window is displayed from which to select an existing file.

2 Select the appropriate file in your system.

3 Click Open.

A button of the object you have selected is displayed in the Attachments tab.

It is not necessary to save the record to save your changes. The file is 
imbedded into the record when the button is displayed in the tab.

Note: Objects attached to a contract in Contract Management in this fashion 
carry a generic label as well as the file name.

Dragging-and-Dropping Files
To drag-and-drop files into an OLE container:

1 Use a file management utility to open the folder containing the document 
you want to attach to the contact record or select a file from your desktop.

Be sure that the Attachment tab is visible on your screen.

Note: You can also drag and drop (cut and paste) files from one instance of 
ServiceCenter to another. Be sure that both instances are open on your 
desktop and that both Attachments tabs are visible. 

2 Click the document you want to attach, and drag it into the OLE container 
in the Attachments tab.
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3 Release the mouse button, and the button for the document is copied into the 
white field.

Note: It is not necessary to save the record to save your changes. The 
document is imbedded into the record when the button is displayed in 
the tab.

File Management from a Shortcut Menu

Moving Files
You can cut, copy, and paste files inserted into the Attachments tab of one 
record into another record by using a shortcut menu.

To move files between records:

1 Click the right mouse button on the file you want to move.

A shortcut menu is displayed.

2 Select the function you want to perform on the file.

3 Open the record in which you want the file to appear.

4 Click the right mouse button in the Attachments tab.

A shortcut menu is displayed.

5 Select Paste from the menu to copy the file to the new location.

Deleting Files
To delete a file from the Attachments tab, simply select the button and press 
the Delete key, or select Delete from the shortcut menu.

Note: It is not necessary to save the record to save your changes. The 
document is removed from the record permanently when the Delete 
key is pressed.
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Defining File Size Limits

To define size limits for OLE attachments, records, and arrays, so that your 
files do not become too large, you can do the following:

Limit the size of file attachments that can be placed in an OLE container 
by defining size limits in three locations within ServiceCenter:

Forms Designer

Operator record

Company record

Set logical size limits in the Initialization (sc.ini) file to prevent record sizes 
from becoming large and large arrays from being built, unnecessarily 
consuming memory.

Limiting Attachment File Sizes
Defined size limits affect individual attachments only. You can attach as 
many documents as you like as long as each one meets the size criteria. 
Documents previously attached to ServiceCenter forms are not affected by 
downsizing the limits.

Company Record
The value set in the Max Attachment Size field in the company 
(info.company.g) record is the company default. This value is measured in 
bytes. It limits the size of any document any user can attach to any OLE 
container in the system. (See System Wide Company Record on page 196.)

Operator Record
You may override the size limit specified in the Company record with the 
limits defined in the Max Attachment Size field in a user’s operator record. 
(See Operator Templates on page 184.) This value defines the maximum size 
document that the user can attach to any OLE container in ServiceCenter. A 
value of 0 (zero) in the Max Attachment Size property allows this user to 
attach documents of the size specified for the Max Attachment Size value for 
the Company record. This value is measured in bytes.
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Forms Designer
A non-zero value specified in Forms Designer overrides any values specified 
in the Company or Operator record. Size limits are defined in bytes in the 
Forms Designer utility. You may define size limits in Forms Designer for each 
OLE container that is displayed in the system. (For details on defining OLE 
container properties, see the Forms Designer chapter of ServiceCenter System 
Tailoring, Volume 1.) All users accessing the forms in which such containers 
appear are subject to the same size limits. 

A value of 0 (zero) in the MaxAttachSize property in Forms Designer allows 
users to attach documents of the size specified on the Operator record. If this 
value is also 0 (zero), users may attach documents of the size specified on the 
Company record. If this value is 0 (zero) as well, users may attach documents 
of any size.

Example 1: If the MaxAttachSize value specified on the Company record is 0 
(zero), the value specified on the Operator record is 6,000, and the value 
specified for the Ole Container in Forms Designer is 0 (zero), the attachment 
file size limit is 6,000 per attachment.

Example 2: If the MaxAttachSize value specified on the both the Company 
and Operator records is 0 (zero) and the value specified for the Ole Container 
in Forms Designer is 12,000, the attachment file size limit is 12,000 per 
attachment.

Setting Logical Size Limits in the Initialization (sc.ini) File
Attachment size for records and arrays is measured in bytes. There are two 
parameters in the sc.ini file that can set logical file limits on the size of records 
and arrays. 

To make the necessary size limit adjustments:

1 Stop the ServiceCenter server.

2 Go to the ServiceCenter RUN directory, and edit the sc.ini file.

Open the sc.ini file.

3 Add the following line to adjust the size limit for records:

recordsizelimit:nnnn
Where nnnn represents the maximum size for a database record. If this 
number is not specified in the sc.ini file, the default value is 64000 bytes 
(64K).
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4 Add the following line to adjust the size limit for the size of arrays:

arraysizelimit:nnnn
Where nnnn represents the maximum number of entries in an array. If this 
number is not specified in the sc.ini file, the maximum value is set at 
89478485.

5 Save your changes.

Finding Data in Extended Text Fields

There are numerous extended text fields in ServiceCenter, such as the 
Incident Details field in an incident ticket, that contain large amounts of 
data, making it difficult for you to search through the history of a reported 
incident and find what you need. ServiceCenter includes a find capability 
that will help you easily find the information you need.

When you’re in an extended text field, such as a lengthy description of an 
incident in Incident Management, you can initiate a search within that field 
to find the information you need. 

To initiate a search of a text field:

1 Place your cursor in the extended text field you want to search.

2 Press the magnifying glass in the toolbar.

An editing shortcut window is displayed, displaying the selected text.
Finding Data in Extended Text Fields  75



ServiceCenter
3 From the Edit menu select Find or press Ctrl + F.

A dialog box for searching the text field is displayed.

4 Select the appropriate options for your search from the following table.

5 Click Find Next.

The first instance of the search will be highlighted.

6 Click Find Next again to find the next instance of the search.

7 When you are finished with your search, exit out of the shortcut editing 
window. 

You are returned to the original field where you started the search.

Field Description

Find What Initiates the IR Expert search so that you can locate specific text 
within the field. 

Search Allows you to search the extended text field and find historical 
data or comments without having to scroll through multiple 
lines of text.

Match Case Allows a search for specific words or phrases that match the 
‘case’ with which they were typed. For example, all capitalized 
letters and lower case letters should match the original typed 
text. This helps you to locate instances where acronyms may 
have been used, helping to limit your search so that you can 
quickly find what you need.

Find Whole 
Words Only

Allows the search to find only instances where whole words are 
used (partially typed words will not be located).

Cancel Allows you to cancel the search and return to the View 
Messages window.
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Automatic Refresh of Record List

When ServiceCenter users are driven by queues of work that are assigned to 
them, they issue specific queries against the ServiceCenter database for lists 
of records that need their attention. In ServiceCenter, automatic refresh of 
record lists has been introduced. You no longer have to manually refresh the 
record list to get updated display records; queries that have been issued for 
database lists will automatically refresh the displayed records on the client 
screen. Any time queried records have been either inserted, updated, or 
deleted in the database, these changes are automatically incorporated into 
the queries displayed on the client screen.

The rate, in seconds, at which displayed queries are refreshed on the client 
screen are set up by the system administrator. There are no defaults in place, 
so you need to set this up by going into the Forms Designer utility and setting 
the number of seconds in the Refresh Rate field of the Table object properties 
that will be used to display the data in your Forms. For more details about 
setting the automatic refresh rate for record lists, see the Forms Designer 
chapter of ServiceCenter System Tailoring, Volume 1. 

Creating a Hot News Entry for the Knowledge Base

Hot News entries are designed to present “late breaking” information to the 
help desk analyst, such as server outages, other infrastructure failures, and 
any form of current information. The ServiceCenter User’s Guide details how 
Hot News entries are used along with the other Knowledge Base options. 

To create a Hot News entry:

1 Select the Toolkit tab in the System Administrator’s home menu.

2 Click Database Manager.

3 Enter core in the Form field. A blank core.g form will display (Figure 1-33 on 
page 78). 

4 Check the Hot News field and click Search to perform a true query to retrieve 
a list of all current Hot News items. Select a Hot News item to use as a base 
to begin creating your new Hot News item.

-or-

Check the Hot News box and begin creating your Hot News entry from 
scratch.
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Note: You can also create Common Problem and Error Message entries.

Figure 1-33: Creating a Hot News item

The fields in the core.g form are described below.

Field Description

Source Filename The system enters the name of the source file if the Hot News 
entry is coming from a ticket.

Source Key Unique identifier in the source file generating the Hot News 
entry

Secondary Key Second unique identifier in the source file generating the Hot 
News entry.

Tertiary Key Third unique identifier in the source file generating the Hot 
News entry.

Keywords Key words to be used within this Hot News entry.
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5 Once all the applicable fields are filled in, click Add.

When you click the Hot News check box, date range fields appear in which 
you can type dates for the validity of the news.

Issue Description Description of the Hot News entry.

Resolution Suggested resolution for the announced Hot News item.

Hot News

Common Problem

Error Message

Check one of the following:

Hot News to flag this entry as a Hot News item
Common Problem to flag as a common problem
Error Message to flag as an error message

Category Enter the Category (Asset and/or Incident) affected by this 
Hot News entry.

Subcategory Enter the Subcategory (Asset and/or Incident) affected by 
this Hot News entry.

Product Type Enter the Product Type affected by this Hot News item.

Company Enter the company that is being affected by this Hot News 
entry. The broadcast of this entry will be for this selected 
company.

Problem Type Enter the specific Problem Type that is affected by this Hot 
News entry.

Location Indicate location where the Hot News entry is applicable. 
The broadcast of this entry will be for this location only.

Affected Item Enter the affected device in this Hot News entry.

Field Description
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CHAPTER

2
 Support Files
Overview

As the system administrator, you can directly access the following support 
files (and their options menus) used in the administration of ServiceCenter.

Contacts (contacts file)

Location (location file)

Model (model file)

Vendor (vendor file)

Company Information (company file)

Department (dept file)

Currency (currency file)—discussed in detail in Service Contract 
Management in the ServiceCenter Application Administration Guide

Currency Conversion (curconvert file)—discussed in detail in Service 
Contract Management in the ServiceCenter Application Administration 
Guide
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File Management

You have access to the support files discussed in this chapter through the 
Support tab in the administrator’s home menu (Figure 2-1 on page 82). You 
may choose to access these files from the Database Manager; however, this 
process is slower than the direct button access provided on the Support tab.

As an administrator, you may create, update, and delete records from these 
files. These procedures vary little between files and are discussed generically 
at the beginning of this chapter; however, deleting a record in the model file 
requires additional steps. This procedure is presented in detail in Model File 
on page 100.

Accessing a Record
To access an existing record:

1 In the system administrator’s home menu, click the Support tab.

Figure 2-1: Support tab in the home menu
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2 Click the button of the file you want to access.

A blank record is displayed.

3 Access an existing record using one of the following procedures:

a Enter known information about the record in a field and click Search or 
press Enter.

- or -

b Click Search and select a record from the record list at the top of the form.

The selected record is displayed.

Creating a Record
As an administrator, you need to add records to the support files from time 
to time.

To create a record:

1 In the system administrator’s home menu, click the Support tab (Figure 2-1 
on page 82).

2 Click the button of a file in which you want to create a record.

3 A blank record is displayed.

4 Complete as many fields as possible, especially the required fields.

You may use the Fill or ellipsis buttons to complete fields linked to other files.

Note: Refer to the field definitions in each section of this chapter to locate 
required fields.

5 Click Add or press F2.

A message in the status bar states: Record added to the <file name> file.

Updating a Record
To update an existing record:

1 In the system administrator’s home menu, click the Support tab (Figure 2-1 
on page 82).

2 Click the button of the file whose record you want to update.

A blank record is displayed.
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a Enter known information about the record in a field and click Search or 
press Enter.

– or –

b Click Search and select a record from the record list at the top of the form.

Note: Make sure the Record List option is turned on (checked) in the View 
menu (View>Record).

The selected record is displayed.

3 Edit the fields you want to change.

4 Click Save or press F2 to save the changes.

A message is displayed stating: Record updated in the <file name> file.

Deleting a Record
To delete an existing record:

1 In the system administrator’s home menu, click the Support tab (Figure 2-1 
on page 82).

2 Click the button of the file whose record you want to update.

A blank record is displayed.

a Enter known information about the record in a field and click Search or 
press Enter.

– or –

b Click Search and select a record from the record list at the top of the form.

The selected record is displayed.

3 Click Delete or press F6.

A prompt is displayed asking you to confirm the action.

4 Click Yes to delete the record.

A message is displayed, stating: Record deleted from the <file name> file.

Contacts File

The contacts file is used throughout ServiceCenter to provide complete 
contact information for items or activities such as incident tickets, change 
requests, and inventory records. Typically, contacts are also associated with 
certain assets, which simplifies the task of opening a call report, an incident 
ticket, or a change request.
84 Chapter 2—Support Files 



System Administrator’s Guide, Volume 1
Contact records may be added or updated by first level support technicians 
in the process of taking a call. When this occurs, the technician adds only 
enough information about the contact to open the ticket. The task of 
completing the contact record is often the responsibility of the user’s 
administrator.

To get to the Contacts file, click the Support tab from the ServiceCenter home 
menu, then click Contacts.

Figure 2-2: Contact record 
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Header Fields

Business Tab

Field Description

Contact Name unique key for the contact record (equal to the contact’s last 
name in the out-of-box system).

Employee ID unique, alpha-numeric identification number of the 
contact.

Last Name last name of the contact.

First Name first name of the contact.

Field Description

Primary Asset Asset most commonly associated with this contact. Click 
Browse to access the asset file and select an asset.

Company Name of the company for which this contact works.

Depart Name Name of the department for which this contact works.

Title Contact’s business title (for example, Manager, Sales Rep, 
Technician).

Group Name of the group/division for which this contact works.

Shift Hours this contact works (for example, day, graveyard).

Email Contact’s e-mail address.

Note: If you leave the e-mail address field blank, the user 
will receive no notifications, and the e-mail sender will 
have no way of knowing this.

Manager Name of the manager associated with this contact. This field 
is used by Work Management.

Service Contract A Contract Management field naming a service contract 
associated with this contact.

Corp Struct/Div Department hierarchy for this location taken from the dept 
file.
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SAP fields
ServiceCenter can be integrated with certain SAP applications through the 
SCAuto interface available from Peregrine Systems. The following fields are 
used by ServiceCenter system administrators who are interfacing with SAP 
human resource applications through SCAuto.

Critical User Client staff who perform vital tasks for some or part of the 
time. Downtime for these users has a greater business impact 
than downtime for standard users.

Requires 
Entitlement

Requires the user to go through an SLA entitlement check 
when opening a call ticket.

Field Description

Valid From Specifies the beginning of the validity period.

To Specifies the validity end date.

Company Code An organizational unit within external accounting.

Cost Center An organizational unit within a controlling area that 
represents a separate location of cost incurrence.

Personnel Area An organizational entity representing an area within an 
organization defined by specific aspects of personnel 
administration, time management, and payroll.

Subarea An organizational entity which represents part of a 
personnel area distinguished from others by unique features 
of personnel administration, time management, and payroll 
accounting.

User Type The type of user. Options are site, home, or mobile.

Payroll Contact’s unique payroll id number.

ServiceCenter ID The operator name (from the operator file) for contacts 
that are also ServiceCenter operators.

Field Description
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Address Tab

Figure 2-3: Address tab in a contact record

Fields

Fields Description

Location Physical location, from the location file, defining the area of 
the country in which the contact’s office is located.

Location 
Structure

Department hierarchy for this location.

Name The unique name from the location file naming the facility in 
which the contact works (for example, atlanta data center).

Address Complete street address of the contact’s place of business.

Hours Working hours of the contact.

Building Building number (if any) where the contact’s office is located.

Floor Floor on which the contact’s office is located.

Room The contact’s room.

Office/Cube The contact’s office or cube.

Home Address The complete street address of the contact’s home.
88 Chapter 2—Support Files 



System Administrator’s Guide, Volume 1
Contact Numbers Tab

Figure 2-4: Contact Numbers tab in a contact record

Fields

Field Description

FAX Fax number for the contact.

Phone Contact phone numbers, including: work extension, home, 
car and portable phones.

Pager Information Complete information on the contact’s pager.

Two-Way Paging SCAutomate function allowing a user to update or close an 
incident ticket via pager. If this field evaluates to true, the 
contact possesses two-way paging capabilities.
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Misc. Tab

Figure 2-5: Miscellaneous tab in a contact record

Fields

Field Description

Aristocratic Title The contact’s aristocratic title if applicable. For example, 
Count or Countess.

Language An SAP field indicating the contact’s principal language.

Form of Address How the contact is to be addressed (for example, Mr., Mrs., 
Ms.). The system then assigns the relevant internal key which 
indicates the employee's gender.

Communication 
Type

An SAP field describing a type of communication device (for 
example, cellular phone, fax).

Communication 
Number

An SAP field containing the number of the corresponding 
communication device. 
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Comments Tab
The comments field is an optional field in which you may enter any 
additional information about the contact that is not already recorded in the 
record. This data is not used in any other part of ServiceCenter. 

Figure 2-6: Comments tab in a contact record

Attachments Tab
The Attachment tab uses an OLE container to display attachments. Attach 
any documents pertaining to this contact in this tab.

Figure 2-7: Attachments tab in a contact record
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There are two options for attaching documents to a contact record:

Pop-up menu: Right-click the Attachments tab field, and select Insert 
from the shortcut menu.

Drag-dropping documents: Drag documents from a file folder directly 
into the Attachments tab.

Refer to Chapter 2, OLE Containers for a complete discussion of attaching 
documents to an OLE container.

Note: Currently, OLE containers are supported only in Windows, OS/2, and 
Macintosh operating systems.

Portrait Tab
The Portrait tab allows you to display a bitmap (.bmp) image of the contact 
if you wish. This field is similar to the Floor Plan tab in the location file 
(page 97) and functions in the same manner.

Adding an Image
The system inserts the bitmap into the frame provided. For the proportions 
of your portrait to be correct, you must adjust the size of the frame to match 
that of the bitmap you intend to use. For detailed instructions on editing 
ServiceCenter forms, refer to the Forms Designer chapter of ServiceCenter 
System Tailoring, Volume 1.

To insert a bitmap:

1 Right-click the blank frame of the Portrait tab.

A shortcut menu is displayed (Figure 2-8 on page 93).

Note: If the menu does not display, try clicking outside the frame, and then 
return to the frame.

Note: Only one bitmap can be stored at any one time.

2 While continuing to hold down the mouse button, select the Insert bitmap 
option.
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A dialog box for selecting an image is displayed.

Figure 2-8: Shortcut menu and dialog box for selecting a bitmap—Portrait tab

3 Select the bitmap file that you want displayed in the tab.

4 Click Open to insert the image.

Note: It is not necessary to save the record to save your changes. The image 
is inserted into the record permanently when the option is selected.
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Deleting an Image
To delete an image from a contact record:

1 Right-click the bitmap image of the Portrait tab.

A shortcut menu is displayed.

Note: If the menu does not display, try clicking outside the frame, and then 
return to the frame.

2 While continuing to hold down the mouse button, select the Delete bitmap 
option.

The bitmap is deleted from the tab.

Note: It is not necessary to save the record to save your changes. The bitmap 
is removed from the record permanently when the option is selected.
94 Chapter 2—Support Files 



System Administrator’s Guide, Volume 1
Location File

ServiceCenter contains a location file with records listing the physical address 
of the components. This data is used to fill in the Company record and 
location information in records in other ServiceCenter applications, such as 
an incident ticket in Incident Management.

Figure 2-9: Location record
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Header Fields

General Tab Fields

Field Description

Location Unique name for identifying this location.

Location Code A unique set of characters identifying the location. For 
example, Australia may appear as aus, and a region of 
California may be indicated by ca1.

Location Name The proper name of the site, for example, Corporate 
Headquarters.

Parent Location The main location. The value in this field is a compilation of 
the company code and the location name of the parent 
location (if a parent location exists). This field is optional.

Location 
Structure

Defines the location structure based on the locations defined 
in the parent structure but does not include the company 
code. For example, the value in this field could name a specific 
building:

Del Mar/BLDG1

Location Full 
Name

The entire hierarchical structure of the location 
consisting of the parent location prefixing the location. 
A possible value for this field could be:

PRGN/Del Mar/BLDG1

Field Description

Address The site’s address.

Hours The hours this site is active.

Company The name of the company from the company file. This name 
may differ from the value in the Location Name field.

Primary Contact Primary contact for this location. The value in this field is 
from the contacts file.

Corp Struct/Div Complete department structure for this location.
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Floor Plan Tab
The Floor Plan tab displays an inserted bit mapped image. This option is only 
available for Windows-based clients. For example, this image could be the 
floor plan of the location. 

Figure 2-10: Floor Plan tab in a location record

Site Category Classification of this location. The four types that appear in 
the drop-down list are:

A-Critical Site
B-Major Site
C-Satellite Site
D-Home Site

Department The department in which the Primary Contact works.

Phone The Primary Contact’s phone number.

FAX The Primary Contact’s fax number.

Email The Primary Contact’s e-mail address.

Comments General comments field. The text here is not used by any 
other process in the system.

Field Description
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Adding an Image
The system inserts the bitmap (.bmp) into the frame provided. For the 
proportions of your diagram to be correct, you must adjust the size of the 
frame to match that of the bitmap you intend to use. For detailed instructions 
on editing ServiceCenter forms, refer to the Forms Designer chapter of 
ServiceCenter System Tailoring, Volume 1.

To insert a bitmap:

1 Right-click the blank frame of the Floor Plan tab.

A shortcut menu is displayed (Figure 2-11 on page 99).

Note: If the menu does not display, try clicking outside the frame, and then 
return to the frame.

2 While continuing to hold down the mouse button, select the Insert bitmap 
option.
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A dialog box for selecting an image is displayed.

Figure 2-11: Shortcut menu and dialog box for selecting a bitmap

3 Select the bitmap file that you want displayed in the tab.

4 Click Open in the dialog box to insert the image.

Note: It is not necessary to save the record to save your changes. The floor 
plan is inserted into the record permanently when the option is 
selected.
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Deleting an Image
To delete an image from a location record:

1 Right-click the bitmap image of the Floor Plan tab.

A shortcut menu is displayed.

Note: If the menu does not display, try clicking the pointer outside the 
frame, and then return to the frame.

2 While continuing to hold down the mouse button, select the Delete bitmap 
option.

The bitmap is deleted from the tab. 

Note: It is not necessary to save the record to save your changes. The bitmap 
is removed from the record permanently when the option is selected.

Model File

ServiceCenter contains a model file to track different models of components 
in a network. For example, the model file is linked to asset records in 
Inventory/Configuration Management. The model file is also linked to 
ServiceCenter’s Request Management, which is discussed in a separate 
manual. When model information is stored in Request Management, users 
can learn items such as:

Rules for processing a component as a line item, part of a quote or order.

Rules for selecting the components of a parent part.

Dependencies.

Approvals required when a component is part of a quote or order.

Quantities of a component that are in use, on hand, on order, and so on.
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Figure 2-12: Model record

Unlike the device file that contains a record for each component on the 
network, the model file allows you to create general records for each overall 
model. Model records are linked to the Model field in other records, such as 
an asset record.

For example, you may have 300 PCs of a particular model, for example, a 
Toshiba Tecra 8000. The device file holds 300 asset records for these PCs, but 
the model file holds only a single record with details of the Tecra 8000.
Model File  101



ServiceCenter
General Tab

Field Description

Part No. Unique part number used to identify this model. If no part 
number is entered, ServiceCenter will automatically assign 
one when a model record is added, or you can add it 
manually.

Brief Description Textual description of the model.

Manufacturer Maker of the model. This field must match an existing vendor 
record. This is a required field.

Model Unique name or number assigned by the manufacturer to 
identify this asset. This is a required field. For example, a 
Hewlett-Packard printer can be a Laserjet.

Model Ext Defines the model extension number of the model. For 
example, the Model Ext for an HP Laserjet can be a 4SI. Note 
that it is just as valid to define the Model as a Laserjet 4SI.

Serialized Logical field indicating whether or not the model is serialized. 
This value affects the process used when generating orders.

Cost Cost per unit in the currency listed in the Currency field.

Currency Name of the currency used for calculating values in the model 
file. Currencies are defined in the currency file.

GL Number A general ledger number used for accounting purposes.

Default Priority Controls the order in which items are presented to the user 
for selection when a part is being selected in Request 
Management.

Note: To track serialized non-inventoried models, select this 
box and set the Config File field to non-inventoried.

Default Quantity Defines the default quantity of this item to order

Config File File to which data is posted when this type of model is 
received.

Attribute File Along with the Config File, a field that determines where a 
part should be defined in inventory. This field appears only if 
the value for Config File is device. For further information 
about attribute files, see the Inventory Management chapter 
in the Application Administration Guide.
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Current Quantities Tab

Figure 2-13: Current Quantities tab in a model record

Note: The fields in the Current Quantities structure default to 0 (zero) if no 
values are entered in these fields.

Detailed 
Description

Detailed textual description of this asset.

Instructions Arrayed field used with Request Management to enter any 
special instructions needed for this type of component. This 
array could contain assembly or installation instructions, 
reminders, and so on.

Field Description

Field Description

Stockroom The physical location of the stockroom.

Installed For serialized equipment, the quantity of this model in the 
device file that has a status of Installed. For non-serialized 
equipment, this value represents the quantity that has been 
delivered over the life of the model.

Available For serialized equipment, the quantity of this model in the 
device file that has a status of Available. For non-serialized 
equipment, this value is the current on-hand quantity.
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Reorder Tab

Figure 2-14: Reorder Information tab in a model record

Note: The Reorder Information fields default to zero (0) if no values are 
entered in these fields.

Reserved For serialized equipment, the quantity of this model in the 
device file that has a status of Reserved. This field is not used for 
non-serialized equipment.

Unavailable Quantity of this model in the inventory device file that has a 
status of Unavailable.

Received For both serialized and non-serialized equipment, the quantity 
of this model with a status of Received. An item is considered 
received after it has been logged during the Order Line Item 
receiving process but not yet posted to the appropriate 
inventory file.

On Order For both serialized and non-serialized equipment, the quantity 
of this model currently ordered. 

On Request For serialized and non-serialized equipment, the quantity of this 
model currently on request.

Backordered Indicates the number of this model that are on back-order.

Field Description
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Field Description

Min. Ord. Amount Minimum quantity of this model that can be ordered.

Max. Ord. Amount Maximum quantity of this model that can be ordered. 

Lot Size (Ord) Lot size used when this model is ordered from a vendor. 
The order amount is always a multiple of this number. 

Unit/Measure Standard unit of measure for this asset.

Reorder Type Controls the processing used when a model is ordered. A 
drop-down menu provides three options:

batch—activate the Reorder fields.
immediate—indicates that this model should be ordered 
immediately.
phantom—this model is not reordered. A phantom is a 
place holders, or pseudo parts, used to organize a 
collection of multiple items and provide flexibility in 
defining component relationships within a catalog. A 
phantom can be considered an umbrella type of level for 
several parts selections of the same type and is not usually 
a physical item.

Stockroom List of stockrooms from which to order

Reorder Point Point at which this model is ordered. When the quantity in 
the Available field moves below this value, the quantity 
shown in the Reorder Amount field is ordered. The Reorder 
Type field must be set to batch to activate this field.

Reorder Amount Amount ordered when the Available quantity drops below 
the Reorder Point. The Reorder Type must be set to batch 
to activate this field.

Purchasing Group Key for a buyer or group of buyers responsible for certain 
activities. A purchasing group is internally responsible for 
the procurement of certain types of materials. For example, 
the IT Department purchases all computer related 
materials, while Facilities handles the procurement of office 
furniture.

Material Group Classifies similar materials within an organization. This 
field tracks the material categories you define. For example, 
you may have different classifications of manufacturing 
equipment or building materials. A large organization, 
composed of several business divisions, can use this field to 
keep a division’s unique stock viewable to members of that 
division only.
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Note: The model file also includes extensive catalog definition data for each 
model, including its components, dependencies, part and component 
conditions, associated alerts and approvals, and receiving and posting 
rules. For details of catalog configuration fields within the model file, 
see the ServiceCenter Request Management manual.

Model file data can also be viewed using alternate forms. In particular, 
form ocmco.detail lets you define and view detailed catalog part and 
component conditions rather than just simple true/false conditions. To 
use an alternate view, click Views in the system tray, and then select the 
desired view.

Consume Avail Logical field permitting the inventory depletion of this 
model. Select this box if the available inventory is 
consumed when Quote Line Items are processed in the 
application ocmo.create.order. The box is not selected by 
default. This box is not selected for non-inventoried 
equipment.

Combine Logical field controlling the processing of Quote Line 
Items. Select this box if Quote Line Item quantities are 
combined into one Order line item when they are 
processed. If this box is not selected, a unique Order and 
Order Line Item is created for each Quote Line Item. The 
box is not selected by default. 

Track Receiving Logical field controlling receipt tracking of this model.

Field Description
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Vendors Tab
The Vendors tab accesses all vendors that provide services for this 
component. The search is performed against the modelvendor file and is 
based on the part number of the current model record. 

Figure 2-15: Vendor information in the model file
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Catalog Tab
The Catalog Information tab displays component definitions from Request 
Management based on the part number of the current model record. For 
additional information on the fields in this tab, please refer to Request 
Management.

.

Figure 2-16: Request Management component definitions
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Software Tab
The Software tab displays information for software licensing and installation. 
Use this tab only if the data in the LI Category field on the Catalog tab 
references a software license or software installation. For details about this 
tab, see the Application Administration Guide.

Picture Tab
This Picture tab (Figure 2-17 on page 109) is an OLE container for bitmap 
images. For instructions on placing and handling such images, refer to File 
Attachments and OLE Containers on page 69.

Figure 2-17: OLE container for bitmap images of part

Field Description

LI Category Allows you to group like entries under one common name. 
This data comes from Request Management. This is a 
required field.

Assigned Dept Field used to assign a group to a part

Sequence User definable sequence used to sort items in the Request 
Management catalog selection process. Sequence numbers 
sort in ascending order with blanks coming first.
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Options Menu - Active Model Record
The Options menu of an active model record contains options unique to the 
model file. For a discussion of options in a blank model record form, see 
Options Menu Items on page 126.

Deleting a Model Record
To delete an existing model record:

1 In the system administrator’s home menu, click the Support tab.

2 Click Models.

A blank model record (model) is displayed. 

Field Description

Print Prints the current record on a server printer.

Validity Lookup Checks the data in the current field against the ServiceCenter 
validity table for that field.

Export/Unload Allows you to export this record into a file for importing into 
a spreadsheet, or provides options to unload the DBdict or 
prepare a query to select records to unload.

IR Query Accesses ServiceCenter’s IR (Information Retrieval) Expert 
application.

Expand Array Displays a separate window with an expanded version of the 
highlighted array, allowing you to enter or remove values in 
the array.

Summarize Summarizes the current parent-component definitions into 
an array which shows at a glance the relationship of various 
model records.

Take Inventory Runs the model.take.inventory application to search the file 
in Config File field for all items in the inventory with the 
same Part Number and totals based on Status (installed, 
reserved, available, unavailable); then calculates from the 
ocml file the number for on order, on request, and received.
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3 Select an existing record using the following procedure:

a Enter any information about the desired record in the fields provided and 
click Search or press Enter, or

b Click Search and select a record from the record list of models displayed 
at the top of the form.

The requested record is displayed.

4 Click Delete or press F6.

A form is displayed asking you to confirm the deletion of the record. 

5 Click Yes to confirm the action.

You are prompted to select the appropriate items to delete option from the 
Summary View of Request Management Parent/Component Relationships 
(ocmo.smry.g) dialog box (page 111).

Figure 2-18: Parent/Component relationship list
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This screen allows you to delete all associated components of this item, which 
could be a parent to several related items.

Drop item removes the item from the line where the cursor is located, 
leaving all other items on the delete list.

Delete all continues with the delete process, removing all items remaining 
on the list.

6 Remove all items that you do not want to delete, and then click Delete all.

A Request Management Component Definition form is displayed in browse 
mode as a confirmation window for each child component if there are 
multiple items to delete.

Figure 2-19: Component definition form

7 Click Delete for each item.

A message in the system tray states: Part <number> successfully deleted. Click 
Delete to delete other related components.
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Vendor File

ServiceCenter contains a vendor file that stores records of vendors, 
manufacturers, and contractors. This data is linked to many related files, 
such as quote, order, and line item Request Management files, where the 
information is placed in the Vendor field. This file is also linked to the Service 
Provider field in an incident ticket, to the Manufacturer field in the model 
file, the Vendor field in the device file, and to the Vendor field in the 
modelvendor file, for example.

Figure 2-20: Vendor record
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Header Fields
The vendor record fields provide information necessary for contacting and 
working with a vendor or manufacturer. Required fields are noted.

General Tab Fields

Figure 2-21: General tab in a vendor record

Field Description

Vendor/
Manufacturer

Name of the seller, manufacturer, contractor, service provider, 
and so on.

ID Unique alphanumeric identification assigned to this vendor 
record in the ServiceCenter database.

Phone Telephone number for the vendor/manufacturer.

Country Country in which the vendor/manufacturer is located.

Field Description

Name Name of the seller, manufacturer, contractor, service 
provider, and so on. This field is required.

Type Optional field defining the type of service this vendor 
supplies.

ID Unique alphanumeric identification assigned to this vendor 
record in the ServiceCenter database.

URL The vendor’s web site address.

Hot Line Telephone number for technical support.
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Sales Tab Fields

Figure 2-22: Sales tab in a vendor record

Order Contact Vendor’s representative.

Phone Telephone number of the contact in the Order Contact field.

Contract No. Service contract number.

Contract Person Contact who represents the vendor in the service contract.

Phone Telephone number of the contact in the Contract Person 
field. 

Field Description

Field Description

Sales Manager Name of the manager of this vendor’s sales office.

Phone Sales manager’s telephone number.

Sales Rep Vendor’s account representative to your company.

Phone Sales representative’s telephone number.

Sales Hours Sales representative’s working hours.
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Service Tab Fields

Figure 2-23: Service tab in a vendor record

Field Description

Technician Your contact in the service department.

Phone Technician’s telephone number.

Beeper Technician’s pager number.

Hours Service department hours.

After-Hours Contact Your service contact outside of business hours.

Phone The contact’s telephone number.

Manager Service department manager.

Phone Manager’s telephone number.

Escalation 
Procedures

Steps necessary to have service performed and problems 
escalated if they are not resolved. 
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Location Tab Fields

Figure 2-24: Location tab in a vendor record

Field Description

Address Scrollable array for the vendor’s mailing address, including 
the city, state and zip code where the vendor is located.

Country Country where the vendor is located.

Phone Vendor’s telephone number.

FAX Vendor’s fax number.

Email Vendor’s e-mail address.

Vendor? Selecting this checkbox indicates that this is a vendor record.

Manufacturer? Selecting this checkbox indicates that this is a manufacturer 
record.
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Company File

Company information contained in the company file is used throughout 
ServiceCenter to complete forms and validate fields, such as fields in 
Contract Management. Unlike the company record, which records particulars 
about your company, the company file contains basic location and contact 
information about other companies with which you have contractual 
relations.

Figure 2-25: Company information—external organizations
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Company File Fields
Contacts and View buttons on this form direct you to linked forms contacts.g 
and sla.edit respectively.

Field Description

Customer ID Unique number assigned to this company for 
identification. This is a required field.

Company Code Unique identifier (user definable) of this company. Click 
Contacts to browse contact records.

Company Name Full name of the company. This is a required field.

Default SLA for 
Company

Default Service Level Agreement for this company. Links 
the incident to the SLA on this company record.

Customer Since Date at which this company became a customer.

Address Street address of this company.

City/County/Post 
Code

City/county/postal or zip code to be used for the company 
mailing address.

Country Country code or name to be used for the mailing address.

Phone Number Principal phone number for this company.

Fax Number Fax number for this company.

Show Company in 
Multi-Company Lists

Displays this company in a list of companies for systems 
configured for multi-company mode. 

For further information about multi-company mode, see 
Using Multi-Company Mode on page 120.

Always Show 
Company in Lists

See above.

MANDATORY 
Affected Item

Not used in this release of ServiceCenter.

Service Manager Service manager for this company. The value in this field 
can be used for notification purposes.

Service Delivery 
Manager

Service delivery manager for this company if different from 
the service manager. The value in this field can be used for 
notification purposes.
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Using Multi-Company Mode
Running ServiceCenter in multi-company mode enables help desks to more 
easily manage data for multiple companies or departments. By using 
customized links and formats in conjunction with multi-company mode you 
isolate a company’s data. As a result, selections relevant only to that company 
appear when you open a ticket or generate bills and reports for the company. 

For example, a help desk analyst who services multiple companies opens a 
new call report based on the customer information he or she receives. If 
ServiceCenter is running in multi-company mode, the analyst sees data that 
applies only to that customer’s company. If ServiceCenter is not running in 
multi-company mode, the analyst sees data that applies to all companies that 
the help desk services. 

You can further segregate data and increase security by using multi-company 
mode with the Mandanten feature. For more information about this feature, 
see Mandanten Database Protection on page 297. 

To set ServiceCenter to run in multi-company mode, select Run in Multi- 
Company Mode on the Misc tab of the System Wide Company Record. For 
details about this field, see Miscellaneous Tab on page 211.
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Department File

The dept file records basic data about the various departments within your 
organization, including the internal SLA (service level agreement) that 
applies to this department. Department records can be accessed from other 
ServiceCenter files, using the Fill function.

Figure 2-26: Department record
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Information Tab Fields

Field Description

Department Unique department name consisting of the company code 
and the department name. The value in this field is compiled 
automatically by the system and is read-only.

This field is set in the trigger.dept.structure application on 
the set.final panel and provides a unique identifier for the 
record. Users should not modify this field.

Dept Name Full name of this department. This is a required field.

Dept Code Unique identification number of the department that is 
assigned by the person creating the record. You may use any 
alpha-numeric scheme.

Company Unique company code (user definable) from the company 
file.

SLA Number Number of an SLA that applies to this department.

Parent Department Main department that will be reporting for Service Level 
Agreements. The value in this field is a compilation of the 
company code and the department name.

Dept Structure Defines the department structure below the parent 
department. For example, the value in this field could name 
the Documentation group within the Research and 
Development department.

Research & Development/Documentation

Dept Full Structure Entire hierarchical structure of the department including the 
company code and a departmental subgroup. A possible 
value for this field could be:

PRGN/Research & Development/Documentation

Last Update Date this department record was last updated.

Updated By Name of the person who last updated this record.
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Positions Tab
Use the array field in the Positions tab to list the job titles for this department.

Figure 2-27: Departmental job titles
Department File  123



ServiceCenter
Org Chart Tab
The Org Chart tab is an OLE container into which you can insert an 
organizational chart of this department. Not all OLE objects are insertable, 
therefore only bitmaps are acceptable. Create the chart in another 
application (for example, MS Word or Visio) and save it as a bitmap (.bmp). 

Figure 2-28: Org Chart tab

Inserting an Image
To insert a bitmap image of an organization chart:

1 Right-click the blank frame of the Org Chart tab.

A shortcut menu is displayed (Figure 2-29 on page 125).

Note: If the menu does not display, try clicking the pointer outside the 
frame, and then return to the frame.

2 While continuing to hold down the mouse button, select the Insert bitmap 
option.
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A dialog box for selecting an image is displayed.

Figure 2-29: Shortcut menu and dialog box for selecting a bitmap—Org Chart tab

3 Select the bitmap (.bmp) file that you want displayed in the tab.

ServiceCenter looks for the file in the Run directory as the default location.

4 Click Open to insert the image.

Note: It is not necessary to click Save. The image is saved automatically with 
the record.
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Deleting an Image
To delete an image of an organization chart from a department record:

1 Right-click the bitmap image in the Org Chart tab.

A shortcut menu is displayed.

Note: If the menu does not display, try clicking the pointer outside the 
frame, and then return to the frame.

2 While continuing to hold down the mouse button, select the Delete bitmap 
option.

The bitmap is deleted from the tab.

Note: It is not necessary to click Save to save your changes. The bitmap is 
removed from the record permanently when the option is selected. 

Options Menu Items

The Options menu selections are consistent throughout the support file 
forms with the exception of the Options menu of an active model record. For 
a discussion of available options in model records, refer to Model File on 
page 100. 

All the support files in this chapter have different Options menu items 
depending upon whether a blank or active record is displayed.

Options Menu—blank Record

Field Description

Clear Clears the data entered in the form.

Restore Returns the fields in the form to the previous values. Only 
available in the initial form in which you enter data.

Advanced Search Displays a search window allowing you to write your own 
search query and sort the results by keyed fields.

IR Query Accesses ServiceCenter’s IR Expert application. 
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Options Menu—active Record

Export/Unload Allows you to export this record into a file for importing into 
a spreadsheet, or unload this data set for loading into another 
ServiceCenter system. Basically, you can export information 
to any product that has DDE (Dynamic Data Exchange) 
support.

Validity Lookup Checks the data in the current field against the ServiceCenter 
validity table for that field.

Reset Deletes all the records in the current file.

Warning: Do not use the Reset option unless you want 
to delete all of the records in the current file.

Regen Regenerates the indices for the current file.

Open Inbox Allows the user to select a predefined query (inbox) to search 
the file.

Expand Array Displays a separate window with an expanded version of the 
highlighted array, allowing you to enter or remove values in 
the array.

Field Description

Field Description

Print Prints the current record on the user’s default printer.

Validity Lookup Checks the data in the current field against the ServiceCenter 
validity table for that field.

Export/Unload Allows you to export this record into a file for importing into 
a spreadsheet, or unload this data set for loading into another 
ServiceCenter system. Basically, you can export information 
to any product that has DDE (Dynamic Data Exchange) 
support. 

IR Query Accesses ServiceCenter’s IR Expert application. 

Expand Array Displays a separate window with an expanded version of the 
highlighted array, allowing you to enter or remove values in 
the array.
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List Options Menu Items

The List Options menu contains options related to record lists and QBE lists. 
List Options are available in support files only when a list is active. 

Field Description

Mass Add Allows you to modify selected records in a file and add them 
to the database, while leaving the original records in place. An 
example of this might be to prepare a list of PC records from 
the device file for export to another system. If the new system 
requires an identifying prefix for each PC, mass add can add 
duplicate PC records to the database bearing this prefix. A 
query can then find the new subset, which can be exported to 
an external file using the mass unload option.

Mass Update Allows you to update all the records in a file. This procedure 
overwrites the original records. An example of this might be 
to update part numbers in the model file to reflect a new 
identification scheme.

Mass Delete Allows you to delete all the records appearing in a record (or 
QBE) list. Query for a certain subset of records and select 
mass delete. You are prompted to confirm the action.

Mass Unload Allows you to unload all the records appearing in a record or 
QBE list to an external file.

Count Counts the records appearing in a record or QBE list. The 
total is displayed in a pop-up message window.

Print List Allows you to print either the record/QBE list or all the 
records.

Refresh Refreshes the record or QBE list display.

Modify Columns Allows you to edit column headings in a record or QBE list 
(see Column Headings on page 52).
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Export to Excel Exports all the records appearing in a record or QBE list 
directly to Microsoft Excel. Basically, you can export 
information to any product that has DDE (Dynamic Data 
Exchange) support. This DDE function requires Excel 95 or 
later.

Note: This option is available only on Windows clients.

Export to Text File Exports all the records appearing in a record or QBE list to an 
external file in text format. Choose a file name and text 
delimiter in the dialogue box displayed. The file is exported to 
the RUN directory in your client installation. This option is 
not part of the DDE support and can be run from clients other 
than those operating in Windows. 

Field Description
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CHAPTER

3
 User Access and Security Control
Overview

As system administrator, you will maintain users in the system by means of 
adding, editing, and maintaining user files, operator records, and profiles, 
and granting user system access rights within the system.

As system administrator, you permit access at three levels--access to the 
system (menu level) and access to and functionality within the ServiceCenter 
applications (capability words). You accomplish security setup for your users 
in the Central Administration Utilities through use of the Operator file, 
which contains the login name, password, and capability code(s) and the 
System Wide Company Record.

ServiceCenter is shipped with several operator templates already defined in 
the system, so you can choose to use some of these predefined users to create 
your user base within ServiceCenter. Each applicable type of user has 
different system rights and a different view of the system, as presented by a 
startup menu. See Operator Templates on page 184 to work with the 
pre-defined operator templates. This chapter will help you through the tasks 
of maintaining the ServiceCenter user base by showing you ways to add and 
edit users and their access rights.
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See the following topics to help you with these tasks.

Setting up profiles, based on User Role on page 132.

Adding Users on page 146.

Creating an Operator Record on page 147.

Using capability words, Capability Words on page 169.

Creating a Startup Menu on page 174.

Creating a Menu Record on page 178.

Changing user passwords, Passwords on page 189.

Modifying a System Wide Company Record, System Wide Company 
Record on page 196.

Using the User’s Assignment & Message Groups Tab, User’s Assignment & 
Message Groups Tab on page 218.

User Role

The out-of-box User Roles help to define operator roles within the 
ServiceCenter applications. An assigned User Role is the basis of assigning 
user profile types to properly engage the operators in each of the 
ServiceCenter applications. When you select an out-of-box User Role, the 
application profile settings within that User Role determine a user’s access 
and privileges within each of the ServiceCenter applications, from basic user 
with limited access to system administrator with full access. When the system 
administrator assigns a particular User Role to an individual or specific 
group type, that role takes on the assigned user profile settings defined for 
privileges and views within each application and determines what tasks the 
operator will be able to perform within the ServiceCenter applications. 

User Profiles
User profiles have varied levels of application access to accommodate the 
different levels of ServiceCenter users. The following describes the 
out-of-box User Profiles that have been set up within ServiceCenter that can 
be used when assigning User Roles to system users.
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User Profile Privileges

ADMIN Used in Service Management, Incident Management, Root 
Cause Analysis, Inventory Management, Change 
Management, and Request Management to grant full 
administrative access:

All basic options, including open, update, view, and close 
Call reports, Incident tickets, and Root Cause Analysis 
tickets.
Search the ServiceCenter knowledge base.
Open, review, approve, deny, and retract changes within 
Change Management.
Open and close quotes and orders within Request 
Management.
Approvals.
All print options.
All query options.

APPROVER Used in Change Management and Request Management to 
grant approval authority for requests for change and 
Request Management quotes and orders. Other privileges 
include:

Basic options, such as, count records, find, and notify.
All query options.
All print options.

ASSET 
MANAGEMENT

Used in Change Management to manage all Inventory 
Management assets and grant full administrative access:

All basic options, including open, update, view, and close 
change tickets.
Search the ServiceCenter knowledge base.
Open, review, approve, deny, and retract changes within 
Change Management.
Approve changes within the CA and ONSITE approval 
groups.
All print options.
All query options.

CLIENT SECURITY Used in Incident Management to grant the following:

Open, update, view, and close incident tickets.
Search the ServiceCenter knowledge base.
Reopen, log, print, and allow inefficient queries.
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COORDINATOR Used in Change Management, Inventory Management, and 
Request Management to grant administrative access to 
coordinate Change Management requests for change and 
Request Management quotes and orders. Privileges include:

All basic options, including open, update, and view 
requests for change and quotes and orders.
Approvals and overrides.
All print options.
All query options.

DEFAULT Used in Service Management, Incident Management, Root 
Cause Analysis, Inventory Management, Change 
Management, and Request Management to grant the 
following access rights and privileges, including:

View, log, find, fill, notify, count, search, override, allow 
inefficient queries, and check for duplicates for Call 
reports, Incident tickets, Root Cause Analysis tickets, 
requests for change, and quotes and orders.
Search the ServiceCenter knowledge base.
Within Change Management, all basic options, as well as 
all approval, print, and query options.
Within Request Management, most basic options, as well 
as all approval and print options and most query options.

EMERGENCY 
GROUP

Used in Change Management to expedite a change from 
within the Change Management application. All basic, 
approval, print, and query options are granted.

FACILITIES Used in Incident Management and Change Management to 
coordinate facilities activities. The following privileges are 
granted:

Most basic options, including view, log, find, fill, notify, 
count, search, override, allow inefficient queries, and 
check for duplicates for Incident tickets and requests for 
change.
Approvals without override.
All print and query options.
Search the ServiceCenter knowledge base.

FIELD ENG Used in Incident Management to grant the following access 
rights and privileges:

Some of the basic options, including view, log, find, fill, 
notify, count, search, override, allow inefficient queries, 
and check for duplicates for Incident tickets.
Search the ServiceCenter knowledge base.

User Profile Privileges
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HELPDESK Used in Change Management to grant the following access 
rights and privileges:

Track alerts.
Calculate the risks.
Some of the basic options, including view, log, find, fill, 
notify, save, count, search, override, allow inefficient 
queries, review, find parents changes, open tasks, and 
check for duplicates for requests for change.
Search the ServiceCenter knowledge base.
Approvals without override.
All print options.
All query options.

HELPDESK TECH Used in Service Management and Incident Management to 
grant the following privileges:

Open, update, view, close, and inactivate Incident tickets.
Search the ServiceCenter knowledge base.
Reopen, log, print, and allow inefficient queries.
Gain database access.
Create new categories.

INITIATOR Used in Service Management, Incident Management, Root 
Cause Analysis, Inventory Management, and Change 
Management to grant the following privileges:

Open, view, log, find, fill, and notify call reports and 
tickets.
Search the ServiceCenter knowledge base.
Log, print, count, and allow inefficient queries.
Create duplicates, new categories, and notes.

ISP Used in Incident Management to grant the following 
privileges:

Open, update, view, close, and inactivate Incident tickets.
Log, reopen, find, fill, and print tickets.
Perform advanced search.
Gain database access.
Create duplicates, allow inefficient queries, and check for 
incident duplicates on a device.

User Profile Privileges
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ISPADMIN Used in Incident Management to grant the following 
privileges:

Open, update, view, close, and inactivate Incident tickets.
Log, reopen, find, fill, and print tickets.
Perform advanced search.
Gain database access.
Create duplicates, allow inefficient queries, and check for 
incident duplicates on a device.
Inactivate and mass inactivate tickets.
Create new categories.

LAN SUPPORT Used in Change Management and Incident Management to 
grant the following privileges:

Open, update, view, and close Incident tickets.
Log, reopen, find, fill, and print tickets.
Perform advanced search.
Gain database access.
Create duplicates, allow inefficient queries, and check for 
incident duplicates on a device.

M/F SUPPORT Used in Change Management and Incident Management to 
grant the following privileges:

Open, update, view, and close Incident tickets.
Log, reopen, find, fill, and print tickets.
Perform advanced search.
Gain database access.
Create categories, allow inefficient queries, and check for 
incident duplicates on a device.

MANAGEMENT Used in Change Management to manage all requests for 
change. Grants full administrative access privileges, 
including:

All basic options, including open, update, view, and close 
change tickets.
Search the ServiceCenter knowledge base.
Open, review, approve, deny, and retract changes within 
Change Management.
Approve changes within the ASSET MANAGEMENT 
and CA approval groups.
All print options.
All query options.

User Profile Privileges
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MASTER Used in Request Management and includes the following 
privileges:

All basic functions, excluding database manager 
activities.
Alert log.
Approval options, including approve, mass approve, 
approval log, reevaluate, reset, and override.
All print options.
All query options.

ONSITE SUPPORT Used in Incident Management and Change Management to 
grant the following privileges:

Some of the basic options, including open, update, view, 
and close Incident tickets and requests for change.
Approvals for Change Management.
All print options.
All query options.

PROCUREMENT Used in Incident Management and Change Management to 
grant the following privileges:

Some of the basic options, including open, update, view, 
and close Incident tickets and requests for change.
Approvals for Change Management.
All print options.
All query options.

RECEIVER Used in Request Management to grant the following 
privileges:

Some of the basic options, including open, update, view, 
and close quotes and orders.
All approval options.
All print options.
Most query options.

REPLACEMENT Used in Incident Management to grant the following 
privileges:

Open, update, view, and close Incident tickets.
Log, reopen, find, fill, and print tickets.
Perform advanced search.
Gain database access.
Create duplicates, allow inefficient queries, and check for 
incident duplicates on a device.

User Profile Privileges
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REQUESTOR Used in Request Management to grant the following 
privileges:

Some of the basic options, including open, update, view, 
and close quotes and orders.
Log, reopen, find, and fill.
Post, reopen, generate orders, and so on.
Alert log.
All print options.
Some query options.
No approval options available.

REVIEWER Used in Service Management, Incident Management, Root 
Cause Analysis, Inventory Management, Change 
Management, and Request Management to grant the 
following privileges:

A few of the basic options, including audit, close, count, 
find, and list pages.
Alert log.
All print options.
Most query options.
No approval options.

SEAGATE INFO Used in Incident Management to allow the following 
privileges:

Browse.
Advanced search.
Print, views, and count.

SERVICE 
MANAGEMENT

Used in Change Management to grant the following 
privileges:

Some of the basic options, including alerts, open, find, 
fill, notify, and save requests for change.
Approvals.
All print options.
All query options.

User Profile Privileges
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SERVICE TECH Used in Incident Management to grant the following 
privileges:

Most of the basic options, including open, update, view, 
and close Incident tickets.
Log, reopen, find, fill, and print tickets.
Perform advanced search.
Gain database access.
Create duplicates, allow inefficient queries, and check for 
incident duplicates on a device.

SOFTWARE Used in Change Management to grant the following 
privileges:

Some of the basic options, including alerts, open, find, 
fill, notify, save requests for change, and IR query.
Approvals.
All print options.
All query options.

STANDARD Used in Incident Management to grant the following 
privileges:

Most of the basic options, including open, update, view, 
and close Incident tickets.
Log, find, fill, and print tickets.
Create new categories and notes, allow inefficient queries, 
and check for incident duplicates on a device.

SYSADMIN Used in Incident Management, Service Management, 
Inventory Management, Root Cause Analysis, Change 
Management, and Request Management to grant the 
following privileges:

Open, update, view, and close Call reports, Incident 
tickets, and Root Cause Analysis tickets.
Search the ServiceCenter knowledge base.
Open, review, approve, deny, and retract changes within 
Change Management.
Open and close quotes and orders within Request 
Management.

SYSTEMS ADMIN Used in Incident Management and Change Management to 
grant the following privileges:

Open, update, and view Incident tickets and requests for 
change.
Search the ServiceCenter knowledge base.
Open, review, approve, deny, and retract changes.

User Profile Privileges
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SYSTEMS 
SUPPORT

Used in Change Management and Incident Management to 
grant the following privileges:

Open, update, view, and close Incident tickets.
Log, reopen, find, fill, and print tickets.
Perform advanced search.
Gain database access.
Create duplicates, allow inefficient queries, and check for 
incident duplicates on a device.

TECH Used in Inventory Management, Root Cause Analysis, 
Change Management, and Request Management....

Open, update, and view Root Cause Analysis tickets.
Reopen, find, and fill tickets.
Perform advanced search.
Create personal inboxes.
Approvals and alerts within Change Management.
All print and query options within Change Management.
All approval and print options within Request 
Management.
Most query options within Request Management.

TECH LEVEL 2 Used in Root Cause Analysis to grant the following 
privileges:

Open, update, and view Root Cause Analysis tickets.
Reopen, find, and fill tickets.
Perform advanced search.
Create personal inboxes.

TELECOMS Used in Change Management and Incident Management to 
grant the following privileges:

Open, update, view, and close Incident tickets.
Log, reopen, find, fill, and print tickets.
Perform advanced search.
Gain database access.
Create duplicates, allow inefficient queries, and check for 
incident duplicates on a device.

User Profile Privileges
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TRAINING Used in Change Management and Incident Management to 
grant the following privileges:

Open, update, view, and close Incident tickets.
Log, reopen, find, fill, and print tickets.
Perform advanced search.
Gain database access.
Create duplicates, allow inefficient queries, and check for 
incident duplicates on a device.

WAN SUPPORT Used in Incident Management and Change Management to 
grant the following privileges:

Open, update, view, and close Incident tickets and 
requests for change.
Log, reopen, find, fill, and print tickets.
Perform advanced search.
Gain database access.
Create duplicates, allow inefficient queries, and check for 
incident duplicates on a device.
Alerts and approvals within Change Management.
All print and query options within Change Management.

User Profile Privileges
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Central Administration Utilities

The Central Administration Utilities give you the ability to view and edit 
existing users in the operator record, as well as edit the user’s contact record, 
assignment groups, and message groups from one central place. They also 
help the system administrator to gain access to adding new users and setting 
the proper security controls. To learn more about adding users and setting 
security controls, see the following topics.

Viewing and Editing User Data on page 144.

Adding Users on page 146.

Creating an Operator Record on page 147.

Capability Words on page 169.

Passwords on page 189.

System Wide Company Record on page 196.

User Administration on page 214.

See the ServiceCenter Application Administration Guide to learn more about 
assigning profiles to each user for the ServiceCenter applications.

There are two ways to access the Central Administration Utilities functions 
within ServiceCenter:

Via Command line shorthand notations from command prompt.

Via the menu option.

Command Line Access:

Enter cau on any menu command line.

-or-

Menu Access:

1 In the system administrator’s home menu, click the Utilities tab.

2 Click Administration.

The Information/Security/Insight menu is displayed.

3 Click User Administration in the Security structure.

The Central Administration Utilities menu is displayed (Figure 3-1 on 
page 143).
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The tabs in the form shown in Figure 3-1 on page 143 represent the options 
available to the system administrator to centrally manage users’ access and 
privileges, and conduct searches on contacts and operators.

Figure 3-1: Central Administration Utilities home menu
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User and Contact Utilities

Viewing and Editing User Data
View and edit existing users to add or edit access and privileges settings 
within the following records, profiles, and message and assignment groups.

Users

Contacts

Service Management profiles

Incident Management profiles

Root Cause Analysis profiles

Inventory/Configuration Management profiles

Change Management profiles

Request Management profiles

Assignment groups

Change Management message groups

Each tab allows you to view and edit user data, so that you can easily identify 
where changes need to be made to the user’s information.

Utility Description

View User Data View and edit existing users to add or edit access and 
privileges settings. For details, see the following section, 
Viewing and Editing User Data.

User Quick Add 
Utility

Quickly add new users and their access rights to applications 
within ServiceCenter. See User Quick Add Utility on 
page 219 for detailed information on how to quickly add 
new users and their contacts within CA Utility.

Search for 
Operators

Search existing operators to select and edit existing user data.

Search for Contact 
information

Search existing contact information to create or modify 
contact records.

Search for User 
Inbox Listing

Search existing user inbox listings.

Search User Roles Search existing user roles and see the capabilities of each 
role.
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To view and edit existing users and their security information:

1 Click View User Data.

2 When prompted, select a user from the existing users list to view.

The user’s information will be displayed, as shown in Figure 3-2 on page 145. 
This screen allows the administrator to quickly see that the user being viewed, 
in this case BOB.HELPDESK, has a profile for Root Cause, Service 
Management, and Incident Management. This user will have the same 
Service and Incident Management capabilities as all of the other members of 
the HELPDESK groups. However, BOB.HELPDESK’s Root Cause access will 
be defined differently by his Root Cause profile.

Figure 3-2: View and edit user data within CA Utility

3 When you add or edit user information, click Add or Save to update the 
information.
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Warning: Do not edit the operator record for the logged on user. If you need 
to revise the system administrator record with which you logged 
on, create a second record with a different login name and the same 
capabilities. You can do this by changing the login name and 
adding the record. Do this by clicking Add, not Save. Then log on 
using the new login and edit your record.

Note: If a user is logged on, any changes you make to that operator’s record 
are implemented after the user logs out and logs back on.

To add a new blank profile, select User Role. For this example, Helpdesk 
Tech was selected. See User Role on page 132 for access details on each of the 
user roles.

The User Role you select assigns the appropriate application profile for that 
user’s role. 

Note: Be sure to click the Fill button so that all application profile 
information is filled correctly when a user role is selected.

If you need to make modifications to the application profile that will be 
unique to the Operator being set up, either fill in the profile information or 
modify the information as needed. See the ServiceCenter Application 
Administration Guide for detailed information about setting up user profiles, 
and selecting privileges and views options.

4 Click Add, which will return you to the previous menu.

The new profile has been saved and will be added. A message is displayed, 
stating: User Service Profile record added. 

You can continue to add or edit profiles, as needed.

5 Click Back to return to the Central Administration Utilities main menu.

Adding Users
ServiceCenter is shipped with several default users already pre-defined with 
operator records. Each type of user has different system rights and a different 
view of the system, as presented by a startup menu. You may copy and 
modify records from a default user’s operator template for your new user, or 
build new records from scratch.
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You must complete the following tasks to add a user to your system:

Creating an Operator Record on page 147 where the fields in the Operator 
record are defined to help you create a new user.

Capability Words on page 169 in which you define capability words for 
your new user.

Creating a Startup Menu on page 174 for your user.

Creating a Menu Record on page 178.

Creating an Operator Record
While the System Wide Company Record designates system-wide settings, the 
Operator record designates specific settings for each user (Operator record). 
The Operator record identifies the login name and password, which are 
required for access to the ServiceCenter system. This section describes the 
fields in the Operator record and provides instructions for creating an 
Operator record. We will create a new Operator record, using Quick Add 
Utility in CAU.

There are two ways to access the Operator record to add and edit a user within 
ServiceCenter:

a Via the Operator record.

In the system administrator’s home menu, click Administration in the 
Utilities tab. Then click Operators in the Security structure of the 
Information/Security/Insight menu.

-or-

b Via the User Quick Add Utility in CAU.

To access the User Quick Add Utility in CAU:

1 Click Administration on the Utilities tab.

2 Click User Administration in the Security structure of the 
Information/Security/Insight tab.

3 Click User Quick Add Utility.

A dialog box will display, prompting you to enter the name of the User to be 
added. 

4 Enter the name of the User to be added.

A dialog box is displayed that asks if you want to clone another user.
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a Click Yes to clone another user. Select an existing User from the 
drop-down list.

-or-

b Click No to create a user from scratch.

Note: Some fields are filled in automatically by ServiceCenter.

Note: The following definitions (Figure 3-3 on page 148) use the 
BOB.HELPDESK operator record as an example.

General Tab
This tab contains date, time zone, application profile, and other general 
information about a selected operator (see Figure 3-3).

.

Figure 3-3: General tab in the operator record
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Date Information

See Time Zone Function and Date Formats on page 271 for further details on 
the Local Date Format functionality.

Field Description

Login Name Operator’s ID (login ID) that will be used for logging on to 
ServiceCenter. This field is required.

Note: Do not put underscores in a login name. In text 
mode, an underscore is translated into a space and the 
name is not recognized.

Language Controls the operator’s principal language used inside 
ServiceCenter. The default is English. This field is required.

Full Name Operator’s full name.

Default Company Default company code of this user’s company. This could be 
one of the company codes that display in the System Wide 
Company Record. Since ServiceCenter handles multiple 
company codes, you may not want to put a default company 
name here. For more information, refer to Company File on 
page 118.

Field Description

Time Zone Optional field containing the operator’s time zone. This field can 
be left blank to default to the time zone set up in the System Wide 
Company Record. The Fill function can be used to access the 
Time Zone (tzfile) file, if needed. For more information on Time 
Zone functionality and date formats, see Time Zone Function and 
Date Formats, Chapter 6.

Format Optional field containing the date formats. You only need to 
enter a format to override the format set in the System Wide 
Company Record. The formats are:

mm/dd/yy—standard US format

dd/mm/yy—European format

yy/mm/dd—optional format

mm/dd/yyyy—standard US format

dd/mm/yyyy—European format

yyyy/mm/dd—optional format
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Time Limits

Application Profile

Security Tab (Includes Account Management Controls)
Security includes account management controls for when and how 
passwords are changed within ServiceCenter. It also covers measures to 
detect and prevent security intrusions into the system.

Field Description

Database, Incident 
Management, 
Change 
Management

Amount of time to query in Database Manager (DB), 
Incident Management (IM) and Change Management (CM) 
before prompting the operator to continue. The default is 
entered automatically if no other value is entered. The default 
is either 10 seconds or the interval defined in the System Wide 
Company Record. The format is hh:mm:ss.

Field Description

User Role The basis for assigning profile types to the operator for access 
and privileges within each ServiceCenter application. See User 
Role on page 132 for more details about the user roles and 
their access rights and privileges within the ServiceCenter 
applications.

Note: Be sure to click the Fill button so that all application 
profile information is filled correctly when a user role is 
selected.

Service Profile, 
Incident Profile, 
Root Cause Profile, 
Inventory Profile, 
Contract Profile, 
Change Profiles, 
Request Profiles

User Role profile assignments for each ServiceCenter 
application.
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Figure 3-4: Security tab in the operator record

Password Information and System Lockout Reset Information
The Password Information structure addresses setting a user’s password. It 
also displays historical information for lockouts a user has experienced.

Field Description

Password Operator’s password, if required at login. If left blank, no 
password is required for this operator. (Permission not to use a 
password is defined in the Company information record.) The 
characters in this field are not displayed at login. You can change 
an operator’s password here. Users can change their own 
passwords, only if they have permission as defined in their 
operator records.

Note: If the System Wide Company Record specifies password 
expiration, every user is required to have a password. If the 
password is not specified here and the System Wide Company 
Record requires it, the first time the user logs in she or he will 
be prompted to enter a password that will then be saved in 
that user’s Operator record. This option allows new users to 
“pick” their own password the first time they log on.
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User’s Lockout Historical Information
Within the Password Information structure, the system displays historical 
information on lockouts a user has experienced.

To reset a user from being locked out of the system the system administrator 
can access the user’s operator record and select Options > User Lockout 
Reset. 

For an explanation of the operator record Options menu items and other 
security control issues, refer to the following topics.

Options Menus—Operator Record on page 167.

User Locking Information on page 154.

Passwords on page 189.

Restricting Logins on page 192.

Startup Tab (Includes an Operator’s System Capabilities) on page 158.

Capability Words on page 169.

Levels of Restriction on page 192.

Applying System Quiesce to Restrict Logins on page 193.

Login Information

Field Description

Last Reset Date when the operator last changed his or her password. If the 
password expiration is set, the user is prompted to enter a new 
password upon expiration. This field is automatically filled in 
by ServiceCenter at that time.

Last Reset By Name of on-site support person who last reset the password.

Logins Since Reset Number of logins since the password was last reset.

Last Login Date and time of the operator’s last access to ServiceCenter. 
This record is maintained by the login application. The 
activation and expiration in the System Wide Company 
Record is based on this date.
152 Chapter 3—User Access and Security Control 



System Administrator’s Guide, Volume 1
LDAP Information

Template Information

Failed Login 
Count

Number of times the user’s login failed. When the user lockout 
is reset, this box is cleared and the user is no longer locked.

Locked Until Date and time the account was unlocked, if locked out 
previously for failed logins. (Locked until is set in the System 
Wide Company Record.) When the user lockout is reset, this 
box is cleared and the user is no longer locked.

Field Description

LDAP Base Name Defines a different branch of the LDAP directory structure for 
this user. For additional information about LDAP fields, see 
the LDAP Server Interface chapter in System Administrator’s 
Guide, Volume 2.

Field Description

Template Name of the template used to merge this user’s operator 
record. For further information on templates, refer to 
Operator Templates on page 184.

Note: If you are creating a user with a login name and a 
template name, it is best to work with a blank template 
rather than fill in all the blanks.

Field Description
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User Session Information

User Locking Information
This structure determines how system and administrative locks will be 
handled with this user login and displays information as to how lockouts 
have occurred and when a locked out user has been reset (cleared of the 
locks). When a user lock has been reset, the Failed Login Count, Locked 
Until, and User has been Locked? fields are cleared.

Field Description

Max Logins Allows a user multiple logins (if the Unlimited Sessions check 
box is not selected). The default is based on the System Wide 
Company Record.

Disallow forced 
Logoff?

Prevents this user’s session from being “killed” by another 
user or process.

Unlimited 
Sessions?

Allows this operator to continually log on and have an 
unlimited number of open ServiceCenter sessions. The 
default is off.

Expire Password? When checked (true), this forces the user to change his or her 
password at the next login.

Field Description

Prevent Lockout? Prevents this user’s session from being locked by the system.

Administrative 
Lockout?

Used by the system administrator to manually lock out a user.

Note: This can be inactivated in the System Wide Company 
Record.
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Password History

User has been 
Locked?

For informational purposes. This box is checked (true) if this 
user has been locked out. When the user lockout is reset, this 
box is unchecked (false) and the user is no longer locked.

Note: Even though this can be changed by some RAD 
application or Format Controls, it is best practice to not 
manually change the information in this field.

Lockout Reason Reason user has been locked out of the system by the system 
administrator. 

The lockout reasons are as follows:

Locked by Admin—user has been locked out by the system 
administrator.
Max Failed Logins—user has reached the set maximum 
number of failed logins.
Account Inactivation—user account has been inactivated.
Account Expiration—user account has expired. If user is 
locked out for this reason, this lockout cannot be reset. A 
new operator record has to be added. Account Expiration is 
set in the System Wide Company Record.

If the user is not locked out of the system, the following is 
displayed instead:

Not Locked—user is not locked out.

Note: If the user is locked out of the system, the User has 
been Locked? field is automatically checked (true).

Field Description

Field Description

Reset By For historical purposes. Name of on-site support person who 
reset the user’s password.

Change Date For historical purposes. Date when the user’s password was 
last reset. This field is automatically filled in by ServiceCenter 
at that time.
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Login/Contact Profiles Tab
The Login/Contact Profiles tab includes setting up login and contact profiles, 
and Incident Management assignment groups.

Figure 3-5: Login/Contact Profiles tab in the operator record

Login Profile

Field Description

Resource Type Used to assign tickets in the Work Management application. 
With the exception of templates, this field is required.

Message Level Level of messages to store in the message queue for this 
operator. If this field is left blank, the system defaults to the 
Informational level and all messages are stored. 

The selections in the drop-down list are:

Information—writes informational, action, and error 
messages to the message queue.
Action—only writes action and error messages to the 
message queue.
Error—only writes error messages to the message queue.

Note: Message levels affect on-screen messages only and have 
nothing to do with the msglog file.

Max Attachment 
Size

Defines the maximum size of a file that this operator can insert 
into an OLE container. For more information on OLE 
containers, see File Attachments and OLE Containers on 
page 69.
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Contact Profile

Assignment Groups
Create Incident Management assignment groups, so that incident tickets can 
be assigned to the appropriate departments and people for resolution. See the 
ServiceCenter Application Administration Guide for details.

Message Count Number of messages to save in the queue.

Message Queue Switches on the message queue. The default is off.

Named User? Identifies this user as a named user who is granted a guaranteed 
connection to the system. For more information on named 
users, refer to Named Users on page 186.

Field Description

Phone Operator’s telephone number.

Department Name of the operator’s department.

Manager Name of the operator’s manager.

Room Room number, department name, or any other appropriate 
identifier for the operator.

Field Description
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Startup Tab (Includes an Operator’s System Capabilities)
The fields in the Startup tab define an operator’s system rights (capabilities) 
and identifies the initial user menu, which permits access to specific 
applications and utilities in ServiceCenter.

Figure 3-6: Startup tab in the operator record
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Initial Application

Field Description

RAD Name Name of the initial RAD (ServiceCenter) application to 
run for this operator. If this field is blank, the default is 
menu.manager.

Note: The menu.manager application takes you from 
one menu to another. For example, Menu manager 
allows you to access the Incident Management menu 
from the system administrator’s home menu.

Activate Command 
Line on Startup

Checking this box (true) makes the command line 
available for use on startup.

Parameter Names Parameter name. The parameters are dictated by the 
application. Primarily, three names are used:

name—menu record accessed if the session is run in 
the text mode.
prompt—text format accessed for the menu.
string1—menu accessed if the session is run in 
Windows mode.

Parameter Values Values passed into the application through the 
parameter names. This value helps identify what is 
displayed when a user starts a session. The value can be 
either a menu name or a format name, depending on 
the parameter.

Note: If the Parameter Value field is blank, the default 
is Main Menu. At logon you are sent to the system 
administrator’s home menu. To send a user to a 
different menu, you can specify menu.manager as 
the name of the initial application to run and enter 
an existing menu name as the parameter value.
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Months
Language used to report months for this user in ServiceCenter records.

Execute Capabilities Capabilities you want this user to have. This array 
defines what ServiceCenter functions this operator can 
access. You can use the Find function on this array.

Note: These capabilities are the allowable functions 
for this operator and must exist in the capability 
file.

Query Groups Defines the Change Management groups to which the 
operator belongs. You can enter the following types of 
groups:

change manager group—approval group of this 
operator’s manager.
change reviewer groups— Reviewer groups to which 
this operator belongs. (Reviewers examine the tasks 
and phases of a change, but do not have approval 
authority.)
change approval groups—groups for which this 
operator can approve changes.

Note: See the ServiceCenter User’s Guide for an 
introduction to Change Management, and the 
ServiceCenter Application Administration Guide for 
more information on approval groups.

Field Description

Field Description

Full Name Full name of the months.

Abrv Three letter abbreviation for the names of the months. 
If these fields are left blank, the months default to 
English.
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Notification Tab (Includes Contact Information)
The Notification tab contains contact information for the operator.

Figure 3-7: Notification tab in the operator record

Field Description

E-Mail Addr operator’s e-mail address.

FAX Optional information field for the operator’s fax number.

Note: Using ServiceCenter for e-mail, faxing, and paging is 
discussed in the ServiceCenter Event Services 
documentation.

Mailbox Names the Microsoft Outlook mailbox to be used by Work 
Management. The system checks the calendar in the user’s 
mailbox and integrates any commitments into the Work 
Management schedule. For additional information, refer to 
Appendix B of the Work Management User Quick Start Guide.

Printer An optional field allowing you to select a valid printer device 
name. This field sets the default printer for the operator and 
must be defined in the hardware configuration file. If the field 
is left blank, the system default printer is used.

In this example, the Fill option was used to select the 
Windows NT printer (sysprint).
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Client Printing

Paging Information
In order for a page event to take place, the applicable information about the 
contact’s or operator’s pager must be entered. To learn more about page 
events, see the ServiceCenter Guide to Event Services.

Security Groups Tab
The Security Groups tab (Figure 3-8 on page 163) establishes the user’s 
membership in a group whose access to certain files in the system is restricted 
by the Mandanten feature. This feature allows a system administrator to limit 
a group’s access to certain data or allow groups to share prescribed data.

Field Description

Lines Per Page Maximum number of lines per page the printer is 
capable of printing. The default setting is 60. This is a 
client printing option only.

Page Width Maximum line width (number of spaces) to ensure that 
the page is properly printed. Eighty (80) is the setting 
for standard 8.5 x 11 inch paper. This is a client printing 
option only.

Header Format Form name for a report header that is different from 
the default. This is a client printing option only.

Field Description

Phone No Operator’s pager number.

Vendor Name of vendor with which the contact is associated.

Group Name of group to which the operator belongs.

Type Operator’s resource type.

Name Operator’s full name.

PIN Operator’s personal identification number.

Voice MB Operator’s voice mail box.

2-Way Page? SCAutomate function allowing a user to update or close an 
incident ticket via pager. If this field evaluates to true 
(checked), the contact possesses two-way paging capabilities.
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For example, a department’s security group designation may limit the 
database access of its members to those incident tickets belonging to that 
department. For more information about the Mandanten feature, see 
Mandanten Database Protection, Chapter 8.

Figure 3-8: Security Groups tab in the operator record

Billing Information Tab
The Billing Information tab records the labor rate for the operator in the 
currency selected for the system. The rate in this tab is used for calculating 
the cost of servicing a contract in the Contract Management application. For 
example, when a technician repairs a device, the system multiplies the time 
spent with the labor rate as it is displayed in the Billing Information tab and 
bills the appropriate contract.

Figure 3-9: Billing Information tab in the operator record
User and Contact Utilities  163



ServiceCenter
Example

The simplest way to add a user is to go into the Central Administration 
Utilities and open the record of an existing user with similar system rights 
and add a new Operator record to the database. For example, to add a system 
administrator with the same rights as the FALCON user in the standard 
system, change the Login Name and contact information and add the record 
to the database by clicking Add.

To add a ServiceCenter user from scratch:

1 Click Administration on the Utilities tab.

2 Click User Administration in the Security structure of the 
Information/Security/Insight tab.

3 Click User Quick Add Utility.

4 Enter the name of the User to be added and click OK.

5 Enter an operator’s name in the Login Name field and click Search.

A dialog box will display, prompting you to enter the name of the User to be 
added. 

6 Enter the name of the User to be added.

A dialog box will display, asking if you want to clone another user.

7 Click No to create a user from scratch.

Note: Some fields are filled in automatically by ServiceCenter.

8 Fill in the fields of the General tab (Figure 3-3 on page 148).

a Create a user with a Login Name of JOE.USER.

b Select English as the principal language to be used.

c Enter Joe User in the Full Name field.

Field Description

Hourly Rate The hourly rate used to compute the cost of billing for a 
completed ticket.

Rate Currency The rate of exchange to be used between currencies, based on 
the time a contract is granted.

Display Currency The currency associated with the estimated cost.

GL Number A general ledger number.
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d Set the Data Base (DB), Incident Management (IM), and Change 
Management (CM) Time Limits.

For this example, set each field to ten seconds (00:00:10).

e Set the Time Zone and Format in Date Information.

For this example, select the US/Pacific time zone. The date format is 
automatically set to mm/dd/yy, although you may select another format. 
For more information on time zone and date formats, see Time Zone 
Function and Date Formats, Chapter 6.

f Assign Helpdesk Tech as the User Role.

Since the User Role drives the access rights and privileges for the 
Application profiles, these will be filled in automatically when User Role 
is selected.

When a user tries to access a ServiceCenter application, the system 
determines which profile to use. For example, if a user tries to access 
Incident Management, there is a profile stored in the pmenv file with a 
login name. If such a record is found, the system allows the user to access 
the application based on the assigned profile. If the system cannot locate a 
profile record for the user, it then searches for a default profile. If one is 
found and enabled, that profile will be used to determine the user’s rights. 
If no profiles are found, the login will be declined. See the ServiceCenter 
Application Administration Guide for detailed information about setting 
up user profiles, and selecting privileges and views options.

9 Enter the Security information (Figure 3-4 on page 151).

a Enter a default password for the user. The user can change this later, if 
desired. A password is required if the company information record either 
selects the Always require password check box or specifies a Password 
expiration interval; otherwise, the password can be left blank.

b Set the number of sessions for this user by selecting the Unlimited 
Sessions check box.

10 Enter the Login/Contact Profiles information (Figure 3-5 on page 156).

a Select Manager as the Resource Type to be used in the Work Management 
application.

b Select Information as the Message Level to be stored in the message queue 
for this operator.

c Set the maximum number of messages in the queue by entering 5 in the 
Message Count field.
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d Turn the message queue on by selecting the Message Queue check box.

e Enter the user’s voice telephone number in the Phone field.

f Enter support as the name of the Department in which Joe User works.

g Enter the name of Joe User’s manager.

h Enter a room number in the Room field.

i Select HELPDESK for the assignment and groups.

11 Enter the Startup information (Figure 3-6 on page 158).

a Enter the name of the initial RAD application that runs when this user logs 
in.

For this example, enter menu.manager.

b Enter the Parameter Names and corresponding Parameter Values.

In the example of joe.user, the name field is set to USER to indicate that 
the USER text menu record is accessed if joe.user logs on in text mode. The 
prompt of menu.prompt.1 is the text format containing the menu defined 
in the USER record. If joe.user logs on in Windows mode, string1 
indicates that the START menu record should be accessed. This record 
identifies the form (start.fmt) to be accessed for this menu.

c Enter the capability words that define the user’s system access in 
ServiceCenter.

For this example, use the following capability words:

problem management

query.stored

change request

change task

d Enter the Change Management Query Groups to which this user belongs.

For this example, leave these fields blank. These fields define review and 
approval groups for Change Management. Because this user is not a 
manager, review and approval capabilities are not necessary.

e Enter the Months information.

Because this user is working in English, no month definitions are required.
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12 Fill in the Notification tab fields (see page 161). These fields are optional.

a Enter the operator’s e-mail address.

For example, enter juser@company.com for Joe User.

b Select a default printer for this user.

For example, if this user operates on a Windows NT system, you could 
select sysprint.winnt.

c Enter the user’s paging information.

For example, simply enter the phone number for the user’s pager.

13 Enter a group name in the Security Groups tab (Figure 3-8 on page 163).

For this example, Joe User is not a member of a security group whose access 
to the system is limited. Leave this tab blank.

14 Enter appropriate billing information for Joe User (see page 164).

For example, enter an hourly rate of 45 in US Dollars.

15 Click Add to add the operator record to the database.

A message is displayed stating: Record added to the operator file.

Options Menus—Operator Record
The options menu located in CAU contains the following items.

Option Description

Validity Lookup Checks the data in the current field against the 
ServiceCenter validity table for that field.

Export/Unload Allows you to unload all the records appearing in a record 
or QBE list to an external file.

Reset Operators 
Password

Sets the password for the operator listed to the setting 
specified in the System Wide Company Record, such as 
the prompt for value or reset to user name. For more 
information on the System Wide Company Record, see 
System Wide Company Record on page 196.
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List Options Menu—Operator Record
The List Options menu is available when a QBE Record list is displayed.

User Lockout Reset Resets locked user field in the operator record. Does not 
work if the operator has already been expired.

Note: The operator record needs to be saved to complete 
the lockout reset. If the operator record is changed 
before the lockout reset or before the operator record 
is saved, then the user’s lockout will not be reset and a 
red exclamation point (!) is displayed with the 
following message in the status bar: *This record has 
changed since you selected it.

View Operator Accesses the user’s operator record.

Expand Array Displays a separate window with an expanded version of 
the highlighted array, allowing you to enter or remove 
values in the array.

Completely Remove 
User

Delete this user’s operator record, contact record, and 
profiles. Also removes this user from all assignment and 
message groups.

Warning: Information will be permanently deleted 
from the ServiceCenter system.

Option Description

List Option Description

Mass Add Allows you to modify selected records in a file and add them 
to the database, while leaving the original records in place. An 
example of this might be to prepare a list of operator records 
for export to another system. If the new system requires an 
identifying prefix for each, mass add can add duplicate records 
to the database bearing this prefix. A query can then find the 
new subset, which can be exported to an external file using the 
mass unload option.

Mass Update Allows you to update all the records in a file. This procedure 
overwrites the original records. An example of this might be to 
contact information from the contacts file.

Mass Delete Allows you to delete all the records displayed in a QBE record 
(or QBE) list. Query for a certain subset of records and select 
Mass Delete. You are prompted to confirm the action.
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Capability Words
User capabilities are defined using Capability words. Within the Operator 
record, Capability words for a user allow the user access to specific 
applications and utilities in ServiceCenter. Capabilities also provide security. 
For example, an end-user does not receive administrative capabilities.

Capabilities are assigned in the operator record, through the Execute 
Capabilities array. (See Security Tab (Includes Account Management Controls) 
on page 150.) 

Note: These capabilities can be overridden by the user profiles set up in each 
ServiceCenter application.

Predefined capability words are stored in the capability file. The capability file 
can be accessed from two locations:

Administration menu

Operator record

Mass Unload Accesses the Unload/Export Facility form where you can 
create an external copy of all records in the currently displayed 
contacts QBE list.

Expire Passwords Allows you to expire the passwords of all the records displayed 
in a QBE record list. Query for a certain subset of records and 
select Expire Passwords. 

Count Counts the number of records in the current QBE Record list.

Refresh Updates the current list.

Modify Columns Displays a dialog box where you can change the fields that 
determine the column headings of the QBE Record list.

Export to Excel Exports the current QBE Record list to a Microsoft Excel 
spreadsheet. Excel automatically opens with the list placed in 
a spreadsheet. Basically, you can export information to any 
product that has DDE (Dynamic Data Exchange) support. 
This DDE function requires Excel 95 or later.

Note: This option is available only on Windows clients.

Export to Text File Exports the QBE Record list to a text file. This option is not 
part of the DDE support and can be run from clients other 
than those operating in Windows.

List Option Description
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ServiceCenter’s applications and utilities recognize the following words, 
which define allowable functionality for a user: 

Capability Word Description

AlwaysAdmin Defaults Administration mode to true when using the 
Database Manager.

CM3Admin Allows access to all CM3 (Change Management) 
Applications for Administration. CM3Admin does 
not provide access to tasks and changes. Change 
Management task and change provide that 
functionality.

Db2Admin Provides DB2 Administrator Capability.

Debug Allows a non SysAdmin user to do debugging for 
testing purposes. Normal users should not have this 
capability word unless that user is involved in 
debugging.

Endevor Performs ENDEVOR-C1 Move Actions.

ICMAdmin Allows complete access to Inventory and 
Configuration Management for user and 
administrative functions.

OCMAdmin Allows complete access to all Request Management 
applications for user and administrative functions.

OCML Allows access to Request Management Line Item 
Applications.

OCMO Allows access to Request Management Order 
Applications.

OCMQ Allows access to Request Management Quote 
Applications.

ProbAdmin Allows complete access to Incident Management user 
and administrative functions.

QueryAdmin Provides full access to query options and 
maintenance, including: query window, stored query 
usage and editing, and so on. This capability is 
intended to be used like SysAdmin, as an 
administrator, not for general usage. Be cautious to 
whom you assign this capability, because it gives access 
to create and modify Stored Queries. Improper 
changes in stored queries can adversely affect system 
performance.
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SMAdmin Allows access to Service Management administration.

SQLAdmin SQL Administrator authority.

SysAdmin System Administrator Capability (that is, 
EVERYTHING).

amend suspension Allows this user to amend the Incident Management 
profile rights for suspend/unsuspend.

change request Allows access to Change Management changes.

change task Allows access to Change Management tasks.

data administrator Allows this user to save, add, or update supporting 
tables from within Service Management and Incident 
Management.

expedite change Allows this user to expedite changes in Change 
Management.

getit.admin Provides access to the OAA Admin module.

getit.advancedrequester Enables access to advanced request form features in 
Get-Resources.

getit.answers Provides access to answers/knowledge base through 
the Get.It! interface.

getit.approver Allows this user to approve requests through the 
Get.It! interface.

getit.change.approver For change approvals.

getit.change.request For change ESS users.

getit.change.technician Grants access to the Change Management module in 
Get-Services.

getit.itemployee Grants access to the Incident Management and Service 
Management modules.

getit.itmanager Grants access to the Incident Management and Service 
Management modules.

getit.personalization.
limited 

Allows users to do limited personalization.

getit.portal Allows users to view the OAA home page and portal 
components.

getit.receiver Allows this user to receive items for requests through 
the Get.It! interface.

Capability Word Description
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getit.requester Allows this user to make requests through the Get.It! 
interface.

getit.service Provides access to Problem Management through the 
Get.It! interface.

help Gives the user the ability to add or update help records 
through the HELP function.

inventory management Allows access to Inventory and Configuration 
Management user functions.

knowledge engineer Allows the capability to modify the adaptive learning 
records.

menu.commands Provides command line access to functions from a 
menu.

mobile.admin Grants access to the Peregrine Portal for Mobile user 
administration.

mobile.user Grants access to the Peregrine Portal for Mobile users.

mod.time.limit Allows user to modify the default time limit for a 
partially keyed query entered in either Database 
Manager or Change Management.

partial.key Allows user to execute a partially keyed query in 
Database Manager or Change Management.

partial.key.msg.skip Allows user to skip the partial key query message in 
Database Manager.

pfkey Allows individual operators to re-map pfkeys.

problem management Allows access to Incident Management.

programmer Allows access to the RAD editor.

query.stored Allows users to execute access of Stored Queries when 
Expert Search is selected from the Options menu of 
any application. The user can perform any Stored 
Query assigned to him/her or to a group to which 
he/she belongs (Query groups in operator record).

Capability Word Description
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Accessing the Capability File 
You can access the capability file from the Administrator’s menu or from 
within an operator record.

To access the capability file from the Administrator’s menu:

1 In the system administrator’s home menu, click the Utilities tab.

2 Click Administration.

3 In the Administration menu, click Capability Words.

A blank capability word record is displayed.

4 Click Search.

A record list of capability words is displayed.

To access the capability file from an operator record:

Execute the Fill function from the Execute Capabilities array in the Startup 
tab of the operator record.

query.stored.mod Allows user to execute or modify Stored Queries when 
Expert Search is selected from the Options menu of 
any application. Modify access is defined as being able 
to modify a stored query on the fly, not modifying the 
query database. The user can perform any Stored 
Query which has been assigned to him or her, or to a 
group to which that user belongs (that is, the Query 
Group list in the operator record). This user can 
perform a one time modification of the query before it 
is executed. The user does not have access to update 
the query file.

query.window Allows access to query window function in 
query.window application

system.build Allows user access to old binary text format unload 
options. These capabilities are used to create a 
ServiceCenter file system from scratch and must 
always be available to someone.

user Basic end-user functionality. The capability does not 
have access to functions such as add, delete, reset, and 
so on.

Capability Word Description
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Place the cursor in a blank line of the array and click Fill (Figure 3-6 on 
page 158).

A QBE list of all capability words in the system is displayed.

–or–

Place the cursor on a specific capability word in the array and click Find 
(Figure 3-6 on page 158).

The record for that capability word is displayed.

Creating a Startup Menu
Your new user now needs an initial startup menu displaying controls 
appropriate to the system rights you granted in the operator record. Use 
ServiceCenter’s Forms Designer utility to create the GUI form from which 
the menu is built. For detailed instructions on using this utility, see the Forms 
Designer chapter in ServiceCenter System Tailoring, Volume 1.

To create a user startup menu with control buttons:

1 In the system administrator’s home menu, click the Toolkit tab.

2 Click Forms Designer.

A Forms Designer dialog box is displayed asking for a form name.

Figure 3-10: Forms Designer dialog box
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3 Enter a form name in the Form field.

For example, create a form called user.menu.

4 Select a display language from the drop-down list.

If the Language field is left blank, the system uses the language in which 
ServiceCenter was installed.

5 Click New.

A prompt is displayed asking if you want to use the Forms Designer Wizard.

The Wizard automatically connects the form to an existing file as it guides 
you through the creation process.

6 Click No to move directly to the designer.

A blank Forms Designer canvas is displayed, with a Properties window and a 
Tools palette.

The name of the form you are creating is displayed in the lower-right corner 
of the form.

You can add any other features to the menu that you desire, including 
marquees or charts. For instructions on adding various features, see 
ServiceCenter Publish and Subscribe or the Forms Designer section of 
ServiceCenter System Tailoring.

7 Select the Button tool from the tool palette.

7
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8 Hold down the primary mouse button while using the cursor to draw a 
button.

When you release the mouse button, a blank button is displayed.

The handles at the corners of the button means that it is selected.

The Properties window provides specific information about the selected 
object—the button in this case—and allows you to configure it.

.

9 In the Property list, select Caption.

12
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10 Enter a caption for the button in the input field.

This caption is displayed on the button. For example, to create a button to 
access the Change Management, change request query screen, you could 
provide the caption of Change Management.

11 Press Enter or click Y in the Properties window.

12 In the Property list, select Button ID.

13 Enter a number for the button.

This number corresponds to the option number listed in the menu record.

For example, you could add the following buttons:

Forms Designer (button ID 2)—accesses the Forms Designer.

Database Manager (button ID 4)—accesses the Database Manager 
application.

Logout (button ID 3)—logs out the user. Button ID 3 is reserved by 
ServiceCenter for back and log off.

14 Press Enter or click Y in the Properties window.

15 Add any other buttons or items for functionality or appearance.

To place a bitmap image on a button, designate a *.bmp file in the Bitmaps 
field.

16 Click OK to exit the Design mode, and then click OK again to save your new 
form.

The following message is displayed in the status bar: Record updated in the 
format file.
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Figure 3-11 on page 178 shows an example of a custom menu. Notice that a 
bevel was added around the buttons to dress up the form.

Figure 3-11: Custom menu

Creating a Menu Record
For the menu you created in the previous procedure to display at startup, you 
must create a menu record. ServiceCenter menus are stored in the menu file. 
Records for this file are created using ServiceCenter’s menu setup.

To create a menu record:

There are two ways to create a menu record.

Via Command line shorthand notations from command prompt.

Via the menu option.
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Command Line Access:

1 To create a menu record from the command line, do the following:

a Make sure that the command line is visible by selecting Command Line 
from the View menu.

b Type menu on the command line. 

c Click the Start Command arrow or press Enter.

-or-

Menu Access:

1 Click the Utilities tab in the System Administrator’s home menu, and then 
choose Tools>Menus.

A blank menu form is displayed.

Note: Depending on the size of your form, you may have to use the bottom 
scroll bar to access the fields on the right side of the form.

2 Enter the name of the menu in upper-case letters in the Menu Name field. 
The menu name is entered in the Parameter Value field of the operator 
record. For more information, see Adding Users on page 146.

For example, create a menu named START.

3 In the Format field, enter the name of the form you created in Forms 
Designer to be used with this menu record.
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For example, enter user.menu, the name of the form you created in the 
previous steps.

Figure 3-12: Menu setup form

4 Create the menu options next.

The availability of the options depends on a user’s Execute Capabilities, as 
defined in the user’s operator record. Operator records are discussed earlier 
in this chapter.
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Enter the menu option number in the Option # field. If this menu is a 
Windows form, the option number is associated with a button ID assigned 
to the button in the Property window of Forms Designer. Refer to the 
previous section, Creating a Startup Menu on page 174, for instructions on 
designing Windows menu forms. Figure 3-13 on page 181 shows the 
correlation between the button and the option number.

Figure 3-13: Defining menu options

In this example:

Option # 1—defines the Change Management button.

Option # 2—defines the Forms Designer button.

Option # 3—defines the Logout button.

Option # 4—defines the Database Manager button.

5 Enter a brief description of the option in the Description field.

This description simply identifies the option and is not a required field. This 
description does not put a caption on the button. The caption is added in 
Forms Designer.

6 If the option can be launched by a ServiceCenter command, enter the syntax 
in the Command field.

For example, you can enter back if the option is designed to return the user 
to the previous form. In our example, none of the options require a 
command.

Button ID 1

Button ID 2

Button ID 3

Button ID 4
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7 In the Application field, enter the application this option should access.

In the example, enter:

cmr3.main to open a new Change Management change request or access 
the query screen from the Change button.

forms.designer to access the Forms Designer from the Forms Designer 
button.

database to access the Database Manager from the Database Manager 
button.

menu.manager to access the logout process from the Logout button.

8 Enter the type of parameter you want this option to pass in the Parameter 
Name field.

This field usually contains name, which represents the name of the parameter 
required by the specified application. While name is commonly used in this 
field, you should check the application to determine the correct parameter 
name.

In the example, name is used for the Logout utility.

9 Enter the Parameter Value.

This value is the parameter being passed into the application listed in the 
Application field. For example, if menu.manager is the application listed, the 
name of a menu record should be entered. If the application is link.edit, a 
link record is placed in the parameter value field.

In the example, the only necessary parameter is LOGOUT for the Logout 
option.

10 Enter true in the Thread column to start a separate thread for the application 
selected.

If the field is NULL, no new thread will be started.

11 Enter the condition, if necessary, for this option to be available to a user.

Set the condition to true to make the option available to all users.

- or -

Enter a pointer to allow the option to check the user’s Execute Capabilities 
in the Operator Record. Use the following command:

index("capability word", $lo.ucapex)>0

where the capability word is listed in the Execute Capabilities array of the 
user’s Operator record.
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Capability words are discussed earlier in this manual.

$lo.ucapex is a program-defined variable that is assigned when the user logs 
in. This variable contains the user’s execute capabilities, as defined in the 
Execute Capabilities array.

If ServiceCenter does not find the capability word in the operator record, the 
expression evaluates to false and this option is unavailable to the user.

For this example, set all the conditions to true.

12 Continue to add the options necessary for the menu.

13 Click Add or press F2 to add the menu record.

A message is displayed stating that the record was added to the menu file.

14 Click OK or press F3 to return to a blank menu form.

Testing a New User
If you created a menu form, menu record and an operator record using the 
examples provided, you can log on as joe.user.

If your test menu is not displayed:

1 Log on as a network administrator (FALCON).

2 Check the syntax in the Initial Application structure of the operator record. 
Ensure that:

a The correct application is entered in the RAD Name field. In this example, 
the application is menu.manager.

b The name of the menu is entered in the Parameter Values field. Using the 
example, START is entered for the Parameter Name of string1.

3 Check the menu record (for instructions on creating menu records, see 
Creating a Menu Record on page 178).

a Query for the START menu.

b When that menu record is displayed, ensure that the correct form name is 
entered in the Format field. In this example, user.menu should be entered.

4 Check the form in Forms Designer. Query for the form name entered in the 
menu record, that is, user.menu.
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To test your sample data:

1 Ensure that your ServiceCenter server is running (for more information, see 
Starting and Stopping a ServiceCenter Server on page 20).

2 Start a client session.

3 Enter joe.user at the login prompt.

4 If you entered a password in the operator record, enter that password.

The menu you created in Forms Designer is displayed. See Starting and 
Stopping a ServiceCenter Server on page 20.

Operator Templates

As system administrator, you can use operator templates to create and 
maintain operator records. For example, you may design one template for 
managers and another for first level help desk operators. Use this template to 
create a group of users, and then edit the template record to change 
capabilities for all the users in that group. You may define as many different 
templates as you have user groups to employ them.

Creating a Template
You may create an operator record template from scratch or copy an existing 
record. It is generally easier to copy the record of a current user whose 
capabilities most closely match those of your intended user group.

To create a template from an existing operator record:

1 Open the operator record of the user whose capabilities you want to copy.

For example, use BOB.HELPDESK.

2 Replace the name of the operator with the name of your template.

For example, type technician in the Login Name field.

3 Remove all personal data concerning the operator, for example, full name, 
work information, and all the contact information listed on the Notification 
tab.

4 Leave all personal data fields blank.

5 Complete any fields that apply to your new user group.

For example, your new users might be members of the same department.

6 Click Add.
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The following message is displayed in the status bar: Operator record added.

Figure 3-14: Operator record with a template applied

Applying a Template
Once you have created your template, use it to create a group of new users 
with identical capabilities.

To create a user from an operator record template:

1 Open your template.

2 Replace the name of the template in the Login Name field with the name of 
the new user.

3 Add appropriate business and contact information to the record, and then 
click Add.
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The following message is displayed in the status bar: Operator record added. 

Figure 3-15: Operator record created from a template

Named Users

ServiceCenter use is granted via your Peregrine Systems Software License 
Agreement, which provides for two types of licensed users: Named Users and 
Floating Users.

Named Users are users authorized to log on to ServiceCenter under a 
different status than Floating Users. The number of Named Users for a 
system is encoded in the authorization code that enables the various features 
of your system. It is not related to the number of Floating Users. 
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Named users can be defined by a flag in their operator record, or by being 
included in a list of Login names for Named Users in a separate text file, the 
path for which is displayed in the server-side initialization (sc.ini) file. If the 
file is provided, it takes precedence over the operator records.

Define as many Named Users as you have Named User licenses. Users not 
defined as Named Users will take floating licenses as they log on. Once all the 
floating licenses have been used, no further regular logins are permitted. 
However, Named Users can always log on to your ServiceCenter system even 
when all the floating licenses are being used.

To select individual users as Named Users, mark Named User on the General 
tab of each individual’s Operator record. See General Tab on page 148 for 
more information.

There are three steps to creating and using a Named User file on your system:

Determine the number of Named User licenses available in your system.

Create a text file containing the login names of your Named Users.

Modify the initialization (sc.ini) file to accept Named User logins.

Determining the Number of Named Users Available
If you are not sure how many Named User licenses you purchased with your 
ServiceCenter system, you can run a license report from a command prompt 
to determine the number of Named Users available.

To run a license report:

1 Open a command prompt window.

2 Open the RUN directory of your ServiceCenter installation.

3 Type scenter -reportlic.

For example, you might enter:

C:\programs\sc\RUN\scenter -reportlic

4 Press Enter.

A complete list of licenses and features is displayed.

5 Check the number of Named User licenses available to you.
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Creating a Text File of Named Users
You must create a simple text file bearing the login names of your Named 
Users and reference it in your initialization (sc.ini) file with a special 
parameter. Provide only as many names as you have licenses.

To create a text file of Named Users:

1 Open any text file editor.

In this example, we use Notepad from Windows.

2 Type the names of these users exactly as they appear in the Login Name field 
of each user’s operator record.

You must type only one name per line. Spaces between names are allowed.

Figure 3-16: Named Users text file

3 From the File menu, choose Save.

4 Name the file, and save it to the server-side RUN directory of your 
ServiceCenter installation.

Modifying the sc.ini File
For ServiceCenter to accept logins from the Named Users you have defined, 
you must add the namedusersfile parameter to the ServiceCenter 
initialization (sc.ini) file together with the fully qualified path to the text file 
of names.

To edit the sc.ini file:

1 Go to the ServiceCenter Programs file directory.

2 Edit the sc.ini file with any text editor.

For example, on Windows NT, you can go to 
Start>Programs>ServiceCenter>Init File to open the sc.ini file with 
Notepad.
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3 Add the Named User parameter (namedusersfile) to the bottom of the sc.ini 
file followed by a colon and the path to the text file containing the login 
names of your Named Users.

Example:

#

# Installed Configuration

#

path:c:\programs\sc\DATA

shared_memory:48000000

ntservice:ServiceCenter

log:c:\programs\sc\sc.log

bitmap_path:c:\programs\sc\BITMAPS

system:12670

auth:9FG756J2 VF375908 95281GGL 1A23JJ56

scauto:12690

namedusersfile:c:\programs\sc\RUN\names.txt

4 From the File menu, choose Save.

5 Exit Notepad.

6 Stop and restart ServiceCenter, so that the system changes will be recognized.

Your Named Users can now log on to the system.

Passwords

Passwords play a major part in controlling system security within the 
ServiceCenter environment. See System Wide Company Record on page 196 
to learn about setting standards, requirements, and lifetime limits for 
passwords.

As the ServiceCenter system administrator, you can change your password, 
and the password of any other user. Users can also change their own 
passwords, if they are configured to do so.
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To change another user’s password:

1 Access the operator record for that user (for instructions on accessing and 
modifying an operator record, see Creating an Operator Record on page 147).

2 Enter the new password in the Password field.

If the user currently has a password, that password (which is masked using 
asterisks) is displayed in the field.

Figure 3-17: Password field in the operator record

3 Click Save or press F2.

The following message is displayed in the status bar: Operator record updated.

Next time the user logs on, the new password is required. If the user attempts 
to start another session with the current session running, the new password 
is required.
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To change your own password:

Note: ServiceCenter contains a form to change your own password.

1 Make sure that the command line is visible by selecting Command Line from 
the View menu.

2 Type password on the command line. 

3 Click the Start Command arrow or press Enter.

Note: Some user menus and forms, such as menu.gui.user, contain a button 
to access the password form.

A password form is displayed with your User Name entered.

Figure 3-18: Change password form

4 Enter your current password in the Old password field.

Note: The passwords you enter are not displayed; ServiceCenter masks the 
characters using asterisks (*).

5 Enter your new password in the New password field.

6 Enter your new password again in the Confirm new password field, and then 
click OK.

The new password takes effect the next time you log on. Even if you start 
another session using your login name with the current session still open, you 
still need to use the new password.
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Restricting Logins

The system.quiesce application allows a system administrator to limit logins 
to a ServiceCenter system when trying to perform system maintenance. 
System Quiesce enables the system to have the rest period it needs, so that the 
following procedures can be performed without any interference during the 
system maintenance.

Upgrading from one version of ServiceCenter to another

Converting the P4 database to an RDBMS

Performing system maintenance, such as creating or editing Format 
Control records, links, or categories

Levels of Restriction
Depending upon the maintenance being performed on the ServiceCenter 
system, there are three levels of login restriction that the system 
administrator can enforce. They are:

Level 0

All logins accepted

Level 1

Only system administrators permitted to log on. When a user without 
system administrator rights attempts to log on to a system at Level 1, the 
login is rejected, and a message displays, stating: System quiesced, you 
cannot login at this time.

Level 2

No further logins accepted. When any user attempts to log on to a system 
at Level 2, the login is rejected, and a message displays, stating: System 
quiesced, logins restricted at this time.

General Effects
When a quiesced system’s restriction levels are set and the system begins to 
enforce restricting users from logging on to the system, according to users’ 
login levels, currently logged in users are not forced off the system. However, 
new users are prevented from logging on. 

When the system administrator places the system at Level 2 and logs off, the 
server must be stopped and started to re-enable the normal login functions.
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Applying System Quiesce to Restrict Logins
To quiesce a system:

1 In the system administrator’s home menu, click the Utilities tab.

2 Click Administration.

The Administration menu is displayed (Figure 3-19 on page 193).

Figure 3-19: Administrator’s menu
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3 Click Connection Restrictions.

The Access Level control console is displayed (Figure 3-20 on page 194).

Figure 3-20: Access Level console

4 Click the button for the access level you want to apply to your system:

Set Level 0

Set Level 1

Set Level 2

The current level is displayed on the console.

5 Click Back to return to the Administrator’s menu.
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Single Sign-On

Single sign-on is a feature that allows users who are connected to the network 
to bypass the ServiceCenter login screen and automatically get into the 
ServiceCenter system. In order for single sign-on to work, the system 
administrator adds the trustedsignon parameter to the server side of the 
sc.ini file and creates operator records for each NT Userid that will be 
utilizing the single sign-on feature. When the system administrator 
completes the parameter file set-up and all necessary operator records are 
created, single sign-on ability is available to the client when it first connects 
to the server. When the client receives notification from the server that single 
sign-ons are allowed, the NT Userid is used as the ServiceCenter login and no 
password is required. The login screen is bypassed, unless the NT Userid is 
not defined in an operator record. 

To set up an operator record for a user’s NT Userid, refer to Adding Users on 
page 146.

To add the single sign-on parameter to the sc.ini file:

1 Go to the ServiceCenter Programs file directory.

2 Edit the sc.ini file with any text editor.

For example, on Windows NT, you can go to 
Start>Programs>ServiceCenter>Init File to open the sc.ini file with 
Notepad. Add the following parameter to the sc.ini file:

trustedsignon

3 From the File menu, choose Save, and then exit Notepad.

4 Stop and restart ServiceCenter, so that the system changes will be recognized.

Note: Once the operator records are created for the NT Userids that will be 
utilizing the single sign-on ability, users can connect to the network 
and bypass the ServiceCenter login screen.
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System Wide Company Record

Each ServiceCenter system contains a System Wide Company Record. This 
record contains information used by the ServiceCenter applications 
accessing this server.

The System Wide Company Record allows the applications to:

Display report headers (when using the master header).

Adhere to logical file size limits.

Compose password and set standards and lifetime limits.

Create a unique record when unloading/loading msgclass records.

Calculate the number of days ServiceCenter passwords are valid.

Provide a syslog audit trail.

Set the default time zone, date, and month formats for the system.

Set default print options for Incident and Change Managements.

Set the length of time for queries.

Print a ServiceCenter banner page with printed reports.

Calculate the month that the fiscal year ends.

Set ServiceCenter to run in multi-company mode.

Accessing the System Wide Company Record
The System Wide Company Record can be accessed from the 
Administrator’s menu:

1 In the system administrator’s home menu, click the Utilities tab (Figure 3-21 
on page 197).

2 Click Administration.
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3 In the Administration menu, click System Wide Company Record.

The System Wide Company Record form (Figure 3-21 on page 197) is 
displayed. The system is shipped with the Peregrine company record 
information by default. 

Figure 3-21: System Wide Company Record

4 Modify this information to create your own System Wide Company Record.

System Wide Company Record Fields

Header

Field Description

Company 
Name/Address/City/
State/Zip

Your company’s name and address, including city, the state 
two-character abbreviation, and zip code.
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Logon Info Tab
The Logon Info tab (Figure 3-21 on page 197) sets limits on the number of 
logins and login attempts that a user can make and activates user lockout and 
account expiration.

User Lockout
Because all users must have a password defined in their operator record to log 
onto ServiceCenter, the Use User Lockout structure sets the lockout times 
and inactive interval. See the structure fields described below.

Field Description

Max Logins per User Maximum number of concurrent logins allowed per user 
ID. If this field is left blank, a user can run an unlimited 
number of concurrent sessions. 

Note: The maximum number of logins in the operator 
record override this setting.

Note: The Unlimited Sessions check box in the operator 
record (page 154) overrides the value in this field. If the 
Unlimited Sessions check box is not selected, the 
system uses the value in the No. per User field.

Attempts Per Login 
Session

Number of incorrect logon attempts a user is allowed 
before being locked-out from logging-on in the current 
logon window. (The user would have to start the client 
again to get a new login window.) If this field is left blank, 
users are given 5 login attempts.

Operator Template Default operator template for LDAP users.
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Note: If Prevent System Locking on this user? is checked (true) in the 
Security tab of the operator record, this will prevent manual or system 
locking of that user’s access.

Account Expiration

Note: If you try to do an F9 to fill the field, it will be the wrong type of date 
structure and will cause unexpected behavior. The DD:HH:MM 
format is correct.

Field Description

Use User Lockout Determines whether or not user lockout will be used. If this 
box is checked (evaluates to true), the user lockout feature will 
be used and the other fields must be set for lockout period and 
inactive interval time.

Attempts Until 
Lockout

Choose one of the lockout reset values below.

Complete Lockout—completely locks user out of the 
system until the system administrator resets the lock
Lock out for time Period—locks user out of the system for 
the specified period of time in days, hours, minutes, and 
seconds DD_:HH:MM:SS
For example: 60 days = 60 00:00:00

Note: If you try to do an F9 to fill the field, it will be the 
wrong type of date structure and will cause unexpected 
behavior. The DD:HH:MM format is correct.

Field Description

Inactivation Interval Interval of time in days, hours, and minutes 
(DD:HH:MM) after which user will be considered 
inactive and locked out of the system. The system 
administrator will have to reset the user password to 
eliminate the inactive status.

Expiration Interval Interval of time in days, hours, and minutes 
(DD:HH:MM) after which an inactive password will be 
considered expired.
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Note: If the Inactivation Interval time period has been exceeded but the 
Expiration Interval has not been reached, the user password can be 
reset.

According to best practices and processes, if the Inactivation Interval 
time period has been exceeded and the Expiration Interval has been 
reached, the user password cannot be reset and a new operator record 
must be created.

For example: If the Inactivation Interval is set at 60 days and the Expiration 
Interval is set at 90 days, the system administrator can reset the lock on an 
inactive user password for up to 89 days.
If the Inactivation Interval has been 90 days or more and the Expiration 
Interval has been reached, then a user’s access is considered expired and 
cannot be reset. A new operator record must be created.

Active Integrations Tab
The Active Integrations tab (Figure 3-22 on page 200) allows you to enable 
or disable integrations, controlling which integration options are available to 
users.

Figure 3-22: System Wide Company Record—Active Integrations tab

Available integrations include:

Knowlix

ServiceWare

Get-Answers

Remote Control

IND
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Selecting (or enabling) an integration causes options for that integration to 
appear on the user Options menu. When you enable Get-Answers and/or 
IND integrations, a field appears beside the integration name for you to type 
the name of the server where the integration is installed. Out-of-box, all 
integrations are disabled.

Menu Information Tab
The Menu Information tab (Figure 3-23 on page 201) allows you to set the 
display value for all menu screens, ServiceCenter printed reports banner 
pages, and text report headers (when using the master header).

Figure 3-23: Menu Information Tab

Field Description

Menu Title (Used for text mode only.) Value displayed at the top of all 
menu screens and on the master header for text reports, as 
shown in the following example.

ServiceCenter—RELEASE ___
 Date:     category listing 
 06/21/02 16:52                      Page: 1
 Operator: FALCON    Selection: all records
 Sequence: 

Menu Prompt on menus, replaces the prompt on the screen. It can be 
used to tag different development systems, and so on.

Banner ID ID printed on banner pages when the banner page option 
is enabled in the print Configuration File.
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Password Standards Tab
The Password Standards tab (Figure 3-24 on page 202) sets requirements for 
user passwords and has the option to store history on passwords.

Figure 3-24: System Wide Company Record—Password Standards tab

Password Reset
Choose one of the password reset values below. The following values are also 
options in the operator record or in Central Administration Utilities, View 
User. When the password reset feature is used, the user is forced to change 
his or her password at the next login.

Password Reset Value Description

Prevent Pwd Resets Prevent password from being reset with the password 
reset pull-down option.

Reset to User Name Reset password to user’s login name.

Prompt for Value Prompt user to enter a password. This will prompt 
whomever is resetting the operator’s password to enter a 
new password. If this is used, the password should also be 
expired (set in the operator record), forcing the user to 
update his/her password on the next login.

Reset to Value Reset password to the value indicated in the next space. 
For example, reset the password to your company name.
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Password History

Password Composition Tab
The Password Composition tab (Figure 3-25 on page 204) sets the rules, such 
as minimum and maximum password length, for how passwords can be 
composed.

Field Description

Keep Password 
History

If this field evaluates to true (checked), the user’s password 
history is retained.

Prevent Use of Last _____ Passwords—automatically 
prevents user from using the last specified number of 
passwords from being used as the new password. In this 
example, the last 10 passwords may not be used to create 
a new password.

Note: There is an exception that allows the last password 
to be reused. If the user’s password has been reset, then 
the reset password (such as, user name or company 
name) can be reused.

Prevent All Password Reuse—prevent all previous 
passwords from being reused when new passwords are 
set.

Note: There is an exception that allows previous 
passwords to be reused. If the user’s password has been 
reset using a standard name (such as, user name or 
company name), then the reset password can be reused.
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Important: Users should not have conflicting password composition 
requirements. See the fields in Figure 3-25 and their descriptions 
that follow.

Figure 3-25: System Wide Company Record—Password Composition tab

Field Description

Min Password Length Minimum number of characters to be used when creating 
a password. Ideally, the minimum should be at least six 
characters.

Max Password Length Maximum number of characters to be used when creating 
a new password. The OS/390 platform requires a 
maximum of eight characters.

Allow Alpha 
Characters

Check here if alphabetical characters can be used when 
creating a password.

Require Alpha Chars—check here if alpha characters 
should be required.
Min. Required—automatically require a specified 
minimum number of alpha characters to be used when 
creating a password.
Require Mixed Case—check here if the password 
should require upper and lower case characters.

Allow Numeric 
Characters

Check here if numeric characters can be used when 
creating a password.

Require Non-Alpha Characters—check here if 
non-alpha characters should be required.
Min Required—automatically require a specified 
minimum number of non-alpha characters to be used 
when creating a password.
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Allow Symbolic 
Characters

Check here if symbolic characters, such as a dash (-), can 
be used when creating a password. OS/390 users can only 
use three symbolic characters.

Warning: If the symbolic characters pound (#), 
equal sign (=), tilde (~), greater than (>), 
or less than (<) are used at the beginning 
of a password, they will not be 
acknowledged by the system.

Prohibit Space Character—check here if you want to 
prohibit the space bar character (blank space character) 
from being used when a password is being created.

Note: You may want to consider prohibiting the use of 
the space character if it causes problems for users 
creating new passwords.

Always require a 
password

Determines whether or not passwords are required. If this 
box is checked (evaluates to true) all users must have a 
password defined in their operator records to log on to 
ServiceCenter. 

Note: ServiceCenter does not require a password if it is 
not in the operator record. If this field is checked and 
the user has a null (blank) password, the user can 
continue to log on until forced to change the password. 
As long as the password is valid, the user can keep using 
it. 

If maximum lifetime is not enforced, the user can have 
a null password forever.

Field Description
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Password Life Time Tab
The Password Life Time tab (Figure 3-26 on page 206) controls minimum 
and maximum lifetime limits according to time period or number of logins.

Note: It is best practice to keep either the same time periods or the same 
number of logins for both Password Max life time and Password Min 
life time.

Figure 3-26: System Wide Company Record—Password Life Time tab

Password Max Life Time
Select one of the following to set the maximum amount of time a password 
should be used.

Field Description

Notify by email on 
pwd change

Notify user by email when the password has been changed 
by another user.

Field Description

No Max Life Time No maximum lifetime should be set for a password. This 
setting should be the same as No Min Life Time.

Use Time Period Use a time period to determine the maximum lifetime of a 
password. It is best practice to keep the same time period 
for Password Min life time. Click the button and the field 
will display.

Use Number of Logins Use number of logins to determine the maximum lifetime 
of a password. Click the button and the field will display.
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Password Min Life Time
Select one of the following to set the minimum amount of time a password 
should be used.

Field Description

No Min Life Time No minimum lifetime should be set for a password. This 
setting should be the same as No Max Life Time.

Use Time Period If checked (true), a field labeled Min Pwd Lifetime 
displays to allow you to define the time period. It is best 
practice to keep the same time period for Password Max 
life time. Click the button and the field will display.

Use Number of Logins If checked (true), a field labeled Min before change 
displays to allow you to define the value. Click the button 
and the field will display.
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Date Information Tab

Figure 3-27: System Wide Company Record—Date Info tab

To change the Time Zone setting:

1 Clear the field.

2 Click the Fill button. 

A QBE list of time zones is displayed.

Field Description

Time Zone Establishes a default, system-wide time zone setting. Time 
zone records are kept in the Time Zone Definition File 
(tzfile). This setting applies to all system operators, unless the 
setting is overridden within their operator record. For more 
information, see Creating an Operator Record on page 147.

Note: ServiceCenter is shipped with a default setting of 
US/Pacific.

Format Format in which dates are entered and displayed throughout 
the ServiceCenter system. This setting applies to all system 
operators, unless the setting is overridden within their 
operator record. For more information, see Creating an 
Operator Record on page 147.

The available formats are:

mm/dd/yy—standard U.S. format.
dd/mm/yy—European format.
yy/mm/dd—optional format.
mm/dd/yyyy—standard U.S. format.
dd/mm/yyyy—European format.
yyyy/mm/dd—optional format.
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3 Select a time zone record from the list by double-clicking the button for the 
time zone you want to use.

The time zone is placed in the field.

Only a system administrator can modify time zone records. For more 
information on Time Zone functions, see Time Zone Function and Date 
Formats, Chapter 6.

Note: ServiceCenter time zone records can specify the cut over dates 
between Daylight Savings Time and Standard Time.

Print Options Tab

Figure 3-28: System Wide Company Record—Print Options tab

Time Limits Tab

Figure 3-29: System Wide Company Record—Time Limits tab

Field Description

Use Old Printing Selects old print routines. Beginning with the 
ServiceCenter A9802 release, new print routines were 
added to ServiceCenter.
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Note: It is only possible if the Operator record for the user has the capability 
word allowing non-partially keyed query searches.

Month Tables Tab

Figure 3-30: System Wide Company Record—Month Tables tab

Used to select long and short versions of the 12 months.

Field Description

DB System default time limit for partially keyed or non-keyed 
queries in Database Manager. The format is hh:mm:ss. 
ServiceCenter is shipped with a default of ten seconds, that is, 
00:00:10.

CM System default time limit for partially keyed or non-keyed 
queries in Change Management. The format is hh:mm:ss. 
ServiceCenter is shipped with a default of ten seconds, that is, 
00:00:10.

IM System default time limit for partially keyed or non-keyed 
queries in Incident Management. The format is hh:mm:ss. 
ServiceCenter is shipped with a default of ten seconds, that is, 
00:00:10.
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Miscellaneous Tab

Figure 3-31: System Wide Company Record—Misc tab

Field Description

Msg Queue Size Default message queue size for each operator. The maximum 
is 500. This setting applies to all system operators, unless the 
setting is overridden within their operator record.

Fiscal Year This field is no longer used.

Language Code Controls what language the operator uses inside 
ServiceCenter, unless this is overridden by the Operator 
record's Language value. See Creating an Operator Record on 
page 147 for details.

Basis Currency Select the base currency the company uses for transactions 
from the drop-down list, unless this is overridden by the 
Operator record. See Creating an Operator Record on page 147 
for details.

Max Attachment 
Size

Defines the maximum size of a file that all ServiceCenter users 
can insert into an OLE container. OLE containers are 
historical only. With ServiceCenter 4.0 or later, all 
attachments are external file attachments. For more 
information on OLE containers, see File Attachments and OLE 
Containers on page 69.

Case Mode Indicates the setting of the system case mode. The system may 
be set to Case-Sensitive or Case-Insensitive. For more 
information on case sensitivity, refer to the P4 Filesystem 
documentation in the ServiceCenter Database Management 
and Administration Guide.

System Start automatically filled in each time you start the server.
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Message Processors Tab

Figure 3-32: Message Processors Tab

Msg. Queue If selected, this check box tells the system to use the Size field 
to set the message queue size; otherwise, the system default is 
used. This setting applies to all system operators, unless the 
setting is overridden within their Operator Record.

Syslog Audit Logical field controlling the logging function. If this check box 
is selected, a record is entered into the syslog file containing 
the time and user ID each time the user logs on or off. 
Otherwise, a record is not entered into the syslog file.

Disable Work 
Management

Checking this box (true) disables the Work Management 
module. This may help with performance on some systems.  
The option will also remove the Work Management icon from 
the Home menu.

Run in Multi- 
Company Mode

Checking this box sets the $G.multi global variable to true so 
that the system runs in multi-company mode. For details 
about multi-company mode, see 
Using Multi-Company Mode on page 120.

Use Learning for 
SC Knowledge

Turns on the learning for SC Knowledge by adding a learning 
record (adlrelation record) when using the Use Resolution 
option after finding a valid solution.

Allow Editing of 
Learning Record

Allows this user to have the ability to edit the learning record 
(adlrelation record), if learning is used. If you add words to the 
original search string, it will learn on those words as well.

Field Description
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Options Menu—System Wide Company Record
The Options menu provides shortcuts to other ServiceCenter applications, 
and access to Incident Management, Search, and Inbox functions.

Field Description

Processor Name Name of the processor(s) you want to handle standard 
message traffic. Messages are rotated among all processors 
that you specify, freeing the problem processor to handle 
problem alerts. 

If you specify no processors, the system defaults to using 
the problem processor to handle all message traffic.

Important: It is the administrator’s responsibility to 
ensure that the correct background 
schedulers are started and maintained.

Option Description

Validity Lookup Checks the selected field against the ServiceCenter 
validity tables.

Set Case Insensitive To enable case insensitive searching. See the 
ServiceCenter Database Management and 
Administration Guide to learn more about changing the 
case mode.

Get-Answers 
Configuration Records

Provides a list of all configuration records needed to set 
up how data is retrieved from and how new knowledge 
is authored in Get-Answers.

Knowlix Configuration 
Records

Provides a list of all configuration records needed to set 
up how new knowledge is authored in Knowlix.

Expand Array Displays a separate window with an expanded version of 
the highlighted array, allowing you to enter or remove 
values in the array.

Set Parms Reinitialize the internal time zone value in 
ServiceCenter. For more information on Time Zone 
functions and setting the default time zone and date 
formats using the Set Parms option, see Set the Default 
Time Zone and Date Format on page 272.
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List Options Menu—System Wide Company Record
The List Options menu is available when a QBE Record list is displayed.

User Administration

General Tab
The user’s capabilities within a given application (such as, Service 
Management and Incident Management) are defined by a user’s Application 
Profile record.

In the General tab of the operator record (see Figure 3-3 on page 148), you 
can identify and update user Application Profile information for each 
ServiceCenter application, including Service Management, Incident 
Management, Root Cause Analysis, Inventory Management, Change 
Management, and Request Management.

See additional options in the Options drop-down lists that are available in the 
top menu bar. See for descriptions of each available option.

List Option Description

Mass Unload Allows you to unload all the records appearing in a record 
or QBE list to an external file.

Count Tallies the number of records in the list.

Refresh Updates the QBE list with current system information.

Modify Columns Allows you to change the column headings in the QBE 
record list.

Export to Excel Exports the current Incident List to a Microsoft® Excel 
spreadsheet. Excel is opened automatically and the list is 
placed in the spreadsheet. Basically, you can export 
information to any product that has DDE (Dynamic Data 
Exchange) support. This DDE function requires Excel 95 
or later.

Note: This option is available only on Windows clients.

Export to Text File Exports the current Incident List to a text file. This option 
is not part of the DDE support and can be run from clients 
other than those operating in Windows.
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Checking the Status of a User’s Profiles
An overview of a user’s profiles is displayed in the General tab of the 
Operator record. If a User Role is not selected as the basis for the application 
profiles, you will see a “DEFAULT” profile type in the profile field, which 
signifies that a default profile is being used. However, based on the User Role 
selected, there will be user profile assignments for each ServiceCenter 
application. If you would like to select a different profile or create a unique 
profile, either select a new profile type from the drop-down list, create unique 
profile settings for this user, or add the operator as a member of an existing 
profile.

Profiles and profile types for Change Profiles and Request Profiles are logged 
in their respective status boxes. As profiles are added or updated, the status 
boxes reflect current data for each profile listed (see Figure 3-2 on page 145).

Change Management profiles

Change Management profiles are created to control access to the Change 
Management application. The access privileges for these profiles are as 
follows:

Changes

Tasks

All

If the pre-set DEFAULT access privileges remain unchanged, the user has 
limited access to Change Management, which will allow access to 
information that is generally available to all users. No update capabilities are 
available.

If one of the specific profile access areas, such as Changes or Tasks, is created 
along with the All profile access, the system will choose the specific area 
(Changes or Tasks) over All, granting access to changes or tasks only. 
However, if all three profile access areas are created (Changes, Tasks, and 
All), the system will grant access privileges according to the All access 
privileges category. Use the Central Administration Utilities overview at a 
glance to make sure you have all access privileges set properly for each user.
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Request Management profiles

Request Management profiles are created to control access to the Request 
Management application. The access privileges for these profiles are as 
follows:

Quotes

Orders

Line Items

All

If the pre-set DEFAULT access privileges remain unchanged, the user has 
limited access to Request Management, which will allow access to 
information that is generally available to all users. No other capabilities, such 
as ordering from the catalog, are available.

If one of the specific profile access categories, such as Quotes, Orders, or Line 
Items, is created along with the All profile access category, the system will 
choose the specific category (Quotes, Orders, or Line Items) over All. The 
user will have access to the specific category assigned (quotes, orders, or line 
items) over all access rights. However, if all profile access categories are 
created, including All, the system will grant access privileges according to the 
All access privileges category. Use the Central Administration Utilities 
overview at a glance to make sure you have access privileges set properly for 
each user.

Adding a User Profile
Add a user profile in the General tab of the Operator record. See Viewing and 
Editing User Data on page 144 for information on how to begin viewing and 
editing user data. Also see Figure 3-2 on page 145.

Editing a User Profile
Edit a user profile in the General tab of the Operator record. See Viewing and 
Editing User Data on page 144 for information on how to begin viewing and 
editing user data.
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To edit a user’s profile, such as the Service Management profile, select the 
application profile you want to view, then click the RIGHT ARROW. With 
the exception of two applications, you will be brought to the profile form to 
make changes. If you need to add a profile, click Add New Profile to bring up 
the Add dialog box. See the ServiceCenter Application Administration Guide 
to learn about the details of the profile form.

When you begin to edit a user’s profile for the Change Management and 
Request Management applications, you will be prompted with the profile 
dialog box.

Warning: If you make any changes to a profile that includes a member list, 
all members on the list will be affected.

Profile with Multiple Members
When you elect to edit a profile with multiple members, the profile’s member 
list will display. You can add, edit, or delete users from the member list.

Warning: If you wish to remove a user from a profile’s member list, do not 
delete the profile nor the list of members. Instead, remove the 
user(s) from the member list, using the Edit Member List option.

Removing Users and Related Profile Information from 
ServiceCenter
You can delete a user from the system and purge all related user profile 
information, using View User Data utility.

To remove a user and all related profile information:

1 From the ServiceCenter home menu, select the Utilities tab and click 
Administration.

2 On the Information/Security/Insight tab, in the Security structure, click User 
Administration.

3 Click View User Data.

4 When prompted to select an existing user, enter the name of the user to be 
removed from the system, or use the drop-down arrow to select the user 
from the list.

The user’s information will be displayed, as in Figure 3-2 on page 145.
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5 Select Options > Completely Remove User from the top menu bar.

6 You will be prompted to confirm that you really want to delete the user and 
his/her related contact and profile information.

Click Yes to continue the delete process.

Click No to return to the user information display screen.

Warning: When you click Yes to completely remove a user and all related 
information, you cannot undo the deletion. All the user’s 
information will be permanently deleted from ServiceCenter.

User’s Assignment & Message Groups Tab

Figure 3-33: User’s Assignment and Message Groups tab

Edit Incident Management assignment groups and Change Management 
message groups, using the menu option buttons.
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Editing Incident Management Assignment Groups
Edit Incident Management assignment groups in the User’s Assignment & 
Message Groups tab in the View User Data menu.

Click Edit Asgn Groups to edit an assignment group. When the 
assignment.util.g form is displayed, select the group you want to edit. See the 
ServiceCenter Application Administration Guide to learn more about editing 
and assigning assignment groups.

To learn more about viewing and editing a user’s data within Central 
Administration Utilities, see Viewing and Editing User Data on page 144.

Editing Change Management Message Groups
Edit Change Management message groups in the User’s Assignment & 
Message Groups tab in the View User Data menu. 

Click Edit Msg Groups to edit a message group. When the cm3groups.g form 
is displayed, select the group you want to edit. You will be able to make 
changes, such as adding and deleting users to the approvers and reviewer 
lists. See the ServiceCenter Application Administration Guide to learn more 
about editing message groups.

To learn more about viewing and editing a user’s data within Central 
Administration Utilities, see Viewing and Editing User Data on page 144.

User Quick Add Utility
1 In the Central Administration Utilities main menu, click User Quick Add 

Utility.

2 When prompted, enter a new user’s name in the dialog box.

Decide whether you want to clone an existing user, or create a brand new 
user. See Adding Users on page 146 to learn more about adding users and 
capability words, and changing passwords.

3 When you’re finished entering new user information, click Add.

4 When prompted, add the contact information.

5 Click Add.
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Incident Tab

Figure 3-34: Central Administration Utilities—Incident tab

Button Description

Incident 
Management Profiles

Define a profile within Incident Management for each user.

Incident 
Management 
Environment

Specify general application functional parameters within 
Incident Management, such as allow access with or without 
operator record and whether or not to allow inefficient 
queries. See the ServiceCenter Application Administration 
Guide to learn more about the Environment record.

Incident Assignment 
Groups

Create incident work assignment groups, so that incident 
tickets can be assigned to the appropriate departments and 
people for resolution.
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Service Tab

Figure 3-35: Central Administration Utilities—Service tab

Button Description

Service Management 
Profiles

Define a profile within Service Management for each user.

Service Management 
Environment

Specify general application functional parameters within 
Service Management to determine the conventions to be 
observed when calls are created, such as whether or not to 
notify certain persons when a call is closed or whether a call 
should be closed before or after all related records are 
closed. See the ServiceCenter Application Administration 
Guide to learn more about the Environment record.
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Root Cause Tab

Figure 3-36: Central Administration Utilities—Root Cause tab

Button Description

Root Cause Profiles Define a profile within Root Cause Analysis for each user.

Root Cause 
Environment

Specify general application functional parameters within 
Root Cause Analysis to observe conventions to be used when 
determining the root cause for particular incidents or related 
incidents in Incident Management and Change 
Management. For example, determine and set up manage, 
search, and list formats, so that root causes and their errors 
can be identified and resolved. See the ServiceCenter 
Application Administration Guide to learn more about the 
Environment record.
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Inventory Tab

Figure 3-37: Central Administration Utilities—Inventory tab

Button Description

Inventory Profiles Define a profile within Inventory and Configuration 
Management for each user.

Inventory 
Management 
Environment

Specify general application functional parameters within 
Inventory and Configuration Management to determine the 
conventions to be observed when keeping track of hardware 
and software in your network. For example, determine and 
set up if there will be device type restrictions or if passwords 
will be required. See the ServiceCenter Application 
Administration Guide to learn more about the Environment 
record.
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Contract Tab

Figure 3-38: Central Administration Utilities—Contract tab

Button Description

Contract Profiles Define profiles within Contract Management for each 
user.

Contract Management 
Environment

Specify general application functional parameters within 
Contract Management to determine the conventions to be 
observed when setting up contracts, making payments, 
allocating assets, and applying contract terms and 
conditions. For further information about the 
Environment record, see the Application Administration 
Guide.
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Change Tab

Figure 3-39: Central Administration Utilities—Change tab

Button Description

Change Management 
Profiles

Define profiles within Change Management for each user 
for:

Changes
Tasks
All

Change Management 
Task Environment

Specify general application functional parameters within 
Change Management to determine the conventions to be 
observed when requesting, listing, and tracking changes at 
a facility. For example, set alerts, approval options, and 
query options. See the ServiceCenter Application 
Administration Guide to learn more about the Environment 
record.
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Request Tab

Figure 3-40: Central Administration Utilities—Request tab

Change Management 
Request Environment

Specify general application functional parameters within 
Change Management to determine the conventions to be 
observed when keeping track of changes at a facility. For 
example, set the change manage formats and set the 
category restrictions. See the ServiceCenter Application 
Administration Guide to learn more about the Environment 
record.

Change Management 
Message Groups

Create Change Management message groups, so that 
change requests can be reported to the appropriate groups 
or persons.

Button Description
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Button Description

Request Management 
Profiles

Define profiles within Request Management for each user 
for:

Quotes
Orders
Line Items
All

Request Management 
Order Environment

Specify general application functional parameters within 
the Request Management order environment to 
determine the conventions to be observed when ordering 
items from the catalog. For example, set up a unique 
control numbering scheme to keep track of your orders. 
See the ServiceCenter Application Administration Guide to 
learn more about the Environment record.

Request Management 
Quote Environment

Specify general application functional parameters within 
the Request Management Quote environment to 
determine the conventions to be observed when receiving 
quotes for items ordered. For example, set whether or not 
an item should be marked as “in stock” when a line item 
has been completely received. See the ServiceCenter 
Application Administration Guide to learn more about the 
Environment record.

Request Management 
Line Item 
Environment

Specify general application functional parameters within the 
Request Management Line Order environment to determine 
the conventions to be observed when requesting items from 
the catalog. For example, set whether or not access is allowed 
without an operator profile or if events should be scheduled. 
See the ServiceCenter Application Administration Guide to 
learn more about the Environment record.
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Mandanten Tab

Figure 3-41: Central Administration Utilities—Mandanten tab

Button Description

Mandanten Security 
Groups

Define companies to be included and excluded for each 
Mandanten Security group.

Mandanten Field 
Restrictions

Define fields to be protected and linked with their source 
fields. Also define which fields should be excluded.

Mandanten 
Restricting Queries

Format Mandanten values in the scaccess file to create 
restricting queries. For more information about the 
Mandanten feature, see Mandanten Database Protection, 
Chapter 8.
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CHAPTER

4
 Print Routines and Printer Setup
Overview

ServiceCenter introduced enhanced print routines as the default beginning 
with release A9802. The us.print routines are used throughout the primary 
applications (except for Inventory Management). These routines support 
both client and server printing. 

In this chapter you will learn about the following tasks:

How print routines work in ServiceCenter’s applications if you are 
printing from the database.

Deciding which print routines to use.

Selecting pre-A9802 routines (Inventory Management uses).

Enabling the pre-A9802 print routines with Format Control.

Note: If you are printing from the database, the enhanced print routines are 
always used.
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Advantages of the Enhanced Print Routines
The enhanced routines feature the following improvements over previous 
print routines:

They are faster and more robust.

Array fields are automatically expanded so that every line of an array is 
printed. This means that you can use just one print to get all the 
information in the description field of an incident record.

Records spanning multiple pages will be printed with page numbers.

Deciding Which Print Routines to Use
ServiceCenter allows you to select between the enhanced routines and the 
pre-A9802 routines depending upon your situation. The following general 
guidelines will help you decide which print routines to use:

If you are implementing ServiceCenter for the first time with release 3 or 
later, use the enhanced print routines that are installed in your system as the 
default. The only exception is that Inventory Management does not use the 
new print routines.

If you have upgraded to release 3 or a later release from another release of 
ServiceCenter that uses the previous print routines (pre-A9802 releases), 
you may prefer to use those routines until your upgrade is established. 
This will lessen the work involved during the upgrade process. Specifically, 
it will allow you to print immediately without redefining print formats 
within the principal applications. Eventually, you can switch to the 
enhanced routines to take advantage of the new print features. To enable 
the previous print routines, refer to Selecting Pre-A9802 Print Routines on 
page 233.
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How Print Routines Work in ServiceCenter

General
The formatting values of page width and lines per page are determined in the 
following fashion:

Client-side printing—based on values found in the Notification tab of the 
operator record (see Notification Tab (Includes Contact Information) on 
page 161).

Server-side printing—based on the values in the printer configuration 
record selected for the server’s system printer (see Creating a New Printer 
Record In the Configuration File on page 241).

The default formatting values for client and server printing are: 

Page width—80

Lines per page—60

Database
If you are printing from the database, the enhanced print routines are always 
used. The rules for selecting the form to print are the same as for the 
pre-A9802 routines (see Selecting Pre-A9802 Print Routines on page 233).

Incident Management
Incident Management uses the enhanced printing routines unless the old 
print routines are selected using one of the methods discussed in Selecting 
Pre-A9802 Print Routines on page 233. When the enhanced printing routines 
are used, the status of the incident ticket determines what form will be 
printed.

In the Formats tab of a problem category record (apm.category.g), the Print 
Formats fields are filled by default with the first line of the array used in 
pre-A9802 print routines.
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If the form to be used is not specified in the associated category record, the 
print routines will use the form specified in the Default field of the Print 
Formats structure in the category record. If this is also blank, the print 
routines will use the current form of the ticket.

A print confirmation dialog gives the user the following printing choices:

print the list only

print the problem records

print all pages of the problem records.

Service Management
Service Management uses the enhanced printing routines. When using the 
enhanced routines, the Print Format field in the SM Security Profile record 
(cc.profile.g) will determine what form will be printed. If this is null, the 
system uses the form named in the Edit Format field. Finally, if this is also 
null, the system uses the cc.incident form instead.

Change Management
Change Management uses the enhanced printing routines. When using the 
enhanced routines, the Print field (Scripts/Views tab) in the associated phase 
record will determine what form will be printed. If this field is null, the 
current form of the change or task will be used.

Inventory Management
Inventory Management uses the enhanced printing routines unless the old 
print routines are selected using one of the methods discussed in Selecting 
Pre-A9802 Print Routines on page 233. When using the enhanced routines, 
the Print Format Name field of the associated device type record (devtype 
file) will determine what form will be printed. If this field is null, the current 
device format will be used.

Service Level Agreement (SLA) Management
SLA Management will always use the enhanced printing routines.
232 Chapter 4—Print Routines and Printer Setup 



System Administrator’s Guide, Volume 1
Selecting Pre-A9802 Print Routines

The enhanced print routines are the default in all releases of ServiceCenter 
beginning with release A9802. If you want to enable the previous print 
routines, use one of the following methods:

Edit the System Wide Company Record.

Apply Format Control.

System Wide Company Record
To keep the pre-A9802 print routines, you can easily set a global flag which 
enables these routines for most applications. You can set this flag for all users 
by accessing your System Wide Company Record and selecting the Use Old 
Printing check box from the Print Options section:

To enable the pre-A9802 print routines in the System Wide Company 
Record:

1 In the system administrator’s home menu, click the Utilities tab.

2 Click Administration. The Administration menu is displayed.

3 Click System Wide Company Record. 
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The System Wide Company Record is displayed (Figure 4-1 on page 234).

Figure 4-1: System Wide Company Record (info form)

4 Click the Print Options tab.

Figure 4-2: Print Options tab in the company info record

5 Select the Use Old Printing check box.

6 Click Save.

The old-style printing routines will now be used for Incident Management, 
Service Management, Change Management, and Inventory Management. 

Note: Printing from the database and from SLA Management will always use 
the enhanced printing routines.
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Format Control
You can also use the variable, $G.old.print, in the login Format Control 
record to set a flag to allow use of the pre-A9802 print routines. 

To enable the pre-A9802 print routines with Format Control:

1 Make sure that the command line is visible by selecting Command Line from 
the View menu.

2 Type fc on the command line.

3 Click the Start Command arrow or press Enter.

The Format Control Maintenance form is displayed. 

4 Type login.DEFAULT in the Name field to set the variable for all users. This is 
used in the following example.

To set the variable for a specific user (for example, FALCON), type 
login.<LOGIN NAME>.

5 Press Enter.
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The login.DEFAULT form is displayed (Figure 4-3 on page 236).

Figure 4-3: Format Control record for user login

6 Click Calculations or select Calculations from the Options menu.
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The Format Control Maintenance—Calculations form is displayed 
(Figure 4-4 on page 237).

Figure 4-4: Format Control maintenance—Calculations

7 In the next available Calculation field, type $G.old.print=true.

8 In the Add field, type true.

9 Click Save.

Old-style printing routines will now be used for Incident Management, 
Service Management, Change Management, and Inventory Management.

Note: Printing from the database and from SLA Management will always use 
the enhanced printing routines.
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Printing—Setup

ServiceCenter allows you to:

Print a form (screen print)

Select Print Screen from the File menu to print the screen just as you see it. A 
screen print is different than printing a record. A screen print simply prints 
the currently displayed form and the data in the displayed fields.

Print a record from an application

Select Print Record or Print from the Options menu to print records such as 
incident tickets or change requests. Printing a record prints all the 
information within the record, including the updates.

Select and configure a printer

For printing records, printers used by ServiceCenter clients and for 
server-side printing are defined in a configuration record. The type of printer 
configured depends on the platform on which the server is running. 
ServiceCenter allows you to configure:

Standard printers (Windows NT or Unix)

JES printers (mainframe)

Select Printing Options from the File menu to select and configure a client 
printer and define a font. This option is described in the ServiceCenter User’s 
Guide.

Background Printing In ServiceCenter for Windows NT
Background printing in ServiceCenter for Windows NT requires that you set 
up printing services for the ServiceCenter service under Windows NT. In this 
section, you will:

Set up the ServiceCenter service to run under a user ID with printers 
defined in the Print Manager.

Create a new printer record in the ServiceCenter configuration file.
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Setting Up Under a User ID
You must set up the ServiceCenter service to run under a user ID that has the 
printers defined in the Windows NT Print Manager. During the installation, 
the setup program installed ServiceCenter service to run under the default 
LocalSystem user ID that does not access any printers. To allow the 
ServiceCenter spool background process to access a printer, the 
ServiceCenter service needs to run under a user ID that has printers defined.

Note: This user ID must belong to an Administrators or Power Users group.

To set up a ServiceCenter service to run under a specific user ID:

1 Open the Control Panel and double-click Services.

The Windows NT/2000 Service dialog box is displayed.

Note: For Win/2000, go to: Control Panel>Administrative Tools>Services.

2 In the Services list in Windows NT, select ServiceCenter, and then click 
Startup. In Windows 2000, double click ServiceCenter in the Services list.

The Service dialog box is displayed.

Figure 4-5: Service startup window—Windows NT and Windows 2000

3 Click Browse in the This Account field.
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The Add User dialog box is displayed in Windows NT, and the Select User 
dialog box is displayed in Windows 2000.

Figure 4-6: Add/Select User window

4 Select a domain name from the List Names From drop-down list in 
Windows NT or from the Look in drop-down list in Windows 2000.

5 Double-click a name from the list displayed.

The name you have selected appears in the Add Name field in Windows NT 
and in the Name field in Windows 2000.

6 Click OK.

The Windows NT Service dialog box is displayed (Figure 1-3 on page 23). 
The This Account field now shows the user ID.

7 Enter the Password.
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8 Re-enter the password in the Confirm the Password field, and then click OK.

A message is displayed stating, The account <account name> has been granted 
the Log On As A Service right.

9 Click OK.

You are returned to the Windows NT Service dialog box.

When you start the ServiceCenter service, the service now runs under the 
new user ID instead of the LocalSystem user ID.

Creating a New Printer Record In the Configuration File
Next, you must create a new printer record in the ServiceCenter 
configuration file. The Standard Printer configuration file allows you to set 
up your ServiceCenter printing for Windows NT or Unix. Printing from a 
mainframe server is described in the next section.

ServiceCenter is shipped with two standard printer records, sysprint.winnt 
and sysprint.unix, for ServiceCenter servers running on Windows NT and 
Unix, respectively. The printer record does not specify a printer destination, 
but uses the default printer defined in the Windows NT Print Manager or in 
Unix as the destination printer. When you select sysprint.winnt or 
sysprint.unix in the ServiceCenter Configuration File, the ServiceCenter 
spool background process routes the print output to the default printer 
defined for the ServiceCenter server. This setup only works for locally 
attached printers and Novell network printers. This setup does not apply to 
Windows NT shared printers.

If multiple printers are defined for the user ID where the ServiceCenter 
service was running, the user can create multiple printer records on the 
system.

To access the printer Configuration File:

You can access the printer Configuration File in two ways:

From the command line:

a Make sure that the command line is visible by selecting Command Line 
from the View menu.

b Type stdptrs on the command line. 

c Click the Start Command arrow or press Enter.
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From the Maintenance menu:

a Click Utilities tab.

b Click Maintenance.

c Click Hardware tab.

d Click Standard Printer.

The Standard Printers Configuration File form is displayed.

To create a printer record in the ServiceCenter system config file:

1 Log on to ServiceCenter as a system administrator.

2 In the system administrator’s home menu, click the Utilities tab (Figure 1-12 
on page 42).

3 Click Maintenance.

The ServiceCenter Maintenance menu is displayed.

4 Select the Hardware tab.

Figure 4-7: Hardware tab in the maintenance menu

5 Click Standard Printer.
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The Standard Printers Configuration File form is displayed.

6 Click Search.

A record is displayed with the list of printer configurations.

Figure 4-8: Standard printer configuration record 

7 Select a printer for your server, that is, Windows NT or Unix.

sysprint.winnt for Windows NT.

sysprint.unix for Unix.

8 Fill in the fields to properly identify the printer where the ServiceCenter 
server prints.

Refer to the following section for field descriptions.

9 Click Add or press F2.

A message is displayed at the bottom of the window stating: Record added to 
the config file.

10 Click OK or press F3, and then click Back to return to the Maintenance 
menu.
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Configuration File Fields

Field Description

Device Name Unique name assigned to the printer in ServiceCenter (for 
example, sysprint.accounting for a printer located in the 
Accounting department).

Program Name Appropriate print command.

For Unix, enter: lpr
For Windows NT, enter:

scntprt 
Select this to print in languages other than English. The 
print output will be sent to the default windows printer 
for the computer from which printing is being done. 

Ensure that the ServiceCenter printing configuration is 
set to the Server printer, rather than the Client printer. 
To verify the printing configuration, go to the File menu 
and select printing Options. When the print command 
prompt is displayed, click the printer icon and select the 
printer name that you just created from the qbe list. 

—Or—

scntlp -d <new_printer_name>
where -d indicates the destination parameter, and 
<new_printer_name> is the destination printer name 
defined in the Windows NT/Windows 2000 Print 
Manager.

If the printer is a Windows NT/Windows 2000 shared 
printer: the <new_printer_name> is 
\\server_name\share_name where share_name is the 
name from the Share Name field in the Printer Properties 
dialog box of the Print Manager. 

For example, if the shared Printer name is account_prt 
and located on server ACCOUT, the 
<new_printer_name> is \\ACCOUT\account_prt.

If the printer is a locally attached or Novell printer: 
<new_printer_name> must be the name from the 
Printer Name field in the Printer Properties dialog box of 
the Print Manager. 

If no destination printer is selected, the print output will 
be sent to the default windows printer for the computer 
from which the printing is being done.

Connection Type Used to distinguish between the different types of 
devices in the Configuration File
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Creating a New Printer Record for a Mainframe Server
ServiceCenter is shipped with a configuration file for JES printing. You can 
access the JES Configuration File form in two ways:

Command line

Maintenance menu

Note: These instructions assume a familiarity with OS/390. If you are unsure 
of these procedures, contact your OS/390 system administrator.

To access the JES Configuration File from the command line:
1 Make sure that the command line is visible by selecting Command Line from 

the View menu.

2 Type jesptrs on the command line. 

3 Click the Start Command arrow or press Enter.

The JES Configuration File form is displayed.

To access the JES Configuration File from the Maintenance Menu:
1 In the system administrator’s home menu, click the Utilities tab (Figure 1-12 

on page 42).

2 Click Maintenance. The ServiceCenter Maintenance menu is displayed.

3 Select the Hardware tab (Figure 4-7 on page 242).

Banner Boolean field to determine if a banner page is printed

Enter true to include a banner page with each print job.

Leave blank or enter false to omit a banner page.

Printer Type Character field where you can enter a description of the 
printer.

Handles Copies Boolean field. This field should be set to true for Unix 
printers. Entering false causes ServiceCenter to ignore any 
data entered in the copies field when a report is printed.

Maximum Width Maximum line width (number of spaces) to ensure that the 
page is properly printed. Eighty (80) is the setting for 
standard 8.5 x 11 inch paper.

Read/Write Option Must be set to w for write.

Lines Per Page Maximum number of lines per page the printer is capable 
of printing. The default setting is 60.

Field Description
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4 Click JES Printer. A blank JES Configuration File form is displayed.

5 Click Search.

A QBE list of available printers is displayed.

Figure 4-9: JES printer configuration file form

6 Select your server’s operating system from the record list displayed:

sysprint.mvs for OS/390.

intrdr for a JES internal reader.
246 Chapter 4—Print Routines and Printer Setup 



System Administrator’s Guide, Volume 1
The record displayed contains the default information for the print record. 
The fields must be properly filled in to identify the printer where the 
ServiceCenter server prints. Refer to JES Printer Options on page 248, JES 
Options for 3800 Printers on page 249, and JES Options Not Specific To 3800 
Printers on page 250 for descriptions of fields and options.

7 Click Add or press F2 to add a record.

A message is displayed at the bottom of the window stating: Record added to 
the config file.

8 Click Return to return to the Maintenance menu.

JES Configuration File Fields

Field Description

Device Name Unique name assigned to the printer in ServiceCenter 
(for example, sysprint.accounting for a printer located 
in the Accounting department).

Sysout Class Contains the JES sysout class to be assigned to all reports 
printed to this printer.

Connection Type Must contain jes for all JES printers. This field is used to 
distinguish between the different types of devices in the 
Configuration File.

Banner Determines if a banner page is printed with each print 
job.

Enter true to print a banner page.
Enter false or leave the field blank to eliminate the 
banner page.

Printer Type Optional description field.

Handles Copies Should be true for JES printers (JES handles printing the 
correct number of copies of each report). Entering false 
causes ServiceCenter to ignore any data entered in the 
copies field when a report is printed from ServiceCenter.

Max Width (80/132) Maximum line width should be entered to ensure 
correct printing of the banner. Eighty (80) is the setting 
for standard 8.5 x 11 inch paper.
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JES Printer Options

Translate Characters 
From

Characters which this printer will not print. For 
example, if your printer only prints uppercase, enter all 
lowercase letters in this field.

Translate Characters To Replacement values for the characters this printer will 
not print. For example, if your printer only prints 
uppercase, enter uppercase letters in this field.

Field Description

Option JCL Equivalent Definition

Route DEST=RMTnnn JES remote routing ID. If you omit 
the node ID, reports are routed to 
an RJE destination off the local 
node.

Hold HOLD= Contains the JES hold parameter. 
Any character entered in this field 
means hold the output.

Number of 
Copies

COPIES=nnn Contains the number of copies 
which will be printed to this 
printer. This field is filled 
automatically when the number of 
copies is specified at report 
execution time.

Form SYSOUT=(,,form-name) Contains the JES forms parameter. 
Specifies special forms or paper.

UCS UCS=char-set-code Contains the JES parameter to 
specify the print train to use.

Fold UCS=(char-set-code,FOLD) This field will fold lowercase to 
uppercase. This is a printer specific 
feature and is independent of the 
translate function.

FCB FCB=fcb-name Contains JES control buffers 
parameters.
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The following fields are used in conjunction with 3800 printers or their 
equivalent.

JES Options for 3800 Printers 

Alignment 
Verify

FCB=(fcb-name,ALIGN) Any character entered in this field 
will cause a request to be issued to 
the operator console to check the 
printer for forms alignment before 
printing. This field cannot be used 
with 3800 printers.

Character Set 
Verify

FCB=(fcb-name,,VERIFY) Same as alignment verify but also 
sends a request to the operator 
console to verify that the image 
displayed on the printer is the 
desired one.

SYSOUT 
Program Name

SYSOUT=(,writer-name) This contains a JES output writer 
name.

Output Limit LINES=nnn Specifies the maximum number of 
lines to print.

User ID DEST=(,userid) Valid user ID destination 
established by your installation.

Option JCL Equivalent Definition(Continued)

Option JCL Equivalent Definition

Character Table CHAR=(table-name) Contains a valid character table 
established by your installation for 
3800 printers.

Overlay Name FLASH=(overlay-name) Contains a valid overlay form name 
for 3800 printers.

Overlay Count FLASH=(overlay-name,
count)

Contains the number of copies in 
which you would like the above 
overlay form to appear.

Output OUTPUT=*.referback Contains processing options for a 
system output (sysout)data set.

Title TITLE='title' Used to print a description of the 
output on the separator pages of 
the output of a sysout data set.
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JES Options Not Specific To 3800 Printers

Name NAME='name' Used to print a preferred name on 
the separator pages of the output 
for a sysout data set. Preferred 
name is the name associated with 
the output.

Address 1

Address 2
ADDRESS='address1,ad
dress2'

Used to print an address on the 
separator pages of an output data 
set.

Building BUILDING='building' Used to print a building 
identification on the separator 
pages of an output data set.

Department DEPT='department Used to print the department 
identification on the separator 
pages of an output data set.

Room ROOM='room' Used to print a room identification 
on the separator pages of the 
output for a sysout data set.

Form Definition FORMDEF='member' Identifies a library member that 
contains statements to tell the Print 
Services Facility (PSF) how to print 
the sysout.

Page Definition PAGEDEF='member' Identifies a library member that 
contains statements to tell the Print 
Services Facility (PSF) how to print 
the sysout data set on a page-mode 
printer.

Option JCL Equivalent Definition(Continued)

Option JCL Equivalent Definition

Record Length LRECL=nnnn Specifies the length of the records in 
a new data set.

Block Size BLKSIZE=nnnn Specifies the maximum length, in 
bytes, of a block.

Record Format RECFM=ccc (FB,FBA, or 
VBA)

Specifies the format and 
characteristics of the records in a 
new data set.
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5
 Clocks and the Inactivity Timer
Clocks

Clocks allow you to track time in specific areas of ServiceCenter. This section 
uses incident tickets as an example. Incident tickets can be associated with 
multiple clocks, one clock, or no clocks. Clocks allow you to track the 
following:

The time an incident ticket spends in a problem state or different states.

The time an operator spends editing a ticket.

The time a ticket spends in an assignment group or multiple groups.

Clocks are based on records in the clocks file. To learn more about what a 
clock is and its function within assignment groups, see ServiceCenter System 
Tailoring.
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To access a clock record:

1 On the System Administrator’s home menu, click the Utilities tab 
(Figure 1-12 on page 42).

2 Click Tools.

The Tools menu is displayed.

Figure 5-1: Tools Menu

3 Click Clocks.

A blank clock record is displayed.

3
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4 Enter the name of the clock you want to view, or click Search to display a 
record list of all clocks in the file.

Figure 5-2: Clocks record

Clock Fields

Field Data Type Description

type character The type of clock, problem, downtime, cm3r, SLA, or 
incident. All clocks associated with incident tickets 
have a clock type of problem or SLA.

key.char character A character key used to associate a clock with a 
particular external record. All clocks associated with 
incident tickets store the incident number in this 
field.
Clocks  253



ServiceCenter
key.numeric number A numeric key used to associate a clock with a 
particular external record. All clocks associated with 
incident tickets have NULL in this field. (In Incident 
Management, the incident number is a character 
field.)

name character The name of this clock, for example, Time locked by: 
<user ID>.

total date/time The total time that this clock has been running. Note 
that this value may not always be accurate for clocks 
which are currently running.

closed.total date/time The total time that this clock last ran from start to 
stop.

schedule character The duty table name from the caldaily file 
(calendar) that applies to this clock. This 
coordinates clock functions with a particular work 
shift.

closed.date date/time The date and time this clock last stopped.

running logical Indicates whether or not this clock is still running.

start 
(structured 
array)

date/time Listing of every start date and time for this clock. 
Note that a clock may start and stop multiple times 
over its lifetime.

stop 
(structured 
array)

date/time Listing of every stop date and time for this clock. 
Note that a clock may start and stop multiple times 
over its lifetime.

Field Data Type Description
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How Does a Clock Work?
Figure 5-3 on page 256 provides an example of how clocks work with 
incident tickets. The following example uses three states: Open, Pending and 
Closed.

Whenever an incident enters the Open state, a clock named Total Time is 
started.

Whenever an incident enters the Pending state, the Total Time clock is 
stopped, and a clock named Pending Time is started.

Whenever an incident ticket leaves the Pending state, the Total Time clock 
is started again, and the Pending Time clock is stopped.

Whenever an incident enters the Closed state, the Total Time clock and the 
Pending Time clock are both stopped.

Applying this model to the example in Figure 5-3 on page 256:

1 At 1:00 PM on July 1, incident ticket 104 is created and saved in the Open 
state. A clock named Total Time is created and started.

2 At 4:00 PM on July 2, the incident ticket is moved to the Pending state.

The Total Time clock is stopped, after running for 27 hours.

The Pending Time clock is created and starts running.
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3 At 2:00 PM on July 4th, the ticket is returned to the Open state.

As the ticket leaves the Pending state and changes to Open state, the 
Pending Time clock is stopped, after running for 46 hours.

As the ticket leaves the Pending state, the Total Time clock is restarted.

Figure 5-3: Clocks example

4 At 2:30 PM on July 4th, the ticket is Closed.

As the ticket enters the Closed state, ServiceCenter attempts to stop the 
Pending Time clock, which is already stopped.

As the ticket enters the Closed state, the system stops the Total Time clock. 
This clock has been running for 30 minutes since being restarted.

Incident 
Ticket 104

Open

July 1
1:00 p.m.

total.time pending.time

starts—00:00 not started

stops—27:00 starts—00:00

restarts—27:00 stops—46:00

stops—27:30 stopped—46:00

July 2
4:00 p.m.

July 4
2:00 p.m.

July 4
2:30 p.m.

1

2

3

4

Incident 
Ticket 104
Pending

Incident 
Ticket 104

Open

Incident 
Ticket 104

Closed
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The clock totals are:

Total Time—ran from 1:00 p.m. July 1st until 4:00 p.m July 2nd:
27 hours; and also ran from 2:00 PM July 4th until 2:30 PM July 4th for 0.5 
hours. The total running time: 27 + 0.5 = 27.5 hours.

Pending Time—ran from 4:00 PM on July 2 until 2:00 PM on July 4, for a 
complete running time of 46 hours.

Starting and stopping clocks
ServiceCenter provides five methods for starting and stopping clocks. You 
can start and stop clocks by:

Status changes.

Operator tracking.

Format Control.

RAD changes.

Macro Editor.

Note: When a clock is started, a record is automatically created in the clocks 
file.

Starting and Stopping Clocks by Status Changes
In Incident Management, you can define an incident status. These status 
definitions are stored in the pmstatus file. Each time an incident ticket 
changes status, ServiceCenter checks for any clocks that need to be started or 
stopped. For example, if an incident ticket changes from Pending to Open, 
ServiceCenter checks for any clocks associated with Pending or Open status 
that need stopping or starting.

To access a pmstatus record:

1 In the system administrator’s home menu, click the Toolkit tab (Figure 1-14 
on page 45).

2 Click Database Manager.
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The Database Manager dialog box is displayed.

Figure 5-4: Database Manager dialog box

3 Type pmstatus in the File field, and then click Search.

4 Select apm.status from the QBE list displayed.

A blank record is displayed.

5 Click Search, and then select the name of the status from the record list for 
which you want to set a clock.
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For example, if you want to start a clock whenever an incident ticket is 
entered that is Pending customer status, select Pending customer.

Figure 5-5: PMStatus record

6 Modify the following fields as needed:

Field Description

Name Name of the Incident Management status that will trigger 
the clock.

Sort Value Order in which statuses are displayed in a combo box.
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On Entering This Status

The clocks listed in this structure are affected when an incident ticket enters 
the status listed in the Name field.

Field Description

Start These Clocks Clocks that you want Incident Management to start when 
a ticket enters the status indicated in the Name field.

In the example shown, each time an incident ticket enters 
the Pending customer status, a clock named Pending 
Customer is started. This clock keeps track of how long the 
ticket remains in the Pending customer state.

Clock Names include:

Closed
Open
Pending customer
Pending other
Pending vendor
Referred
Reject
Replaced Problem
Resolved
Suspended
Work in progress

Stop These Clocks Clocks you want Incident Management to stop when a 
ticket enters the status indicated in the Name field.

In the example shown, each time an incident ticket enters 
the Pending customer status, a clock named Total Time is 
stopped. This clock keeps track of how long the ticket has 
been in states other than the Pending customer state.
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On Exiting This Status

The clocks listed in this structure are affected when an incident ticket enters 
a status other than the status listed in the Name field.

7 Choose one of the following:

Click Save or press F2 to save the changes made to the record.

A message is displayed in the status bar that states: Record updated in the 
pmstatus file.

Rename the record, and click Add or press F5 to create a new pmstatus 
record.

Stopping and Starting Clocks Via Operator Tracking
ServiceCenter includes an option available in the Incident Management 
Environment record called Track Operator Times. When this option 
evaluates to true, the system automatically starts a clock whenever an 
operator begins editing a record. The clock is stopped when the operator 
stops editing the record. The name of this clock is Time viewed by: 
<operator>, where <operator> is the user editing the record. For example if 
FALCON is editing a record, the clock is named Time viewed by: FALCON.

Field Description

Start These Clocks Clocks that you want Incident Management to start 
when a ticket leaves this status.

In the example shown, each time an incident ticket exits 
the Pending customer status, a clock named Total Time 
is started. This clock keeps track of how long the ticket 
has been in states other than the Pending customer state.

Stop These Clocks Clocks that you want Incident Management to stop 
when a ticket leaves this status.

In the example shown, each time an incident ticket exits 
the Pending customer status, a clocked named Pending 
Time is stopped. This clock keeps track of how long the 
ticket remains in the Pending customer state.
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Stopping and Starting Clocks With Format Control
Clocks can be started and stopped through ServiceCenter’s Format Control 
utility. Two Format Control routines are used:

apm.start.clock – Starts a clock

apm.stop.clock – Stops a clock

To start or stop a clock from Format Control, you simply invoke the 
appropriate subroutine and pass it the appropriate parameters. For details on 
using the Format Control utility, see ServiceCenter System Tailoring, 
Volume 1.

To get to this example, go into the Format Control utility by following the 
steps below:

1 Go to a command line and type fc.

2 Enter problem.sw.desktop.open and click Search.

3 When the record displays, select Subroutines from the Options menu.

4 Once in Subroutines, click on Options and select Show Expanded Form.

5 Enter apm.start.clock in the Application Name field.
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The following figure displays a Format Control record that will start a clock 
named elvis.

Figure 5-6: Setting clocks in Format Control

The following table describes the parameters that are entered in the Names 
and Values arrays for apm.start.clock:
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Parameters for the apm.start.clock Application

The following table describes the parameters that are entered in the Names 
and Value arrays for apm.stop.clock.

Names Type Description/Values

name character The type of clock to start. For example, all incident 
management clocks are of type problem or SLA.

prompt character The name of this clock, for example, elvis. The value you put 
in here needs to be unique within a given incident ticket. You 
cannot have two clocks named boris associated with the same 
incident ticket. The system would restart the existing boris 
clock when you try to open a second clock named boris. No 
requirement exists that clock names be unique between 
incident tickets. You could have several thousand incident 
tickets, each with a clock called Total Time.

query character The unique character key for this clock. For an incident 
clock, pass the incident number of the incident ticket with 
which you want this clock to be associated, for example, 
number in $file.

time1 date/time The time at which this clock is to start (defaults to current 
date and time).

Note that putting in a time prior to the present rolls back all 
clock events since that time. Usually, you should leave this 
blank and allow it to default to tod().
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Parameters for the apm.stop.clock Application

Starting and Stopping Clocks Via Rad
You can easily start and stop clocks via ServiceCenter’s RAD programming.

Clocks can be started by calling apm.start.clock.

Clocks can be stopped by calling apm.stop.clock.

Note: Clocks can be in various applications in ServiceCenter other than 
Incident Management. If you choose to use a clock for an application 
other than Incident Management, ensure that you select a clock type 
that is not already in use.

Names Type Description/Values

name character The type of clock to stop all problem clocks are of type 
problem or SLA.

prompt character The name of this clock, for example, elvis. The value you put 
in here needs to be unique within a given incident ticket. You 
cannot have two clocks named boris associated with the same 
incident ticket. The system would stop the existing boris 
clock when you try to stop a second clock named boris. No 
requirement exists that clock names be unique between 
incident tickets. You could have several thousand incident 
tickets, each with a clock called Total Time.

query character The unique character key for this clock. For an incident 
ticket, pass in the incident number of the incident ticket with 
which you want this clock to be associated, for example, 
number in $file.

string1 character Either stop or strobe. If you want to stop a clock, set this 
value to stop. Strobing a clock simply forces it to recalculate 
its current running time.

time1 date/time The time at which this clock is to stop (defaults to current 
date and time). 
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Accessing a Clock
To view all the clocks associated with an incident ticket:

Click Clocks when editing a problem record.

A shortcut window (Figure 5-7 on page 266) is displayed listing all the clocks 
currently associated with this ticket and the time that each clock has been 
running. This display is a snapshot of the various clocks and can be updated 
by clicking Clocks again.

Figure 5-7: Clocks
266 Chapter 5—Clocks and the Inactivity Timer 



System Administrator’s Guide, Volume 1
Inactivity Timer

The inactivity timer allows you to terminate the sessions of users who have 
been idle for a specified period of time. The inactivity timer will shut down 
all users on the system after a prescribed interval with the exception of those 
defined in the inactivity schedule record.

Note: To use the inactivity timer you must have the inactive background 
process running on the ServiceCenter server. Refer to Start Scheduler 
on page 53 for procedures on starting background processes.

Users can be alerted prior to a scheduled inactivity shutdown by defining a 
warning interval in the inactivity schedule record. The warning message is 
displayed in Active Notes. 

When the defined inactive time interval has elapsed, the client is terminated 
without further notification.

Starting the Inactivity Timer
To define a scheduled inactivity shutdown:

1 In the system ServiceCenter home menu, click the Utilities tab.

2 Click Maintenance. 

The Maintenance menu is displayed.

3 Click Start Inactivity Timer.

The inactivity schedule record is displayed (Figure 5-8 on page 268). If no 
inactivity shutdown interval has been scheduled, the record is blank with a 
default interval of 30 minutes appearing in the Number of minutes to allow 
idle user field.
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4 Change the inactivity interval to suit your needs.

Figure 5-8: Inactivity parameters defined

5 Define a warning interval in the Warn user within <n> minutes of 
termination field to alert your users that their sessions are about to be 
terminated due to inactivity.

Note: Users must select Active notes from the View menu for the warning 
message to appear.

6 Enter the names of users whose sessions you do not want to terminate for 
inactivity in the array titled DO NOT terminate these users.

7 Click Start inact to schedule the inactivity shutdown interval.

You are returned to the Maintenance menu. The following message is 
displayed in the status bar: The inactive process has been set up to look for users 
idle after 30 minutes. 
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Stopping the Inactivity Timer
To stop the scheduled shutdown of idle users:

1 Open the inactivity schedule record using the procedures described in steps 
1-3 in Starting the Inactivity Timer on page 267.

2 Click Stop inact.

You are returned to the Maintenance menu. The following message is 
displayed in the status bar: Inactivity Schedule Record futured to mm/dd/yyyy 
hh:mm:ss.

Note: Stopping the inactivity timer using this procedure disables the 
scheduler, but leaves the record with the same appearance.

Restarting the Inactivity Timer
You may restart the inactivity timer using the current parameters or edit 
them before resetting the record.

To restart the timer:

1 Open the inactivity schedule record using the procedures described in steps 
1-3 in Starting the Inactivity Timer on page 267 (Figure 5-8 on page 268).

2 Click Reset inact.

You are returned to the Maintenance menu. The following message is 
displayed in the status bar: The inactive process has been set up to look for users 
idle after 30 minutes.

Deleting the Inactivity Schedule Record
Deleting the record from the schedule file gives all users unlimited inactivity 
time. To apply the timer again, you must redefine time limits and excluded 
users.

To delete the inactivity schedule record:

1 Open the inactivity schedule record using the procedures described in steps 
1-3 in Starting the Inactivity Timer on page 267 (Figure 5-8 on page 268).

2 Click Delete inact.

The fields in the inactivity schedule record are cleared of parameters (with 
the exception of the default 30 minute inactivity interval), and the following 
message is displayed in the status bar: Record deleted from the schedule file. 
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6
 Time Zone Function and Date Formats
Overview

The Time Zone Function within ServiceCenter is designed to provide 
enhanced internal handling of date/time fields. The main features are:

Automatic clock adjustment during Time Zone switchovers, such as, 
Standard Time to Daylight Savings Time.

Accurate date/time interval calculations, adjusting automatically for any 
Time Zone changes occurring during the date span.

Ability to define Local Time Zones down to the individual operator level, 
if necessary. This allows users, local or remote, to view the same date/time 
data and have it automatically converted to their correct local time.

Ability to set various Date Formats in order to view dates in the local 
standard.

Standard US format (mm/dd/yy)

European format (dd/mm/yy)

Optional format (yy/mm/dd)

The Time Zone and/or Date Format can be set as a default for the entire 
system within the System Wide Company Record. This default can be 
overridden by setting a different Time Zone and/or Date Format in 
individual operators’ Operator Records. This feature is useful if remote users 
have different Time Zones or use a different Date Format in their location. 
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The ServiceCenter file system includes Time Zone records for many world 
regions. These records contain offsets from Greenwich Mean Time (GMT) 
and local switchover definitions. Refer to Maintaining the tzfile on page 276 
for tzfile cautions and instructions. You will learn to:

set the default Time Zone and Date Formats.

set the Time Zone and Date Formats for individual operators.

create and modify Time Zone records.

Set the Default Time Zone and Date Format

The Time Zone function allows a default Time Zone and Date Format to be 
set for all operators on the ServiceCenter system. This is done within the 
System Wide Company Record, but can be overridden for individual 
operators within the Operator Record (see Setting the time zone and date 
format for an operator on page 275).

The following example demonstrates setting up the default Time Zone as US 
Pacific Standard Time and the Date Format as US Standard (mm/dd/yy) 
within the System Wide Company Record.

To access the System Wide Company Record:

1 Click the Utilities tab in the ServiceCenter Home menu.

2 Click Administration.

The Administration menu is displayed.

3 Click System Wide Company Record in the Information structure.

The System Wide Company Definition (info.company.g) form is displayed.

4 Click the Date Info tab and position the cursor in the Time Zone field 
(Figure 6-1 on page 272).

Figure 6-1: System Wide Company Record—Date Info tab
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5 Enter the name of the Time Zone in this field. For this example, enter US in 
the field to view all Time Zone records starting with US.

Note: If you don’t know the name, you can click the Fill button to view the 
available Time Zone data.

6 Click Fill.

A QBE list of records that start with US in the tzfile are displayed (Figure 6-2 
on page 273). Each record represents a different Time Zone.

Figure 6-2: Selecting a Time Zone

7 For this example, select US/Pacific.

The System Information Definition form is displayed again with US/Pacific 
filled in the Time Zone field.

Notice that a date format is automatically entered in the Format field that 
corresponds with the US/Pacific time zone. This date format is mm/dd/yy, 
the Standard US date format (see Figure 6-1 on page 272).

8 Click Save to save the updated record.

9 Select Options > Set Parms.

A message confirming the setting of the Time Zone for the entire 
ServiceCenter system is displayed at the bottom of the form:

System setparms time zone set using tz record: US/Pacific.

10 Click OK to return to the previous menu.
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Important: The ServiceCenter System must be shut down and brought back 
up again in order for the Time Zone and Date Format to take 
effect.

All date/time data viewed by all operators on this system will now be 
converted to the US Pacific Time Zone and will display in the Standard US 
format of mm/dd/yy unless overridden within the individual operator 
records. Refer to Set the Time Zone and Date Format for Individual Operators 
on page 274.

Set the Time Zone and Date Format for Individual 
Operators

Control of Time Zone and Date Formats are provided at the operator level 
for local control. This allows remote users located in time zones different 
than the CPU location to view date/time fields with automatic conversion to 
their correct local time. Similarly, the date format can be controlled as well.

For example, ServiceCenter is running on a CPU located in San Diego, CA, 
under local Pacific Standard Time using standard US formatted dates 
(mm/dd/yy). Remote users logged onto ServiceCenter from Western Europe 
are now able to view the same date/time data with the time converted to their 
local time of Western European Time and the dates in European format 
(dd/mm/yy).

Setting of local time zones and date formats within an Operator record 
overrides the values set up in the System Wide Company Record as the 
system-wide defaults. 

The following example shows the steps necessary to override the system 
default for a specific operator.

To access an Operator record:

1 Click the Utilities tab in the ServiceCenter Home menu.

2 Click Administration.

The Administration menu is displayed.

3 Click Operators in the Security structure.

The operator form is displayed (Figure 6-3 on page 275).
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4 Position the cursor in the Login Name field and enter the name of the 
operator whose record you want to modify. Press Enter.

-or-

Click Search to perform a true query and retrieve a list of all current Operator 
records. From the displayed queue screen, select a record to view and modify 
by double-clicking on the Name in the record.

Figure 6-3: Setting the time zone and date format for an operator

5 Position the cursor in the Time Zone field.
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6 Enter the name of the Time Zone record in this field. For this example, enter 
Europe in the field to view all Time Zone records starting with Europe.

Note: If you do not know the name of the Time Zone, click the Fill button to 
view the available Time Zone data.

7 Click Fill.

A QBE list of records that start with Europe in the tzfile are displayed, similar 
to the list displayed in Figure 6-2 on page 273. Each record represents a 
different Time Zone within Europe.

8 For this example, click Europe/Western.

The operator form is displayed again with Europe/Western filled in the Time 
Zone field.

Notice that a date format is automatically entered in the Format field that 
corresponds with the Europe/Western time zone. This date format is 
dd/mm/yy, the European date format.

9 Click Save or OK to save the record change.

If you are modifying an Operator record other than your own, the changes 
take effect the next time a user logs on using that Operator ID.

If the user was already logged on, the user needs to log off and on again for 
the changes to take effect.

Maintaining the tzfile

Due to its critical nature, access to the tzfile is limited to system 
administrators for maintenance.

Important: The tzfile is among the most sensitive and critical of all 
ServiceCenter databases. Unlike most user databases, the 
ServiceCenter system relies on the tzfile to perform low-level 
date calculations. This means that tzfile modifications impact 
the entire user community and all ServiceCenter system 
processes, including the scheduling of background processes.
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Note: The ServiceCenter file system includes Time Zone records for many 
world regions. Since local time zones are controlled by ever-changing 
social and political factors, accuracy of the canned Time Zone records 
cannot be guaranteed. The system administrator assumes 
responsibility for monitoring time-zone-related world events and 
recording them in the tzfile.

To access the tzfile:

1 Click the Toolkit tab in the system administrator’s ServiceCenter Home 
menu.

2 Click Database Manager.

The initial Database Manager (format.prompt.db) form is displayed.

3 Type tzfile in the Form field and press Enter.

The tzfile form is displayed.

4 Press Enter or click Search to perform a true query and retrieve a QBE list of 
approximately forty pre-built records, which you can browse.

5 Scroll through the records to find a record for viewing. For this example, find 
and click on US/Eastern.
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The tzfile form is displayed again with the fields filled in that correspond to 
the US/Eastern time zone (Figure 6-4 on page 278).

Figure 6-4: Browsing through the pre-built records within the tzfile

The following field definitions identify the type of data needed for the record.

Field Description

Time Zone Name Unique key by which this record is referenced on the System 
Wide Company Record and on individual Operator records. 
For example, a user whose Operator record specifies 
US/Eastern in the Time Zone field is bound by this record.

Description Text description of the time zone name, including region 
and time zone.
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Default Date 
Format

Optional field containing the date formats. You only need to 
enter a format to override the format set in the System Wide 
Company Record. The formats are:

mm/dd/yy - Standard US date format where mm/dd/yy 
equals 
month, day, and year.
dd/mm/yy- European date format where dd/mm/yy 
equals 
day, month, and year.
yy/mm/dd - Optional date format where yy/mm/dd 
equals 
year, month, and day.
mm/dd/yyyy - Optional date format where mm/dd/yyyy 
equals 
month, day, and year.
dd/mm/yyyy - Optional date format where dd/mm/yyyy 
equals 
day, month, and year.
yyyy/mm/dd - Optional date format where yyyy/mm/dd 
equals 
year, month, and day.

Date Separator Defining separator character to be used in the date format, 
such as / for separating the month, day, and year. For 
example: MM/DD/YY, which is also the default separator 
character.

Time Change 
Definitions

This structure defines every possible Greenwich Mean Time 
(GMT) offset that can occur within this time zone.

Name (abbr) Abbreviations help the administrator interpret the offsets; 
no system processing is associated with these abbreviations.

Offset from GMT Time Zone records for many world regions contain offsets 
from Greenwich Mean Time (GMT) and local switchover 
definitions. Offsets are referenced by their position (index) 
within the structured array. That is, the first offset (EST 
-05:00:00) occupies position 0; the second (EDT 
-04:00:00), position 1, etc.

Field Description
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Create Time Zone Records

If a necessary Time Zone definition is not included in the canned tzfile, or if 
you want to create a new Time Zone for testing purposes, you can create the 
new Time Zone by adding another record to the tzfile. You can model your 
new Time Zone from an existing record, or you can enter every field 
manually. You identify the new record by assigning a unique Time Zone 
Name.

For instructions on how to use the new Time Zone, refer to the previous 
sections Set the Default Time Zone and Date Format on page 272 and Set the 
Time Zone and Date Format for Individual Operators on page 274.

Time Change 
Dates/Indexes

This structure defines when time changes occur.

Switchover Date 
and Index of 
Definition

Common change involves redefining the switchover date. 
For example, before 1987 the US switchover date for Eastern 
Daylight Time (GMT -4) was defined as the last Sunday in 
April. The first entry in this field instructs ServiceCenter to 
begin using the second GMT offset (the offset in position 1 
at 02:00:00 on April 27, 1986). 

Example: The US/Eastern time zone record would have 
defined future switchover dates accordingly:

04/27/86 02:00:00__     1____
This four-hour offset from GMT persisted until the next 
entry:

10/26/86 02:00:00__     0____

This entry instructed ServiceCenter to begin using the 
first offset from GMT (the offset in position 0) at 
02:00:00 on October 26th, 1986. Similarly, the 
following offset persists until the next switchover entry, 
and so on.

Field Description
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Modify Time Zone Records

Changing Switchover Dates
A common change involves the redefinition of a switchover date. For 
example, before 2001 the US switchover date for Eastern Daylight Time 
(Offset from GMT -04:00:00) was defined as the last Sunday in October 2000. 
The US/Eastern Time Zone record would have defined future switchover 
dates accordingly:

Note: The following graphic (Figure 6-5 on page 281) indicates switchover 
dates for the first Sunday of April and the last Sunday of October 2001.

Figure 6-5: Switchover dates

In 1986 a new definition for Eastern Daylight Time was announced. The new 
switchover was to occur on the first Sunday in April beginning in 1987. To 
accommodate this change, a system administrator would simply have 
changed the switchover dates.

Adding New GMT Offsets
To accommodate a new offset, add the offset in the last Time Change 
Definitions structure in the Name (abbr) field of the time zone record. Note 
the new offset’s position in the Index of Definition field in the Time Change 
Dates/Indexes structured array and use this index to define switchover dates.
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In this example, a NEW offset in the Offset from GMT field of (GMT 
-04:30:00) is added to the bottom of the Time Change Definitions structured 
array. An appropriate Switchover Date for this new offset is inserted into the 
Time Change Dates/Indexes structure in its correct chronological sequence.

Note: The following graphic illustrates the NEW Offset from GMT at -4.5. 
An appropriate Switchover Date is inserted in its correct 
chronological sequence (such as, 04/06/03) and the Index of Definition 
reflects position 5.

Figure 6-6: Adding new GMT offsets
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7
 Monitor System Events
Overview

Monitoring System Events covers how the system administrator can:

Set system alerts for ServiceCenter Monitoring of system events (see 
Monitor ServiceCenter System Events on page 283).

Set up time intervals, so that registered queries being viewed will have 
the data automatically refreshed on a user’s display (see Automatic 
Refresh of Record List on page 77).

Monitor ServiceCenter System Events

As a system administrator, you need to be aware of system events that could 
cause the system to perform poorly or become unstable. ServiceCenter 
includes a way for you to monitor these events without having to search for 
the messages within the log file. 

To monitor system events and be proactive in making sure your system is 
running at its peak capacity, ServiceCenter monitors itself and creates an 
alert log that generates messages and directs your attention to how the system 
is performing.
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The following databases and activity are monitored within ServiceCenter.

P4 database

SQL database

Locked resources

Virtual or shared storage

Defining the Alert Periodic Schedule Record
Certain aspects of the system monitoring activities that are done by 
ServiceCenter are too expensive to be done on a continuous basis. Therefore, 
you can set how often ServiceCenter will monitor itself by using the 
Scheduler to start the Alert Periodic application intermittently. Once the 
settings are defined, the application will periodically check the features to be 
monitored.

Set how often ServiceCenter will be monitored by updating the Repeat 
Interval field and Application field settings in the Alert Periodic schedule 
record. For example, if you set the Repeat Interval field at four hours, 
ServiceCenter will monitor itself every four hours to check on virtual 
memory consumption and the sizes of various queues. Use the following 
steps to define the settings.

Note: These steps are for Windows NT. They may be slightly different for 
other platforms.

To schedule the Alert Periodic application:

1 In the system administrator home menu, click the Toolkit tab.

2 Click Database Manager.

3 Enter schedule in the Form field of the Database Manager dialog box.

4 Press Enter or click Search.

5 Select schedule from the QBE list.

A blank Schedule File record is displayed.

6 Enter Alert Periodic in the Name field, and then click Search.
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7 Update the Repeat Interval field values to reflect the frequency with which 
you would like alerts to be checked.

For example, if you want to have the alerts checked every four hours, set the 
time as:

04:00:00

8 If needed, update the Application field value to call the correct application:

us.alert.periodic

9 Click Save and exit.

Making Changes to the Alert Periodic Schedule Record
If you want to make changes to the frequency of how often ServiceCenter 
monitors itself, go back into the Alert Periodic schedule record and follow 
the steps in the previous procedure, setting the new frequency in the Repeat 
Interval field.

Setting System Alert Parameters in the Initialization (sc.ini) File
The system detects anomalies within the ServiceCenter environment by 
tracking certain system functions requested by the applications (for example, 
database and locking requests). Based upon the parameters set in the sc.ini 
file, the system administrator tracks system events. If an alert is generated for 
a system event that is not being tracked by the system administrator, the 
system administrator can set the alertfilters parameter in the Initialization 
file (sc.ini file) to tell the system to ignore the alert. For example, if an alert is 
being recorded and the system administrator determines that this alert is not 
detrimental to the system, the alertfilter can be used to cease the recording of 
the alert. After alerts have been analyzed and identified as not detrimental, 
they should be filtered. This keeps the alert log meaningful, as it only contains 
entries that require attention. See Alert Parameters on page 286 for 
descriptions of the alert parameters.

To make revisions in the server sc.ini file to include, exclude, or update 
alerts:

1 Go to the ServiceCenter Programs file directory.

2 Edit the sc.ini file with any text editor.

For example, on Windows NT, you can go to 
Start>Programs>ServiceCenter>Init file to open the sc.ini file with 
Notepad.
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3 Add a new line to the parameter field.

Example: If you want to set an average CPU or memory limit that each user 
should not pass, set the parameter in the sc.ini file as follows:

alertcpulimit:2

4 From the File menu, choose Save.

5 Exit Notepad.

6 Stop and restart ServiceCenter, so that the system changes will be recognized.

Set the following alert parameters as needed.

Alert Parameters

Alert Parameters Descriptions

alertcpulimit:n

(“n” represents the 
number you will set 
for average cpu usage 
limit)

The system determines if a user is consuming too much 
CPU by comparing the CPU used by each user with the 
CPU used by the average of all users. Most users should fall 
within one or two standard deviations from the average. 
The number provided by this parameter indicates the 
number of standard deviations that are acceptable. For 
example, alertcpulimit:2 indicates that all users within two 
standard deviations from the average are acceptable.

alertdtqueuelimit:n

(“n” represents the 
number of records)

Set the number of records that can reside in the 
ServiceCenter Distributed (SCD) data queue before 
causing an alert.
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alertfilters: Set which alerts can be filtered out and go unreported in 
the error log. Specify a single alert list, or multiple alerts, by 
separating each alert with a semicolon. For a description of 
the alert categories, see Alert Categories on page 289.

For example, to filter out all performance alerts, type:

alertfilters:Performance*
To specify all mapping alerts and a long running query 
alert against the contacts file, type:

alertfilters:Mapping*;Performance-5-contacts
If after evaluating an alert log and verifying that each 
performance-1 (full file scan) and performance-2 (partial 
key) query alert is not a problem, you can filter these out. 
Type:

alertfilters:performance-1*;performance-2*
(Adding an asterisk (*) at the end specifies all alerts within 
that category.)

alertholdlimit:n

(“n” represents the 
amount of time, in 
milliseconds)

A system lock is something that the system obtains when it 
is necessary to control access to a resource. For example, 
the IREXPERT indexes can only be updated by one process 
at a time, so if the ir.probsummary file is being updated, the 
system obtains a lock on that resource. Because locks are 
generally held for a short period of time, the alertholdlimit 
can be set to cause an alert when a lock is held for an 
excessive period of time. 

Set the amount of time, in milliseconds, that a lock can be 
held before it is considered an alert situation.

Note: The alerts alertholdlimit and alertwaitlimit are closely 
related, as they both measure locks within the system. 
Holding a lock (alertholdlimit) for a long time is not 
necessarily a bad thing. However, waiting for a lock 
(alertwaitlimit) is generally something to be avoided.

alertirqueuelimit:n

(“n” represents the 
number of records)

Set the number of records that can reside in the IR queue 
before causing an alert.

alertlog:sc.name.log

(“name” represents 
the log name)

Set the file where alerts should be written, using the full 
path name. The default will be alert.log within the current 
directory, typically the RUN directory.

Alert Parameters Descriptions
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Message Log: Alert Categories and Descriptions
Based upon the frequency set by the system administrator, the system 
periodically checks system events, finds alerts, and then prints them in the 
alert log. Problem events, such as problem queries, SQL activity, timing, and 
system locks, are detected based on the alert parameters set in the sc.ini file 
and logged, so that the system administrator can identify the potential 
problems and become proactive in handling the outcome. 

Alerts found within ServiceCenter are categorized, according to alert 
categories, and written to the log with an assigned number that identifies the 
type of alert that is being detected. For example, if a user has exceeded the 
specified CPU usage limit, an entry in the Limits category will appear in the 
log. See Alert Categories on page 289 for details of the alert categories and 
descriptions for each one.

alertquerylimit:n

(“n” represents the 
amount of time, in 
milliseconds)

Set the amount of time, in milliseconds, that a query can 
execute before causing an alert.

alertsqlqueuelimit:n

(“n” represents the 
number of records)

Set the number of records that can reside in the SQL 
Shadow queue before causing an alert.

alertvirtuallimit:n

(“n” represents the 
amount of memory 
in kilobytes)

Set the amount of memory, in kilobytes, that can be used 
before causing an alert.

alertwaitlimit:n

(“n” represents the 
amount of time, in 
milliseconds)

Set system wait time, in milliseconds, before causing an 
alert. This alert is probably more important than the alert 
controlled by the alertholdlimit parameter, because this 
alert indicates that clients are waiting for resources, which 
will cause their response time to suffer.

Note: The alerts alertwaitlimit and alertholdlimit are 
closely related, as they both measure locks within the 
system. Holding a lock (alertholdlimit) for a long time is 
not necessarily a bad thing. However, waiting for a lock 
(alertwaitlimit) is generally something to be avoided.

Alert Parameters Descriptions
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Alerts written to the alert log have the following header in each line.

category-type-item

See Alert Categories on page 289 for definitions of the categories and types for 
each category, and indicate the cause for the alert. For example, if a lock on 
the dbdict file was held for a long period of time, the alert header would be:

performance-4-dbdict

Alert Categories

Alert Category Descriptions

Limits-n

(“n” represents the 
Limits alert 
number)

   Limits-1 =  P4 database pool is getting close to being full. The 
alert item is the pool number.

   Limits-2 =  User has exceeded the virtual memory 
(alertvirtuallimit) threshold. The alert item is the name of the 
user.

   Limits-3 =  User has exceeded the specified CPU usage limit 
(alertcpulimit). The alert item is the name of the user.

   Limits-4 =  Shared memory is critically close to full.

Mapping-n

(“n” represents the 
Mapping alert 
number)

   Mapping-1 =  Field is truncated and mapped in RC format. 
The alert item is the file name and the field name that was 
truncated.

   Mapping-2 =  Duplicate mapping. Multiple ServiceCenter 
fields to a single SQL field. The alert item is the file name with 
the duplicate mapping. The alert text identifies the fields that 
are involved in the duplicate mapping.

   Mapping-3 =  Query cannot be translated to SQL. The alert 
item is the file name. The alert text will identify the query and 
the function that cannot be translated into SQL.

   Mapping-4 =  Field cannot be used in an SQL query, because 
of its data type. The alert item will be the file name and the 
field name.
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Performance-n

(“n” represents the 
Performance alert 
number)

   Performance-1 =  Query is not keyed. A long running query 
limit will be issued when a query exceeds the specified 
alertquerylimit, or a limit has not been set. The alert is the 
name of the file that is the target of the query. Consider 
creating a key to satisfy the query to avoid performance 
problems in the future when the database grows.

   Performance-2 = Query is partially keyed. A long running 
query limit will be issued when a query exceeds the 
alertquerylimit or a limit has not been set. The alert is the name 
of the file that is the target of the query. Consider creating a key 
to satisfy the query to avoid performance problems in the 
future when the database grows.

   Performance-3 = System waiting for a long period of time. 
The system has been waiting and exceeded the specified 
(alertwaitlimit) limit. The alert item is the name of the lock.

   Performance-4 = A lock is held for a long period of time. A 
lock hold limit will be issued when it exceeds the specified 
(alertholdlimit) limit. Many conditions can cause a lock to be 
held for a long period of time, such as a client updating a ticket 
(which locks the ticket from the time it is opened until the time 
it is closed). The alert item is the name of the lock.

   Performance-5 = Long running query. A long running query 
limit will be issued when a query exceeds the specified 
(alertquerylimit) limit, or a limit has not been set. The alert is 
the name of the file that is the target of the query. Consider 
creating a key to satisfy the query to avoid performance 
problems in the future when the database grows.

Performance-6 = The hit ratio for a query is a ratio of the 
number of records evaluated versus the number of records 
that are selected. Using a fully keyed query, the hit ratio is 
always 100%, because an index is used to select the records. 
With a partially keyed query, the hit ratio will vary based on 
the number of records that can be selected via the index 
(rather than requiring the record be retrieved and evaluated). 
A low hit ratio indicates that the system has to evaluate a lot of 
records to locate the records that are of interest to the current 
query. A hit ratio of 50% means that ServiceCenter evaluates 
and discards half of the records that have been checked. The 
default value for alerthitratio is 90%.

Alert Category Descriptions
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The first time an alert is detected within the system, it is entered into the log. 
Once the entry is made in the log, the system will keep track of how many 
times an alert has occurred within the last hour and then write a summary to 
the log, indicating the number of times the alert occurred since the last entry. 
See the following example messages in Sample Error Messages on page 292 
that you can expect to see in the alert message log.

Example System Message

Stalled-n

(“n” represents the 
Stalled alert 
number)

   Stalled-1 =  SCD dtqueue is stalled. The number of records 
in the dtqueue is growing in excess of the specified 
(alertdtqueuelimit) limit.

   Stalled-2 =  SQL sqlqueue is stalled. The number of records 
in the sqlqueue is growing in excess of the specified 
(alertsqlqueuelimit) limit.

   Stalled-3 =  IR irqueue is stalled. The number of records in 
the irqueue is growing in excess of the specified 
(alertirqueuelimit) limit.

   Stalled-4 =  SCD dtqueue is stopped. The first record in the 
dtqueue is not changing.

   Stalled-5 =  SQL sqlqueue is stopped. The first record in the 
sqlqueue is not changing.

   Stalled-6 =  IR irqueue is stopped. The first record in the 
irqueue is not changing.

An example message for the hit ratio of a query: 
1976 01/22/01 10:33:18 Performance-6-application, Hit Ratio 
not achieved on file application and query (comments>”M”): 
Of 47179 records checked, 44643 did not match the 
query;user(FALCON), application(display),panel (show.rio)

Alert Category Descriptions
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Sample Error Messages

Message Log Switch

The log switch feature allows users to have the ServiceCenter log written to a 
new file on a scheduled basis. Switching the files will prevent any one log file 
from becoming too large to work with and allow archiving or deleting of old 
portions of the log. This is particularly useful for customers who run 24x7, 
and do not have downtime to make backups of the log and clear it. If you do 
not set up the log switch options, the log will not switch, but will just keep 
growing.

To invoke the log switch option, you must enter numberoflogfiles:n in sc.ini, 
where n = number of log files. See Log Switch Parameter Definitions on page 296 
for more information.

1496 02/21/2001 13:57:17 Performance-4-dbdict, Held resource (dbdict) 
for 150 milliseconds; user(N/A), application(Unknown), 
panel(Unknown)

2272 02/21/2001 14:02:48 Performance-5-scmessage, Query 
(syslanguage=”en” and class=”scgui”) took 130 milliseconds to complete; 
user(N/A), application(login), panel(prompt.for.password)

2272 02/21/2001 14:02:55 Performance-4-code, Held resource (code) for 
140 milliseconds; user(FALCON), 
application(ocml.setup.environment), panel(build.admin)

2272 02/21/2001 14:02:56 Performance-1-erddef, Full File Scan for query 
(distributed=true); user(FALCON), application(syslog.add), 
panel(add.syslog)

2272 02/21/2001 14:02:57 Performance-5-mail, Query 
(user.to=”FALCON” or user.to=”broadcast”) and status=”sent” and 
date.to.send<= ‘01/21/2001 14:02:56’) took 711 milliseconds to 
complete; user(FALCON), application(mail.check), panel(select.mail)
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The Log switch feature has two options:

maximum log size

log switch interval

You can set the maximum log size by entering maxlogsize:n in sc.ini, where n 

= maximum log size in bytes. See Log Switch Parameter Definitions on 
page 296 for more information.

You can set the log switch interval in the SC schedule file. 

To set the log switch interval:

1 In the system administrator home menu, select the Toolkit tab.

2 Click Database Manager.

3 Enter schedule in the Form field of the Database Manager dialog box.

4 Press Enter or Search.

5 Select schedule from the QBE list.
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A blank Schedule File record is displayed (Figure 7-1 on page 294).

Figure 7-1: Schedule File

6 Enter Log Switch in the Name box.

7 Click Search.
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The log switch record (Figure 7-2 on page 295) will appear with some data 
filled in.

Figure 7-2: Log Switch

8 Change the expiration date to when you want to start the log switch. 
(mm/dd/yy hh:mm:ss)

9 Enter the frequency at which the log should be switched in the Repeat 
Interval field. (mm/dd/yy hh:mm:ss)

Note: The other fields in the schedule record do not apply to the log switch, 
or should not be changed.

10 Click Save and exit.
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Log Switch Parameter Definitions

Parameter Definition

numberoflogfiles:n Mandatory. n = number of log files, Minimum =1, 
Maximum =7. When the log reaches the maxlogsize, or 
when the log switch interval has been reached, the active 
log will be renamed log 1, and a new empty log will be 
started. The next time the active log reaches the maxlogsize, 
or when the log switch interval has been reached, the active 
log will be renamed log 2, and so on, until the log number 
has equaled n. At that point the active log will be renamed 
log 1 again. And so on. This parameter is set in sc.ini.

Note: You must set this parameter on the server.

maxlogsize:n Optional. n = maximum log size in bytes, default size = 
5000. A new log will be created when the current one 
reaches this size, no matter what the log switch interval is. 
This parameter is set in sc.ini. This parameter will have no 
effect unless the numberoflogfiles parameter is displayed in 
sc.ini.

Note: You must set this parameter on the server.

log switch interval Optional. A new log will be created after this interval, no 
matter what the current log size is. This parameter is set in 
the ServiceCenter Schedule file. This option is not active 
unless the numberoflogfiles parameter is displayed in 
sc.ini.
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8
 Mandanten Database Protection
Overview

ServiceCenter’s Mandanten feature protects records of multiple clients by 
logically separating a shared database. Clients see only the data they are 
allowed to share. Further discrimination of rights can be applied within client 
groups, allowing system administrators to conceal department records 
selectively within an organization. For example, finance department records 
may still be accessed by the finance group but not by the marketing group.

Unlike Format Control, which provides security at the application layer, the 
Mandanten feature operates at the database layer. Restrictions on data are 
invisible to the applications, and protection is achieved without regard to the 
application design.
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As you go through this chapter, you will learn how to:

Define Security Groups and determine names in the Operator record.

Define Mandanten values in the Database Manager.

Sequence the range of values that can be excluded.

Define the file and Mandant field.

Create virtual join fields.

Create a Mandant field.

Create a restricting query.

Create a shared Mandanten.

Activate the Mandanten Protection feature.

Construct a query, using an index.

How Mandanten Protection Works
The Mandanten feature allows a system administrator to establish lists of 
field values (of type character) for disparate customers using the same database. 
These values are assigned to Security Groups named in an operator record and 
then associated with a Mandant field in a ServiceCenter file that is to be 
protected. 

When a user logs on to ServiceCenter, the system establishes an access list of 
values at the database layer. Only those records containing defined Mandant 
Field values can be viewed by the user.

Excluded Files

Warning: 1. Do not attempt to protect fields in an operator record; the 
named user will be unable to log on to ServiceCenter.

2. Do not attempt to apply Mandanten protection to the following 
system files: formatctrl, format, link, code, tzfile, menu, 
environment, and dbdict.
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Mandanten Structure

Mandanten protection is managed by four elements in the database:

Security Groups array

scsecurity file

scmandant file

scaccess file

Security Groups
Access to protected fields—those fields whose values are protected—is 
controlled from a tab in the Operator record called Security Groups. Groups 
named here determine which Mandanten values are available to the user. 
Shared ownership of records can be defined by naming several Security 
Groups for a single operator.

The scsecurity File
Lists of values are defined in the scsecuritygroup file and associated with the 
name of a Security Group. You may create lists of included values and those 
values (usually hierarchical) you want to exclude. 

The scmandant File
Specific files are marked for Mandanten protection in the scmandant file. 
The Mandant (protected) field for that file is defined here as well. You may 
also create a virtual join with the same field in a second file if the data for your 
Mandant field is contained in that second file. 

The scaccess File
The scaccess file allows you to format Mandanten values as restricting 
queries allowing for a deeper layer of protection within a Security Group. For 
example, a user might see only those incident tickets he or she owns that are 
in Alert Stage 3.
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Mandanten Workflow

The Mandanten files (scsecurity, scmandant, and scaccess) create a Mandanten 
filter. When a user who is a member of a Security Group queries the database, 
the system uses this filter to extract the appropriate data subset from the 
database and return it to the user.

Figure 8-1: Mandanten workflow

Protecting a File

Mandanten protection works on any file in ServiceCenter; however, certain 
files make more sense to protect than others. For example, device records and 
incident tickets might require increased security on a system where different 
organizations share the same database.

Mandanten
Protected File

End UserMandanten
Filter

Data Subset

scaccess
File

scmandant
File

scsecuritygroup
File

Operator
Record

Security
Groups

User Query

Modified Query
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A system administrator may select an existing field to protect or may create 
a specific Mandant field for the purposes of protecting client files. Shared 
ownership may be desirable, particularly when assigning rights to system 
administrators.

To establish Mandanten protection for a file, perform the following 
procedures:

1 Pick an appropriate field to use to protect client data. You may select an 
existing field or create one specifically for that purpose. The field must be of 
the data type character.

2 Name your Security Groups in the Operator record.

3 Define Mandanten values in the scsecurity file.

4 Name the file to be protected and the Mandant field using the scmandant file.

5 Create any restricting queries for the values listed using the scaccess file.

Selecting a Field
As one possible example, you might choose to protect the Location field in 
the device file. The value in this field reflects the physical location of 
equipment, typically in the same location as a related client or department. 
To discriminate the level of protection further, the Network Name field 
could be used to define a restricting query. When the user queries the 
database for device file records, only those devices from a prescribed location 
and network are presented.

Defining Security Groups
Determine names for your Security Groups in the Operator record. Use 
meaningful names that a system administrator responsible for managing a 
shared database can recognize. For example, if you have chosen to protect the 
Location field in the device file, you may want to create Security Groups that 
reflects your client’s physical location (for example, Atlanta, Dallas, and so 
on), or simply use a company name.

To name Security Groups:

1 In the system administrator’s home menu, click the Utilities tab.

2 Click Administration.

The Administration menu is displayed.
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3 Click Operators.

A blank operator record form is displayed.

4 Click Search or press Enter.

5 Select an operator or template from the record list displayed (Figure 8-2 on 
page 302).

Figure 8-2: QBE list of operators
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6 Select the Security Groups tab in the operator record form (Figure 8-3 on 
page 303).

Figure 8-3: Security Groups in the operator record

7 Enter the name of the Security Group(s) in which that user is a member.

In this example, BOB.HELPDESK is a member of a Security Group called 
Headquarters.

Note: You may enter an array of groups in this field if the user has the right 
to share records from other Security Groups.

8 Click Save.

A message appears saying Operator record updated.
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Defining Mandanten Values
Mandanten values are defined in the scsecurity file. You may list as many 
values as you wish. The system returns only those records whose Mandant 
field values match the entries in the Included Values field of this record.

To gain access to the Mandanten tab through the Central Administration 
Utilities:

If you are familiar with the Central Administration Utilities, you may access 
the Mandanten tab through use of these utilities. For more information on 
accessing and using the Central Administration Utilities, please refer to User 
Access and Security Control on page 131 and see the discussion about Central 
Administration Utilities on page 142.

To define the Mandanten values:

1 In the system administrator’s home menu, click the Toolkit tab.

2 Click Database Manager.

3 Enter scsecurity in the Form field of the Database Manager dialog box 
(Figure 8-4 on page 304).

Figure 8-4: Database Manager dialog box
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4 Click Search or press Enter.

A blank Security Group record is displayed.

5 Enter the name of your Security Group in the Security ID field (for example, 
Headquarters).

6 Enter all field values in the records to be displayed to the user in the Include 
Value List.

In this example, we want to display only the records for devices belonging to 
PRGN.

Note: These are case-sensitive values. Be sure the case of the value in the 
scsecurity file matches that of the value in the device records.

7 Enter values you want to exclude in the Exclude Value List.

This field is used when the Mandanten values have a hierarchical structure 
with broad values. A certain sequence within the range of values can be 
excluded, as in the case of a large organization using location codes as 
Mandanten values.

Figure 8-5: Mandant Field values defined in a security group record

8 Click Add to add the record to the database.

The following message displays in the status bar: scsecuritygroup record added.
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Wild Cards 
You can use an asterisk (*) as a wild card to define the entire range of a value 
list (Figure 8-6 on page 307). If a large organization has several major 
divisions, records for all divisions can be included by entering a single value 
delimited by an asterisk. 

For example, let us suppose that an organization has four principal divisions. 
The wild card searches for these values in the Mandant Field Name field:

PRGN A

PRGN B

PRGN C

PRGN D

As system administrator, you can make the records for all the PRGN 
divisions available to the Headquarters security group by entering PRGN* in 
the Include Value List. 
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Perhaps the PRGN C division is the financial unit of the organization, and 
their records need to be protected from access by the other three divisions. In 
this case, simply enter PRGN C in the Exclude Value List to make the financial 
records inaccessible to the Headquarters security group.

Figure 8-6: Value Range defined with a wild card

To make the PRGN C records visible to the financial division, create an 
scsecurity record that defines a new security group (for example, Financial) 
with PRGN C entered in the Include ValueList.

Defining the File and Mandant Field
Name the file you want to protect and name a Mandant field in the 
scmandant file (Figure 8-7 on page 309). Only one Mandant field can be 
associated with a file. You must use the linking feature in the scmandant file 
if the data for your Mandant field is contained in a file other than the file you 
are protecting (for example, a file virtually joined to another).
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Virtual Join Fields

Creating Records
To gain access to the Mandanten tab through the Central Administration 
Utilities:

If you are familiar with the Central Administration Utilities, you may access 
the Mandanten tab through use of these utilities. For more information on 
accessing and using the Central Administration Utilities, please refer to User 
Access and Security Control on page 131 and see the discussion about Central 
Administration Utilities on page 142.

To create a Mandant field:

1 In the system administrator’s home menu, click the Toolkit tab.

2 Click Database Manager.

3 Enter scmandant in the Form field of the Database Manager dialog box.

4 Click Search or press Enter.

A blank Mandant field record is displayed.

5 Enter the name of the file you want to protect in the File Name field.

Field Description

Linkage Field 
Name

Name of the Mandant field that you want to link to a second file.

Source File Name Virtually joined source file in which the data for your Mandant 
field is stored.

Source Field 
Name

Name of the field in the source file containing the specified 
Mandanten values.

Exclude Field Record by record exclusion list that is rarely used. This field uses 
the same criteria as the Exclude Values List in the scsecurity file.
308 Chapter 8—Mandanten Database Protection 



System Administrator’s Guide, Volume 1
In this example, we want to protect the device file.

Figure 8-7: Mandant Field record

6 Enter the name of the Mandant field in the Mandant Field Name field.

In this example, we have selected company as our Mandant field.

Note: The value in this field needs to match the type of data in the Include or 
Exclude Value lists.

7 Click Add to add the record to the database.

The following message is displayed in the status bar: scmandant record added.

Creating a Restricting Query
The scaccess file allows you to format Mandanten values as a restricting 
query (Figure 8-8 on page 310). For example, you can write a query to restrict 
a user’s access to records for those devices he owns that are part of a specific 
network and no others.

Note: This is an optional layer of security. It is used in addition to the normal 
Mandanten field protection.
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To create a restricting query:

1 In the system administrator’s home menu, click the Toolkit tab.

2 Click Database Manager.

3 Enter scaccess in the Form field of the Database Manager dialog box.

4 Click Search or press Enter.

A restricting query record is displayed.

5 Enter the name of the file you want to protect in the File Name field.

In this example, we are protecting the device file.

Figure 8-8: Restricting Query record

6 Enter the name of the Security Group associated with the file being protected 
in the Security Group ID field.

In this example, our Security Group is Headquarters. This is the name of a 
Security Group you named in the operator record.

7 Create a query in the Restricting Query field to select specific kinds of 
records belonging to the user.

In this example, the query network.name=“PeregrineMain” allows a user to see 
only those devices in the main Peregrine network.

8 Click Add to add the record to the database.

The following message is displayed in the status bar: scaccess record added.
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Shared Mandanten
In the most common usage of the Mandanten feature, individual records in 
a segmented database are owned by particular clients. There are, however, 
cases when a record is shared within a segmented database between the 
clients. An example might be the Incident Management categories or 
assignment lists. More than one client may want a hardware category. Rather 
than defining categories of hardware-A and hardware-B, it is possible to define 
a single category of hardware and to indicate that client A and client B share 
the category. This is accomplished by defining an array within the file that 
lists the clients that can share the record. Any user who has at least one value 
in their access list that matches one of the values in the array will be given 
access to the record.

Quite often Mandanten values have an internal hierarchy—for example:

Peregrine-East

Peregrine-West

Peregrine-West-Development

Peregrine-West-Financial

Peregrine-West-Sales

Peregrine-North

To ease the maintenance of the Mandanten access lists, it is possible to use a 
wild card character (*) in the Mandanten values. A user could be given access 
to all Peregrine records with a single entry of Peregrine*. To make the 
wildcard usable, however, there must be a list to which a user is denied access. 
Therefore, if users should have access to all Peregrine data except Peregrine 
Financial data, the access list would contain Peregrine*, and the denied list 
would contain Peregrine-West-F*.

The wildcards ease maintenance; however, when the shared Mandanten 
feature is used against a large database and the user query being made does 
little to exclude the number of records that apply, there can be a performance 
problem. This occurs because each record must be selected and analyzed to 
see if the include/exclude arrays within the record match the array of include 
and exclude values that are defined for the user. Because this analysis is going 
against four arrays and any of these arrays may contain the wildcard 
character, it is not possible to modify the original query such that an index 
can be used to select the records (as is done with standard Mandanten 
queries).
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Initialization Parameter
The shared Mandanten feature is activated by adding the parameter 
sharedmandantquery to the server initialization (sc.ini) file. ServiceCenter 
server processes check for the sharedmandantquery parameter, and if it is 
present, the query entered by the user will be modified to contain the 
Mandanten filter specifications.

Constructing the Query
If we are told that wildcard characters are not used, a query can be 
constructed which uses an index. Therefore, sharedmandantquery tells the 
system to modify the query when going against shared Mandanten files in the 
same way we modify the queries when going against standard Mandanten 
files. With a modified query, the search engine (P4 or SQL) will be able to use 
an index to satisfy the query.

Using the internal hierarchy list shown earlier, an example of a modified 
query would be one with the appended phrase:

<user query> And mandant.file isin {"Peregrine-East", 
"Peregrine-West","Peregrine-West-Development", "Peregrine-West-Financial", 
"Peregrine-West-Sales", "Peregrine-North"}

The modified search allows the search engine to find the records that qualify, 
as long as the Mandant field is defined as part of the key. For SQL, the 
Mandant field array must be mapped as a multi-row array, which happens 
automatically for any key field. 
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A
 Command Line Prompt Calls
This appendix provides lists of both generic and direct prompt calls that you 
can enter from the ServiceCenter command line, including the RAD 
application that each command calls and each command’s function.

Generic Prompt Calls

Command RAD Application 
Called

Function

*a<application 
name>

as specified Runs the specified RAD routine.

Example: *adatabase accesses 
Database Manager.

*f<file name> database Accesses a specified file.

Example: *fcontacts accesses the 
contacts file.

*m<menu name> menu.manager Changes to a specific menu.

Example: *mCM3 accesses the 
Change Management menu.

*q<query name> query.stored Runs a stored query.

Example: *qcm3r.user.all accesses a 
list of your change requests.
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Direct Prompt Calls

*s<script name> script.execute Runs the specified script.

Example: *socmq.open.hr.quote 
opens an HR Request ticket.

#<shortcut name> non-applicable Queries for a list of shortcut 
commands.

Example: #do brings up a list of all 
commands that start with “do.”

Command RAD Application 
Called

Function

Command RAD Application Called Function

about bulletin.key Displays the system bulletin and 
any active “hot” incidents.

admin menu.manager Displays the text-based System 
Administrator menu.

ag encl.appl Displays the RAD Editor prompt 
(formerly known as Application 
Generator).

agcompare compare.applications Displays the RAD Application 
Comparison form.

agentrev query.stored Executes the “agentrev” query 
which displays a list of the schedule 
records for all SCAuto agents.

agentstat scauto.check.setup Displays a form allowing for 
options to ststop 
currently-available SCAuto agents.

agmap agmap.sched Displays the Application Mapping 
form.

agr report.exerciser Executes the “OPEN PROBLEM 
ANALYSIS REPORTS - 
ASSIGNMENT GROUP” report 
via Report Exerciser.

alert database Displays the Alert Definition form.
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alertdefs se.search.engine Displays the Alert Definition form.

alertlogs se.search.engine Displays the Alert Log form.

am menu.manager Displays the text-based 
Administration menu.

appr database Displays the Approval Definition 
form.

approvaldefs se.search.engine Displays the Approval Definition 
form.

approvallogs se.search.engine Displays the Approval Log form.

asgnlist report.exerciser Executes the “assignment group 
listing” report via Report 
Exerciser.

asr report.exerciser Executes the “ALERT STATUS 
REPORT” report via Report 
Exerciser.

assign problem.management Displays the Assignment Groups 
form.

audit menu.manager Displays the text-based Audit 
menu.

auditdelta audit.unload.front Displays the form for unloading an 
Audit Delta.

audithist database Displays the Audit History form.

auditonoff database Displays the Audit Control form.

audlog database Displays the Audit Log form.

audspec database Displays the Audit Specification 
Table form.

autoshut database Displays the Automatic Shutdown 
Information form.

back menu.manager Initiates an action that backs out of 
the current form and displays the 
text-based Main menu.

bm database Displays the form for accessing 
Benchmark field information.

bmconfig database Displays the Benchmark 
Configuration Record form.
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bmparms database Displays the Benchmark 
Parameters form.

bulletin database Displays the System Bulletin form.

caldaily database Displays the Calendar Event 
Add/Edit form.

caldefs menu.manager Displays the text-based Calendar 
menu.

calduty database Displays the Normal Working 
Hours form.

calholiday database Displays the Holiday Names form.

call exercise Displays the Application Exerciser 
form for testing/running a RAD 
application directly.

callqueue sc.setup.manage Displays the Call queue.

category database Displays the Category form for 
Service Management.

catlist report.exerciser Executes the “category listing” 
report via Report Exerciser.

cau menu.manager Displays the Central 
Administration Utilities menu.

cc menu.manager Displays the text-based Service 
Management menu.

chgqueue sc.setup.manage Displays the Change queue.

clavail availability.clear Allows for the clearing of 
availability information.

cls pm.access Displays the Incident queue.

cm3 menu.manager Displays the text-based CM3 Main 
menu.

cm3grp database Displays the Change Management 
Groups Definition form.

cm3maint menu.manager Displays the text-based CM3 
Maintenance menu.

cm3msg database Displays Change Management 
Event Definition form.
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cm3profile database Displays the CM Security Profile 
form.

cm3r se.search.engine Displays the search form for 
Change Management requests.

cm3rcat cm3r.category.maint Displays the Change Management 
Request Category form.

cm3renv se.search.engine Displays the Change Management 
Application Environment form.

cm3ropen cmc.open.from.menu Initiates the script for opening a 
new change request ticket.

cm3rpt1 report.exerciser Executes the “All Requests 
Planned to Start Within the Next 
30 Days” report via Report 
Exerciser.

cm3rpt10 report.exerciser Executes the “Summary Manhour 
and Leadtime Totals by Request 
Group” report via Report 
Exerciser.

cm3rpt2 report.exerciser Executes the “Aging Totals by 
Business Area” report via Report 
Exerciser.

cm3rpt4 report.exerciser Executes the “Summary Manhour 
and Leadtime Totals by Category” 
report via Report Exerciser.

cm3rpt5 report.exerciser Executes the “Summary Manhour 
and Leadtime Totals by 
Assignment Group” report via 
Report Exerciser.

cm3rpt6 report.exerciser Executes the “Summary Manhour 
and Leadtime Totals by Request 
Group” report via Report 
Exerciser.

cm3rpt7 report.exerciser Executes the “Aging Totals by 
Business Area” report via Report 
Exerciser.

cm3rpt8 report.exerciser Executes the “Summary Manhour 
and Leadtime Totals by Category” 
report via Report Exerciser.
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cm3rpt9 report.exerciser Executes the “Summary Manhour 
and Leadtime Totals by 
Assignment Group” report via 
Report Exerciser.

cm3rpts menu.manager Displays the text-based CM3 
Reports menu.

cm3t se.search.engine Displays the search form for 
Change Management tasks.

cm3tcat cm3t.category.maint Displays the Change Management 
Task Category form.

cm3tenv se.search.engine Displays the Change Management 
Application Environment form.

cm3topen cmt.open.from.menu Initiates the script for opening a 
new change task.

cm3upg1 report.exerciser Executes the “Compare and 
Report DBDICT” report via 
Report Exerciser.

cm3upg2 report.exerciser Executes the “Compare and 
Report cm3t DBDICT” report via 
Report Exerciser.

cm3upg5 report.exerciser Executes the “Convert CM2 
Capability Words” report via 
Report Exerciser.

cmcontrol cm.edit.config Displays the Change Management 
Control form.

cmdlist report.exerciser Executes the Menu Command List 
report via Report Exerciser.

cmsla database Displays the Change Management 
SLA form.

commlst report.exerciser Executes the “communications 
listing” report via Report 
Exerciser.

commtype database Displays the Communication 
Type form.

commun database Displays the attribute form for the 
Communications device type.
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comp se.search.engine Displays the System Information 
Definition form (system Company 
record).

compare compare.applications Displays the RAD Application 
Comparison form.

configure sla sla.edit.config Displays the Service Level 
Agreement Control form.

contacts database Displays the Contacts form.

contract menu.manager Displays the text-based Contract 
Management menu.

copyfile copy.database.file Initiates the script for copying a 
database file.

costcntr database Displays the SAP Cost Center 
form.

cpnycode database Displays the Company Codes 
form.

createcat create category Initiates the script for adding an 
Incident Management category.

createschd database Displays the Schedule form.

curalerts se.search.engine Displays a list of the current alerts.

curapprovals se.search.engine Displays a list of the current 
requests awaiting approval.

curconvert database Displays the Currency Rate 
Information form.

currency database Displays the Currency form.

datamap database Displays the Data Map form.

db database Displays the Database Manager 
prompt.

dbdict dbdict.utility database Displays the Database Dictionary 
prompt.

de database Displays the Display Application 
Event Definition form.

delmail database Displays the form for sending 
internal ServiceCenter broadcast 
mail.
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device icm.access Displays the Asset Information 
form.

devloc report.exerciser Executes the “INVENTORY 
LISTING BY LOCATION” report 
via Report Exerciser.

devrpt report.exerciser Executes the “DEVICE LISTING” 
report via Report Exerciser.

devtype icm.create.device Displays the Inventory Device 
Types form.

devvend report.exerciser Executes the “INVENTORY 
LISTING BY VENDOR” report via 
Report Exerciser.

directory report.exerciser Executes the “USER 
DIRECTORY” report via Report 
Exerciser.

dist database Displays the Distribution Group 
form.

dmrpts menu.manager Displays the text-based Doc 
Management Analysis Reports 
menu.

do database Displays the Display Application 
Option Definition form.

doc menu.manager Displays the menu with options 
for maintaining the document 
engine.

drc report.exerciser Executes the “OPEN PROBLEM 
ANALYSIS REPORT - 
CATEGORY” report via Report 
Exerciser.

ds database Displays the Display Application 
Screen Definition form.

dtqueue database Displays the distributed ticketing 
queue form.

dtrace report.exerciser Executes the “Downstream 
Devices” report via Report 
Exerciser.
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dtshad database Displays the distributed ticketing 
shadow form.

edit gkn database Displays the form for editing core 
knowledge.

enduser database Displays the attribute form for the 
Enduser device type.

enduserlst report.exerciser Executes the “enduser listing” 
report via Report Exerciser.

entitle database Displays the Service Entitlement 
form.

erp menu.manager Displays the text-based ERP menu.

err report.exerciser Executes the “EXCESSIVE 
REASSIGNMENT REPORT” 
report via Report Exerciser.

es menu.manager Displays the text-based Event 
Services menu.

esadmin menu.manager Displays the text-based Event 
Services Administration menu.

evemail sca.window Displays the form for sending an 
email event.

eventbld axces.build.maps Initiates the wizard for building 
event mappings.

eventfltr database Displays the Event Filters form.

eventin database Displays the Event Services input 
queue.

eventmap database Displays the Event Map form.

eventout database Displays the Event Services output 
queue.

eventreg database Displays the Event Registration 
form.

evfax sca.window Displays the form for sending a fax 
event.

evicmbld scauto.build.maps Initiates a script for building ICM 
mappings.
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evpage axces.page.window Displays the form for sending a 
paging event.

evwrite sca.window Displays the form for sending an 
incident, inventory, or generic 
event.

exceedcall query.stored Executes the “overcall contracts” 
query which displays a list of all 
service contracts that have 
exceeded their call allocation.

exceedim query.stored Executes the “overproblem 
contracts” query which displays a 
list of all service contracts that have 
exceeded their problem allocation.

expired query.stored Executes the “expired contracts” 
query which displays a list of all 
service contracts that have expired.

expline database Displays the Expense Line 
Information form.

faxinfo database Displays the Fax Configuration 
form.

fc format.ctrl.maint Displays the Format Control form.

fd forms.designer Displays the Forms Designer 
prompt.

fep database Displays the attribute form for the 
Frontend device type.

feplst report.exerciser Executes the “front end processor 
listing” report via Report 
Exerciser.

files database Displays the Configuration File 
form for database unloads.

fixed database Displays the Fixed Function Keys 
for 327x Terminals form.

formatctrl format.ctrl.maint Displays the Format Control form.

formofad database Displays the Form of Address 
form.

forms forms.designer Displays the Forms Designer 
prompt.
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from sql pmc.sql.unfront Initiates the process for bringing 
data from an RDBMS database to 
P4.

gen core ke.gencore.verify Displays the prompt for generating 
the core Knowledge Base.

gl database Displays the global list form.

hardware menu.manager Displays the text-based Hardware 
Configuration menu.

hd pm.access Displays the Incident queue.

help database Displays the Help form.

hfield database Displays the text-based help field 
form.

History query.stored Displays aging results for SLA on 
bar graphs.

Home menu.manager Displays the Main menu.

host database Displays the attribute form for the 
Host device type.

hostdev database Displays the attribute form for the 
Host Devices device type.

hostdevlst report.exerciser Executes the “host peripherals 
listing” report via Report 
Exerciser.

hostlst report.exerciser Executes the “host listing” report 
via Report Exerciser.

hrcontacts erp.request.batch Displays the prompt for importing 
PeopleSoft HR data.

hrimport erp.request.batch Displays the prompt for importing 
PeopleSoft HR data.

hrsupport database Displays the States form.

htopic database Displays the Help form.

icm menu.manager Displays the text-based Inventory 
Management menu.

icmapplenv database Displays the Asset Management 
Application Environment form.
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icmconvert icm.convert.files Displays the link record for 
building inventory records during 
the upgrade process.

icmenv menu.manager Displays the text-based Inventory 
Management menu.

icmgroups database Displays the Inventory 
Management Groups form.

icmprofile database Displays the Inventory Security 
Profile form.

icmreports menu.manager Displays the text-based Inventory 
Management Reports menu.

im menu.manager Displays the text-based Incident 
Management menu.

im admin menu.manager Displays the text-based Incident 
Management Environment menu.

imapplenv database Displays the Incident Management 
Environment form.

imassign database Displays the Assignment Groups 
form.

imbuild pm.build.probsum Initiates the script for the building 
of probsummary records.

imconvert pm.convert.format Displays the Convert Incident 
Format form.

imgroups database Displays the Incident Management 
Groups form.

imm menu.manager Displays the text-based Incident 
Management menu.

improfile database Displays the IM Security Profile 
form.

imreset pm.clear.downtime Allows for the clearing of 
availability information.

inact kill.inactive.setup Displays the Kill Inactive Users 
Setup Parameters form.

incident menu.manager Displays the text-based Incident 
Management menu.

incidentqueue sc.setup.manage Displays the Incident queue.
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info database Displays the Agent Initialization 
Registry form.

inventory menu.manager Displays the text-based Inventory 
Management menu.

invlist database Displays the text-based Inv/Config 
Management Listings menu.

irassg report.exerciser Executes the “Problem Response 
Analysis By Assignment” report 
via Report Exerciser.

ircomp report.exerciser Executes the “Problem Response 
Analysis By Component” report 
via Report Exerciser.

irloc report.exerciser Executes the Problem Response 
Analysis By Location” report via 
Report Exerciser.

irq ir.query.window Displays the form for issuing an IR 
query.

irvend report.exerciser Executes the “Problem Response 
Analysis By Vendor” report via 
Report Exerciser.

jesptrs database Displays the Configuration File 
form for jes.

ke menu.manager Displays the text-based Knowledge 
Engineering menu.

knowledge sc.knowledge Displays the search form for 
Knowledge Base information.

line database Displays the attribute form for the 
Line device type.

linelst report.exerciser Executes the “line listing” report 
via Report Exerciser.

link edit.link Displays the Link form.

linklist report.exerciser Executes the Link File Listing 
report via Report Exerciser.

load transfer apm.upgrade.load.transfer Initiates the ServiceCenter 
Upgrade Utility Load Transfer 
form. 
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loc database Displays the Location form.

location database Displays the Location form.

loclist report.exerciser Executes the “location listing” 
report via Report Exerciser.

loclst report.exerciser Executes the “location listing” 
report via Report Exerciser.

logmsg database Displays the “log” type Message 
Class form.

Logoff menu.manager Logs out of the session completely.

logoff menu.manager Displays the text-based Logoff 
prompt.

Logout menu.manager Displays the Logout prompt.

mailmsg database Displays the “mail” type Message 
Class form.

main menu.manager Displays the text-based Main 
menu.

mcf database Displays the Capability Word 
form.

menu database Displays the Menu form.

message database Displays the Message form.

mmm menu.manager Displays the text-based Main 
menu.

model database Displays the Model form.

modelicm database Displays the ICM Model form.

modelven database Displays the Model Vendor 
Information form.

modlist report.exerciser Executes the “MODEL LISTING” 
report via Report Exerciser.

monitor system.monitor Displays the system status form.

moresa menu.manager Displays the text-based System 

Admin menu (2nd form).

moreutil menu.manager Displays the text-based User 

Utilities menu (2nd form).
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moreutil2 menu.manager Displays the text-based User 

Utilities menu (3rd form).

msg database Displays the generic Message Class 
form.

msgclass menu.manager Displays the text-based Message 
Class menu.

msglog database Displays the Message Log form.

msgtype database Displays the Message Type form.

napainfo query.stored Executes the “napainfo” query 
which displays the record for 
maintaining NAPA information.

new call cc.first Displays a blank call form for 
ticket entry.

new incident apm.first Displays a blank incident form for 
ticket entry.

new prob apm.first Displays a blank incident form for 
ticket entry.

new sla sla.edit.objects Displays the Service Level 
Agreement form.

note database Displays the Notification 
Definition form.

number database Displays the Sequential Number 
form.

ocm menu.manager Displays the text-based Request 
Management Main menu.

ocmbldlvl ocm.co.bld.lvls Displays the prompt for updating 
all of the level numbers for all 
components in the model file.

ocmcatalog menu.manager Displays the text-based Request 
Management Catalog menu.

ocmco database Displays the Request Management 
Component Definitions form.

ocmdeliv report.exerciser Executes the “Delivery Forecast for 
Next 7 Days” report via Report 
Exerciser.
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ocmdreqj report.exerciser Executes the “Daily Quote Log” 
report via Report Exerciser.

ocmdrj report.exerciser Executes the “Daily Receipt 
Journal” report via Report 
Exerciser.

ocmevents database Displays the Request Management 
Events form.

ocmexample menu.manager Displays the text-based Request 
Management Example User menu.

ocmgroups database Displays the Request Management 
Group Definition form.

ocml ocml.access Displays the search form for 
Request Management line items

ocmlcat database Displays the Request Management 
Line Item Category form.

ocmlcreate ocm.category.create Displays the Request Management 
Line Item Category form.

ocmlenv menu.manager Displays the text-based Request 
Management Line Item 
Environment menu.

ocmlenvir query.stored Displays the Request Management 
Line Items Application 
Environment form.

ocmlmast database Displays the Request Management 
Catalog Select Categories form.

ocmlphase database Displays the Request Management 
Line Item Phase form.

ocmlrec database Displays the Request Management 
Receiving Log form.

ocmmain menu.manager Displays the text-based Request 
Management Main menu.

ocmo ocmo.access Displays the search form for 
Request Management orders.

ocmoappr ocmo.access Displays a list of orders that have 
been approved.
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ocmocat database Displays the Request Management 
Order Category form.

ocmocavail database Displays the Request Management 
Check Availability Order 
Generation Schedule Record.

ocmocreate ocm.category.create Displays the Request Management 
Order Category form.

ocmodemand database Displays the Request Management 
Background Order Generation 
Schedule Record form.

ocmoenv menu.manager Displays the text-based Request 
Management Order Environment 
menu.

ocmoenvir query.stored Displays the Request Management 
Orders Application form.

ocmoopen ocmo.access Initiates the script for creating a 
new Request Management order.

ocmophase database Displays the Request Management 
Order Phase form.

ocmphaselg database Displays the Request Management 
Phase Log form.

ocmpo report.exerciser Executes the “Print Purchase 
Orders” report via Report 
Exerciser.

ocmprofile database Displays the Request Management 
Profile form.

ocmq ocmq.access Displays the search form for 
Request Management quotes.

ocmqcat database Displays the Request Management 
Quote Category form.

ocmqcreate ocm.category.create Displays the Request Management 
Quote Category form.

ocmqenv menu.manager Displays the text-based Request 
Management Quote Environment 
menu.
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ocmqenvir query.stored Displays the Request Management 
Quotes Application Environment 
form.

ocmqopen ocmq.access Initiates the script for creating a 
new Request Management quote.

ocmqphase database Displays the Request Management 
Quote Phase form.

ocmrpts menu.manager Displays the text-based Request 
Management Reports menu.

ocmsupport menu.manager Displays the text-based Request 
Management Support Files menu.

ocmvenper report.exerciser Executes the “Vendor 
Performance Based on Line Item 
Dates” report via Report Exerciser.

odr report.exerciser Executes the “OPEN PROBLEM 
ANALYSIS REPORTS - 
DOCUMENT NUMBER” report 
via Report Exerciser.

oncall database Displays the On Call Schedule 
contact form.

oncallsched database Displays the On Call Schedule 
calendar form.

operator database Displays the Operator form.

opn pm.access Displays the Incident queue.

order query.stored Displays a list of the user’s work 
orders.

overspent query.stored Executes the “overspent contracts” 
query which displays a list of all 
service contracts that have 
exceeded their financial budget.

password password.change Displays the prompt for changing 
the login password.

pfkeys database Displays the PF Key Mapping 
form.

pm menu.manager Displays the text-based Problem 
Management menu.
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pm admin menu.manager Displays the text-based Problem 
Management Environment menu.

pmapplenv database Displays the Incident Management 
Environment Profile form.

pmassign database Displays the Assignment Group 
form.

pmbuild pm.build.probsum Displays the form for building 
probsummary records.

pmconvert pm.convert.format Displays the Convert Incident 
Format form.

pmgroups database Displays the Incident Management 
Groups form.

pmprofile database Displays the IM Security Profile 
form.

pmreset pm.clear.downtime Displays the Clear Availability 
Information form.

position database Displays the Titles & Position 
form.

prassg report.exerciser Executes the “Problem Response 
Analysis By Assignment” report 
via Report Exerciser.

prcomp report.exerciser Executes the “Problem Response 
Analysis By Component” report 
via Report Exerciser.

print report.exerciser Executes the “Print of 
Application” report via Report 
Exerciser.

printappl report.exerciser Executes the “Print of 
Application” report via Report 
Exerciser.

prloc report.exerciser Executes the “Problem Response 
Analysis By Location” report via 
Report Exerciser.

problem menu.manager Displays the text-based Problem 
Management menu.

prtmsg database Displays the “print” type Message 
Class form.
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prvend report.exerciser Executes the “Problem Response 
Analysis By Vendor” report via 
Report Exerciser.

ps menu.manager Displays the text-based Peoplesoft 
menu.

psnlarea database Displays the HR Personnel Area 
form.

psnlsuba database Displays the Personnel Subarea 
form.

purgarch pa.main.appl Displays the Purge/Archive form.

purgeaudit audit.purge Displays the form for purging 
audit history.

qsamfiles database Displays the Configuration File 
form for qsam.

quiesce system.quiesce On MVS systems, prevents 
additional users from logging in 
until shutdown has completed.

RAD database Displays the RAD Editor prompt.

rad encl.appl Displays the RAD Editor prompt.

rca menu.manager Displays the Root Cause menu.

re report.exerciser Displays the Report Exerciser 
prompt.

recalc partials sla.recalc.totals Displays the prompt for 
recalculating SLA information 
over a given time frame.

region database Displays the Country Division 
form.

report report.exerciser Displays the Report Exerciser 
prompt.

resetbm benchmark.reset Resets the system Benchmark 
results.

reslist report.exerciser Executes the “resolution code 
listing” report via Report 
Exerciser.

resol database Displays the Resolution Codes 
form.
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review cc cc.setup.manage Displays the Call queue.

review im apm.setup.manage Displays the Incident queue.

review pm sc.setup.manage Displays the Incident queue.

rmail read mail Displays the prompt for selecting 
which type of internal 
ServiceCenter mail to read.

rt menu.manager Displays the text-based Text RT 
menu.

run encl.appl Displays the Application Exerciser 
form for testing/running a RAD 
application directly.

rv pm.access Displays the Incident queue.

rw report.writer Displays the Report Writer 
prompt.

sap menu.manager Displays the text-based SAP menu.

sapconfig query.stored Executes the “sapconfig” query 
which displays the Enterprise 
Connections configuration record.

sarpts menu.manager Displays the text-based System 
Admin Report menu.

sc5upgrade menu.manager Displays the Application Upgrade 
menu.

sc5upgradetext menu.manager Displays the text-based 
Application Upgrade menu.

scd menu.manager Displays the text-based SCD 
(ServiceCenter Distributed) menu.

scdsites database Displays the distributed ticketing 
sites form.

sch database Displays the Schedule File form.

schedule database Displays the Schedule File form.

schmail mail.set.schedule Displays the form for scheduling 
background mail.

scknowledge sc.knowledge Displays the Knowledge Base 
form.
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scm menu.manager Displays the Main menu.

scmsg database Displays the ServiceCenter 
Message form.

scr report.exerciser Executes the “shift change report” 
report via Report Exerciser.

scripts script.maint Displays the Script Definition 
form.

search cal cc.search.incidents Displays the search form for 
Service Management calls.

search calls cc.search.incidents Displays the search form for 
Service Management calls.

search incident apm.search.problems Displays the search form for 
Incident Management incidents.

search prob apm.search.problems Displays the search form for 
Incident Management incidents.

search sla sla.search.objects Displays the search form for 
Service Level Agreements.

servcont database Displays the Service Contract 
form.

shadow pmc.sql.front Initiates the process for shadowing 
data between SQL and P4.

shutdown system.shutdown Initiates the process for shutting 
down the ServiceCenter server.

SLA sla.graph Displays the current SLA response 
metrics bar chart.

sla menu.manager Displays the text-based SLA menu.

sm menu.manager Displays the text-based Service 
Management menu.

sm admin menu.manager Displays the text-based Service 
Management Environment menu.

smail mail.send.appl Displays the prompt for 
confirming the sending of internal 
ServiceCenter mail.

smapplenv database Displays the Service Management 
Environment form.
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smgroups database Displays the Service Management 
Groups form.

smprofile database Displays the Service Management 
Security Profile form.

softlist report.exerciser Executes the “software product 
listing” report via Report 
Exerciser.

software database Displays the Installed Software 
form.

sol cans se.search.engine Displays the Pending Knowledge 
Items form.

spool spool.scheduler Displays the Spoolheader form.

sq database Displays the Stored Query 
Maintenance form.

sql menu.manager Displays the text-based SQL menu.

start apm.upgrade.main Initiates the Upgrade Utility 
wizard.

startbm benchmark.start Displays the Benchmark Utility 
form.

status system.status Displays the system status form.

stdptrs database Displays the Configuration File 
form for standard printers.

subtotals database Displays the Subtotal Definition 
form.

sw database Displays the attribute form for the 
Software device type.

swlst report.exerciser Executes the “software product 
listing” report via Report 
Exerciser.

sysadm2 menu.manager Displays the text-based System 
Admin Menu II menu.

sysadmin menu.manager Displays the text-based System 
Administrator menu.

syslog database Displays the System Log form.
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task query.stored Displays a list of the user’s change 
tasks.

terminals database Displays the Terminal 
Configuration form.

termtype database Displays the Terminal Type 
Definition form.

titles database Displays the Aristocratic Titles 
form.

to sql pmc.sql.front Initiates the process for pushing P4 
data to an RDBMS database.

tpdev database Displays the attribute form for the 
Teleprocessing device type.

tplst report.exerciser Executes the “tp devices listing” 
report via Report Exerciser.

triggers database Displays the triggers form.

tskqueue sc.setup.manage Displays the Task queue.

tsomsg database Displays the “tso” type Message 
Class form.

unload us.unload Displays a list of unload scripts.

unshadow pmc.sql.unfront Initiates the process for turning off 
the shadowing of data between 
SQL and P4.

uoperprof query.stored Displays the Operator Status 
Display form.

upd pm.access Displays the Incident queue.

userlevel us.userlevel Displays the current user access 
level and the options for changing 
this access.

userstats report.userstats Displays the prompt for executing 
the Usage Statistics report.

userutil menu.manager Displays the text-based User 

Utilities menu (1st form).

usrcmr cm3r.main Displays a list of the current 
Change Management request 
categories.
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usrdir database Displays the Contacts form.

usricm icm.access Displays the Asset Information 
form.

usrknow database Displays the search form for 
Knowledge Base information.

usrocma ocmo.access Displays a list of the current 
Request Management orders.

usrocmo ocmo.access Displays the search form for 
Request Management orders.

usrprof menu.manager Displays the text-based Profiles 
menu.

validity se.search.engine Displays the Validity Table 
Specifications form.

vend database Displays the 
Vendor/Manufacturer form.

vendlist report.exerciser Executes the “vendor listing” 
report via Report Exerciser.

vendor database Displays the 
Vendor/Manufacturer form.

venlist report.exerciser Executes the “vendor listing” 
report via Report Exerciser.

viewbm benchmark.avg.results Displays the Benchmark Results.

vsaminfo query.stored Executes the “vsaminfo” query 
which displays the record for 
maintaining VSAM information.
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A
Active Notes 267
active users listed 67
adding

users 146–183
example 164–167

alert periodic schedule 284
alerts

alertcpulimit 286
alertdtqueuelimit 286
alertfilters 287
alertholdlimit 287
alertirqueuelimit 287
alertlog 287
alertquerylimit 288
alertsqlqueuelimit 288
alertvirtuallimit 288
alertwaitlimit 288
categories 288–291

limits 289
mapping 289
performance 290
stalled 291

defining 284, 285–288
system 284, 285–288

applications
profiles 150

arrays
expanding 213

assignment groups
defining for users 157
editing 219
Incident Management 220

attachments
contact record 91

authorization code
named users 186

B
background processes 50
background schedulers

inactivity timer 267–268
background tasks 50
broadcasting messages 55

C
capability file 173–174
capability words 169–173

menu record 183
categories

alerts 288–291
Central Administration Utilities (CAU)

adding user data 216
Change Management

message groups 226
profiles 215, 225
request environment 226
task environment 225
Index  339



ServiceCenter
Contract Management
environment 224
profiles 224

editing message groups 218, 219
editing user profiles 216
Incident Management

assignment groups 220
editing profile assignment groups 218,

219
environment 220
profiles 220

Inventory Management
environment 223
profiles 223

Mandanten protection 228
profiles status 215
quick add user data 219
Request Management

line item environment 227
order environment 227
profiles 216, 226, 227
quote environment 227

Root Cause Analysis
environment profile 222
profiles 222

searching contact information 144
searching for operators 144
searching user inbox listings 144
searching user roles 144
Service Management

environment 221
profiles 221

user and contact utilities 144
user data, viewing and editing 144
user quick add utility 144

Change Management
accessing 41
changes

attaching a file 70–72
enhanced print routines 232
message groups 226
profiles 225
query groups 160
request environment 226
task environment 225

client
printing

header format 162
lines per page 162, 231
page width 162, 231

system administrator menu 39–47
main application modules 41
support files 41
system buttons 41
system tray buttons 45
toolkit 45
utilities 42

client/server
platforms available 19

clocks 251–266
accessing 266
defined 255
fields 253
starting and stopping

by editor tracking 261
by Format Control 262–265
by RAD 265
by status changes 257–261

command line 40, 159
command line prompt calls

direct 314–337
generic 313–314

command list 66
company file 118

accessing 41
fields 119

company record 196–228
accessing 196–197
configuring to launch Network Discovery 47
date format 271

default, setting 272–274
individual operators 274–276

fields 197–201, 211, 212
OLE attachment size limit 73, 211
password

composition rules 203–205
expiration interval 199–200
history 203
resetting 202
time limit of 206–207
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print routines (pre-A9802) 209, 213, 233
time zone

creating records 280
default, setting 272–274
GMT offsets 281
individual operators 274–276
internal calculations 271
modifying records 281–282

tzfile maintenance 276–280
configuration file (sc.cfg)

printer record 241–245
console

starting the ServiceCenter server 21
stopping the ServiceCenter server 25

contact record
addresses 88
attachments 91
comments 91
contact numbers 89

contacts file 84–91
accessing 41
portraits 92–94
tabs and fields 86–94

Contract Management
access from home menu 41
contract attachments 70–72
environment 224
profiles 224

control panel
starting the ServiceCenter server 22
stopping the ServiceCenter server 26

creating
hot news entry 77

curconvert file
accessing 41

currency file
accessing 41

D
data

sample 12
database

Mandanten protection 297
Database Dictionary

accessing 45

Database Manager
accessing 45

date format 149, 271
default, setting 272–274
individual operators 274–276

DDE 129, 214
dept file 121–126

accessing 41
deleting an org chart 126
fields 122–124
inserting an org chart 124

device records
attaching documents 70–72

distribution 42
DOS command prompt

starting the ServiceCenter server 24
stopping the ServiceCenter server 27

E
editing

multiple member profiles 217
education services 14
errors

descriptions 288–291
performance issues to be recorded 288–291

events
system monitored 283

Excel
exporting to 214

Excel, exporting to 129
exporting 110, 127

F
fields

company file 119
company record 197–201, 211, 212
contact record 86–91
dept file 122–124
location file 96–97
model file 102–106
vendor file 114–116
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file management 82–84
accessing records 82
creating records 83
deleting records 84
updating records 83

files
Mandanten protection 297
size limits for OLE attachments 73
support 81

find function
search for data 75

floor plan
adding an image 98
deleting an image 100

Format Control
clocks, starting and stopping 262–265
setting pre-A9802 print routines 235

Forms Designer
accessing 45
creating startup menus 174–178
OLE attachment size limit 73
properties 176
tool palette 175
wizard 175

G
GMT

Time Change Definitions 279
time zones 272, 279, 281

H
header format 162
hot news entry

creating 77

I
idle users listed 67
inactivity timer 267–269

deleting a schedule record 269
resetting 269
starting 267–268
stopping 269

Incident Management
accessing 41
assignment groups 220
enhanced print routines 231
environment 220
profiles 220

incident tickets
attaching a file 70–72

information
distribution 42
print queue 42
run report 42
system bulltetin 42

initialization (sc.ini) file
named users 187, 188
switching display modes 18

interface
enhancement 16–19

Inventory Management
access from home menu 41
enhanced print routines 232
environment 223
profiles 223

IR Query 110, 126, 127

J
JES configuration file 245–250

accessing from command line 245
accessing from maintenance menu 245

L
LDAP

operator record 153
licenses

viewing 187
lines per page 162, 231
List Options menu 128
location file 95–100

accessing 41
fields 96–97
floor plan 97–100

locking
user logins 154–155
viewing locked processed 56
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lockout
history 152–153
setting for users 198

log files
alerts 288–291
events 283
system errors 288–291

logging on
locks for users, establishing 154–155
login information 152–153
number of sessions allowed 198
profile in operator record 156–157
restricting during maintenance 192, 193–194
sessions permitted 154

M
Macintosh

Ole container 92
Mandanten

Central Administration Utilities
field restrictions 228
security groups 228

creating records 308
defining a file 307
defining Mandant field 307
defining values 304–307

wild cards 306
definition 298
exclude value 305
excluded files 298
include value 305
Mandant field 298, 301
procedures for protecting a file 301
protect database files 297
restricting queries 309–310
scaccess file 299
scmandant file 299
scsecurity file 299
security groups 162, 299, 301–303
shared 311–312

constructing a query 312
initialization parameter 312

virtual join fields 308
workflow 300

MDI mode 16–19
switching modes

client shortcut 18
sc.ini file 18

menus
capability words 183
creating records 178–183
maintenance 42

message groups
Change Management 226
editing 219

message log 288–291
messages

broadcasting to all users 55
model file 100–112

accessing 41
deleting records 110–112
fields 102–106
Options menu 110

monitor
system events 283

multi-company mode 119, 120, 212

N
named users 157, 186–189

creating name file 188
determining number of licenses 187
editing sc.ini file 188

Network Discovery
launching from ServiceCenter 45
setting up in company record 47

O
OLE containers 69, 91

attaching documents
drag-dropping 71
insert command 70–71

creating new documents 70
defining attachment size 156, 211
deleting documents 72
moving files between records 72
size limits 73
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operator record 147–167
capability file, accessing 173
capability words 158–160
initial application 159
LDAP

directory structure, defining 153
lockouts, establishing 154–155
login information 152–153
login profile 156–157
OLE attachment size limit 73, 156
password

expiration of 151, 154
history 155
setting 151

printing options 161
query groups 160
security groups 162
security, controlling 150–155
templates 153, 184–186

Options menu
model file 110
support files

active record 127
blank record 126

org chart
deleting 126
inserting 124

OS/2
Ole container 92

OS/390
server

starting 28
starting and stopping 29

P
page width 162, 231
parameters

server control options
Active Notes 36
Attachments 36
dock tray 36
Help on field 36
Key numbers bar 35
Print 36
Prompt for save 36

Record list 36
Status bar 35
Tall tray 35
Tool bar 35
Tray captions 35

server controls, setting 35–38
password

changing 190–191
composition rules 203–205
expiration 151, 154, 199–200
history 155, 203
requirements for 205
resetting 202
time limit of 206–207

PMStatus fields 259
portraits

adding an image 92
contacts file 92–94
deleting an image 94

print queue 42
printing

background in Windows NT
under user ID 239–241

client 231
header format 162
lines per page 162
page width 162

configuration file 243
fields 244
printer record 241–245

default lines per page 231
default page width 231
enhanced routines

advantages 230
Change Management 232
database 231
Incident Management 231
Inventory Management 232
overview 229
Service Management 232
SLA Management 232

JES (main frame)
configuration file 245–250
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pre-A9802 routines 209, 213
enabling 233–237
setting in company record 233–234
setting with Format Control 235–237

printer selection 161
routines 230
server 231
setup 238–250

process
killing 68

processes
system status 67

processors 50
profiles 150

Change Management 225
Contract Management 224
editing

member list 217
Incident Management 220
Inventory Management 223
removing users and related information 217
Request Management 226, 227
Root Cause Analysis 222
Service Management 221

Q
QBE list

editing columns 129
queries

query groups 160
restricting 309–310
time limits 150

quiesce
see also, system quiesce

R
RAD

accessing RAD development 45
starting and stopping clocks 265

record list
automatic refresh 77
editing columns 129

refreshing
record list 77

Request Management
access from home menu 41
line item environment 227
order environment 227
quote environment 227

restricting
logins 192, 193–194
queries 309–310

Root Cause Analysis
environment profile 222
profiles 222

run report 42

S
sc.ini file

MDI/SDI modes 18
named users 188
server control parameters 37
system alerts, setting 285–288

scaccess file 299
schedule records

system alerts 284
schedulers 50

inactivity timer 267–268
starting background processes 53

scmandant file 299
scsecurity file 299
SDI mode 16–19

switching modes
client shortcut 18
sc.ini file 18

searching
for data

find capability 75
security 150–155
security groups 162, 299

defining 301–303
server

installation
overview 20

parameters
control 35–38

printing 231
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shutting down
OS/390 29

starting 20
OS/390 28
Unix 27
Windows NT 21–24

stopping 20
OS/390 29
Unix 28
Windows NT 25–27

Service Management
accessing 41
call reports

attaching documents 70–72
enhanced print routines 232
environment record 221
profiles 221

ServiceCenter
applications defined 11
knowledge requirements 10
licenses 187
overview 11
platforms 19

shared Mandanten, See Mandanten
shared memory

allocation of 63
shutdown

server
delayed 31
immediate 30–31
scheduled 33–35

sign on
single sign-on 195

single sign-on 195
SLA (Service Level Agreement) Management

access from home menu 41
enhanced print routines 232

startup menu
creating in Forms Designer 174–178

support files 81

system
alerts, setting 285–288
buttons 41
error descriptions 288–291
maintenance

restricting logins during 192
performance issues to be recorded 288–291

system administrator’s home menu
accessing 42

system bulletin 42
system monitor 58–64

capturing information (snapshots) 64
CPU Info 61
Grand Total 60
SC Info 62
Shared Memory Info 63

system quiesce
applying 193–194
general effects 192
levels of restriction 192
overview 192

system status 47–69
accessing

command line 48
menu button 49

active schedulers 67
column headings 52
feature buttons 53–69

broadcast 55
command list 66
display options 56
execute commands 68
refresh display 53
show locks 56
start scheduler 53
summary 67
system monitor 58–64

processes, displayed 67
System Wide Company Record

See company record

T
templates

operator record 153, 184–186
threading 16, 182
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time zone
accuracy 272, 277
company record 208, 209
creating records 280
date formats 271
default 271
default, setting 272–274
GMT offsets 281
individual operators 274–276
internal calculations 271
modifying records 281–282
operator record 149

tools menu
accessing 42

training 14
tzfile

maintenance of 276–280
precautions 276

U
Unix

starting a server 27
stopping a server 28

user
adding 146–183
removing from profiles 217
roles

profiles 150
testing new user 183

user data
adding 216
Change Management

editing message groups 219
profiles 215

Incident Management
editing profile assignment groups 219

message groups, editing 218
profile assignment groups, editing 218
profiles status 215
profiles, editing 216
quick add 219
Request Management profiles 216
viewing 216

utilities
accessing 42
searching contact information 144
searching for operators 144
searching user inbox listings 144
searching user roles 144
user and contact 144
user quick add 144
viewing and editing user data 144

V
vendor file 113–116

accessing 41
fields 114–116

vendor ID 114

W
wild cards 306
Windows

Ole container 92
Windows NT

starting SC server
console 21
control panel 22
DOS command prompt 24

stopping SC server
console 25
control panel 26
DOS command prompt 27

Work Management
accessing 41
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